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BandiT User Manual 

Introduction 
Contact Information 

 
  

k-Space Associates, Inc.  

2182 Bishop Circle East.  

Dexter, MI 48130 USA 

  

Tel. (734) 426-7977  

Fax (734) 426-7955 

  

Email: requestinfo@k-space.com  

Web: www.k-space.com 

  

 

Introduction 

The kSA BandiT is a non-
contact, non-invasive, 
optically-based real-time 
wafer temperature sensor. 
Typical substrate materials 
include GaAs, Si, InP, ZnSe, 
and ZnTe, and are measured 
using a NearIR 
spectrometer. kSA BandiT 
may also be used with a 
Visible spectrometer for SiC 

mailto:requestinfo%40k-space.com
http://www.k-space.com/
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substrates and for GaN deposition on sapphire. Pyrometry is another method for measuring temperature 
in transmission mode (no light source) by measuring blackbody radiation. 

  

BandiT provides an absolute temperature solution for low- and high-temperature wafer monitoring. 
BandiT works by detecting diffusely scattered light from the wafer and using that to measure the band 
gap absorption edge. Then, from the absorption edge, BandiT accurately determines the temperature. 
Hence, BandiT is insensitive to viewport transmission, stray light sources, and signal contribution from 
substrate heaters. 

  

Using the NearIR spectrometer – 

For high-temperature applications: 

BandiT can use the substrate heater stage as the light source, operating in a single port 
geometry. 

For low-temperature applications: 

BandiT’s light source mounts on one optical port, its detector mounts on a second (non-
specular) port. 

For MBE chambers: 

BandiT is typically installed on the pyrometer port and an unused source port. 

  

Using the Visible spectrometer – 

The BandiT light source must be used for producing enough signal. Two ports are ideal, but 
contact us to discuss single-port configurations. 

  

The BandiT is available in two models covering the spectral range 380 nm – 1400 nm (NearIR through 
Visible). Dual spectrometer units are also available for applications requiring the full spectral range. 

BandiT can also take temperature via a pyrometer. Generally, this technique is less accurate than using 
band edge thermometry. However, the band-edge technique often fails when depositing a very absorbing 
layer, so the pyrometry technique is available for such situations. 

  

Multi-wafer BandiT enables users to determine temperature on multiple wafers spinning on a platen. For 
Multi-wafer BandiT users, this help document includes pages specific to Multi-wafer BandiT features. 

  

Notes: 

1. Learn more about how to navigate this Help document by reading the Using Help topic. 
2. Several How-To Guides are available that cover the procedures for executing BandiT’s most 

commonly used routines. 
3. For detailed information on the installation of the kSA BandiT system, please refer to the 

document titled kSA BandiT Install and Getting Started Guide, or contact us directly. For 
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information on the absorption-edge temperature measurement technique, please refer to the 
references on the following page. 

4. In an effort to provide our customers with the latest capability (including measuring temperature of 
materials deposited on SiC substrates as well as GaN deposition on sapphire), kSA engineers 
are continually advancing kSA BandiT software. This Help Manual documents software version 
1.14. 

References 

The kSA BandiT system analyzes the diffuse reflectance spectrum from semiconductor substrates for 
temperature measurement. This technique has been known for several years. However, recent progress 
in solid-state spectrometer performance has made the diffuse reflectance technique a viable and 
affordable technology for commercial semiconductor wafer temperature monitoring.  

  

Please refer to the following references for additional information on diffuse reflectance spectroscopy:  

Ri-an Zhao, Michael J. Chich, Petra Specht, and Eicke R. Weber, "In-situ Diffuse Reflectance 
Spectroscopy Investigation of Low-Temperature-Grown GaAs", App. Phys. Lett. 80(12), 2002, pp. 2060-
2062. 

P. Thompson, Y. Li, J.J. Zhou, D.L. Sato, L. Flander, and H.P. Lee, "Diffuse Reflectance Spectroscopy 
Measurement of Substrate Temperature and Temperature Transient During Molecular Beam Epitaxy and 
Implications for Low-Temperature III-V Epitaxy", App. Phys. Lett 70(12), 1997, pp 1605-1607.  

C. Lavoie, S.R. Johnson, J.A. Mackenzie, T. Tiedje, and T. van Buuren, "Diffuse Optical Reflectivity 
Measurements on GaAs during Molecular-Beam Epitaxy Processing", J.V.S.T. A 10(4), 1992, pp. 930-
933.  

  

S.R. Johnson, C. Lavoie, T. Tiedje, and J.A. Mackenzie, "Semiconductor Substrate Temperature 
Measurement by Diffuse Reflectance Spectroscopy in Molecular-Beam Epitaxy", J.V.S.T B 11(3), 1993, 
pp. 1007-1010.  

M. K. Weilmeier and K. M. Colbow, "A New Optical Temperature Measurement Technique for 
Semiconductor Substrates in Molecular Beam Epitaxy", Can. J. Phys. 69, (1991) pp 422-426  

  

  

  

  

  

System Schematic 

  

The kSA BandiT system communicates with its hardware components via a single USB connection. As a 
result, the BandiT system can run from a laptop, and is extremely easy to connect to the rack mount unit. 
Here is a schematic of the BandiT hookup:  
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The main hardware components of BandiT are the following:  

• Solid-state spectrometer  
• Light source (optional)  
• Alignment laser  
• Detector assembly with dual 400 um fiber optic  
• DT9806 USB data acquisition module  

  

The kSA BandiT software communicates with and controls all the components listed above. From a user 
standpoint, external data access is made possible through the PMD1208FS board, via BNC and D-sub 
type connections on the back of the BandiT 19" rack mount assembly. Please refer to the document kSA 
BandiT Install and Getting Started Guide supplied with the BandiT system for details on wiring and 
connecting.  

Notes:  

1. (Fixed Temperature Output) The standard method for externally reading the BandiT 
temperature is to connect to the "Temp Out" BNC on the back panel of the BandiT 19" rack 
mount assembly. The signal emanating from this connector is mapped as follows:  
0 – 800°C BandiT Temperature = 0 – 10V analog output.  
Internally, this signal is emanating from Channel 0 of the PMD1208FS board.  

2. (Fully Configurable Output) Temperature output is both voltage configurable and temperature-
range configurable from a software standpoint. Please see the Device Output Control Advanced 
Acquisition Option.  

The schematic diagram below shows BandiT connected to a system and computer. 



BandiT User Manual 

5 

 

Using Help 

There are several ways to navigate this Help file. Below is a picture of the many options.  
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Note that the current topic will always appear in the upper right-hand corner of each page with the 
navigation route to the page. 

Select:  

Hide button to show/hide the Contents, Index, and Search panel 

Back button to jump back to a previously-viewed topic  

Forward to move forward to a previously viewed topic 

Print button to print a page or a section and sub-sections of the help file 

Throughout this Help file, click blue words ( try it!) for more information or to jump to that topic.  

Most users do not read Help files straight through from beginning to end, but prefer to jump from topic to 
topic based on interest or need. For this reason, the Back button is probably the most useful feature 
because it allows the user to jump back to the previous topic even when it is not the previous page.  

For example, to return to any previous topic you viewed before jumping to this Using Help topic, click the 
Back button.  

Precautions and Care 

To keep the BandiT system operational and keep those who use it from harm, please take the following 
precautions: 

  
 

Warning 
This symbol indicates: 

• the possibility of minor injury 
• the possibility of damage to the system or 

its accessories 
• possible problems relating to the quality of 

the process 

 

Hazard 
This symbol indicates the possibility of: 

• very serious injury 
• fatality 
• considerable damage to property 
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Laser Radiation 
Avoid exposure to the laser beam 

 

Wear Protective laser goggles/glasses 

  

Water and Moisture — The system should not be used near water, or in any area where 
excessive moisture or condensation may come in contact with system components. 

  

Ventilation — System components should be mounted in well-ventilated areas. Ensure that 
there is adequate airflow above the rack controller (intake) and to the fan side (exhaust) of the 
rack controller. Also ensure that there are no obstructions to the lamp housing air intake fan or 
the exhaust vents. 

  

Heat — Do not place flammable materials on or near the lamp housing at any time. Always 
allow time for the lamp and all surfaces surrounding the bulb to cool before attempting to 
replace lamp. 

  

Lamp — Never stare into the lamp output. The lamp output contains focused infrared radiation 
and long-term exposure to the lamp output should be avoided. 

  

Power — Connect all cables before plugging in the BandiT system. Ensure the unit is plugged 
into a properly grounded outlet. The system uses a high current supply to power the lamp, so 
never connect or disconnect the lamp power cable or service the lamp in any manner unless 
the system power is OFF. As a further safety precaution, always unplug the rack controller 

when replacing or servicing the lamp. 

  

Laser — Never look directly at the focused beam from the detector and 
always use laser goggles when aligning the system. The alignment laser 
used in the BandiT system is a CLASS IIIA laser (only CLASS I lasers 

present no eye hazard). The laser interlock should always be set to OFF when the laser 
is not in use. 

  

Servicing — Do not service the unit beyond that which described in this manual. The rack 
controller contains no user-serviceable parts. 
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I/O Interface — Before making connections, refer to Rack Mount Controller Installation for a 
complete functional description of each pin in the BNC and DB-15 I/O connectors found on the 
BandiT rack controller. 

Setup 
General Options 

BandiT Settings 

The BandiT Settings tab is available by selecting General Options under the Options menu.  

 

 Select either  

Use Latest Calibration Files – these come with the system and/or are downloaded from k-
Space's web site  

or  

Use Archived Calibration Files – this becomes enabled only if the user has stored a folder called 
CalibrationArchive (all one word) in the program folder (i.e., …kSA\PROGRAM\kSA 
BandiT\Program\). The latest calibration files give the best temperature fit, so, in general, archived 
calibration files should not be used. But there are circumstances when some users have desired 
the use of archived calibration files. So this option allows for that functionality.  

Chamber Interface 

The Chamber Interface tab is available by selecting General Options under the Options menu.  

This allows for software interface through TCPIP. 
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Colors 

The Colors tab is available by selecting General Options under the Options menu.  

 

Select the color for each Shape/Series. Default selections are shown above.  

General Note:  
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After the software cycles through the twelve colors, it repeats. For example, if performing thirteen 
Line Profiles on a single image, both the first and the thirteenth line will be red (given the above 
color choices).  

File Settings 

The File Settings tab is available by selecting General Options under the Options menu.  

 

Select Use Disk as Cache to 
cache data to disk during 
acquisition 

Specify file size. 

General 

The General tab is available 
by selecting General 
Options under the Options 
menu. 

Select: 

Keep real-time plot 
windows inside 
application window – 
to keep the real-time 
plot windows inside 
the application 
window. If this is not 
checked, then you can 
drag the real-time plot 
windows outside the 
main application 
window. 

Keep static plot 
windows inside 
application window – 
to keep the static plot 
windows inside the 
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application window. If this is not checked, then you can drag the static plot windows outside the 
main application window. 

Resolve RTC Y Axis Label Placement – in general leave unchanged. If Y-Axis labels are not 
centered on plots, changing this option (either from checked to unchecked or vice versa) should 
center it. 

Ensure GUI response during acquisition – so that the program responds to user commands 
promptly during acquisition. Unless absolute timing precision is needed, the user can leave this 
box checked. To ensure maximum data throughput during acquisition, leave this box unchecked. 

Set application to high priority during acquisition – to give the kSA application the highest 
priority within the Windows environment during acquisition. In the operating system vernacular, this 
is setting its "Priority Class" to "High," meaning that only real-time events (such as moving the 
mouse and refreshing the screen) are done before the kSA application acquisition task. Generally, 
this is not checked. But for BandiT, it should be. 

Optimize UI during acquisition – to reduce the priority of the user-interface during acquisition. 
This will lead to less data interruption, as moving windows around can slightly affect acquisition. 

Lock UI during acquisition – to keep the user-interface from working during acquisition. This 
prevents the user from moving any window or clicking any button until acquisition is complete. 

Add auto-saved documents to MRU list – kSA software auto-saves documents generated by the 
program if the user has selected the auto-save checkbox in the Document Generation advanced 
acquisition option. Check this option to add these auto-saved documents to the Most-Recently 
Used list (found under the File menu at the top of the application window). 

Save RTC data specific prefs – kSA software builds dynamic real-time charts (RTCs) that 
update, for example, the scale of the X and Y axis depending on the data. These preferences may 
be changed by the user, but default back to the dynamic mode once the chart is closed. Checking 
this box keeps those user-specified preferences the next time those charts are opened. 

Save settings at program exit - this is normally checked so that the current programme settings 
are always saved when the programme is exited. If it is unchecked then the user will need to save 
settings manually. 

Process data in background - this should always be checked as it causes data processing to be 
done in the background when processor power is available and not take up processor power that 
is needed to run the acquisition. If this is not checked it is possible for the acquisition to be 
interrupted. This can only be changed when there is no acquisition mode open, if it is greyed out, 
close the current acquisition mode. 

Specify: 

CPU Affinity -  select a specific CPU for processing if required 

Temporary Directory – where the program places temporary files 

Output Directory – where the program saves files 

Personal Directory - where the program saves files such as logging files 

System ID – defaults to the computer name, but may be changed for archival purposes 

Default Compression – set either to None for no compression or to Z-Lib as a loss-less 
compression. Note that compression takes system resources and therefore can interrupt 
acquisition. 

Default acquire mode – an acquisition mode that opens when the software opens. Select one of: 
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BandiT Dark Background – to obtain a calibration of the spectrometer dark background at 
various spectrometer exposure times 

BandiT Temperature – to obtain substrate temperature and (optionally) spectra data 

BandiT Reference -  used to take a reference scan when using a Visible Spectrometer 

Bandit Roughness Calibration - used to calibrate the system for roughness measurements 

Bandit Pyrometry Calibration -  used to calibrate the temperature acquired by Pyrometry to 
the real BandiT temperature 

Blackbody Calibration - used to calibrate the temperature acquired by Blackbody 
measurements 

Phase Delay Selection - used to set the phase delay for a sample on a rotating platen 

BandiT Temperature Scan - used by k-Space when configuring calibration files 

BandiT Substrate Calibration - used by k-Space when configuring calibration files 

Flat Field Correction - used to create a flat field correction file specific to each Spectrometer 
for use in Blackbody Pyrometry - this file will normally be provided by k-Space when the 
instrument is shipped 

Spectrometer Calibration - used to calibrate the Spectrometer - this is normally done by k-
Space before the instrument is shipped and it is not usually necessary for users to do this. 

With a Default acquire mode selected, choose: 

Start Automatically – to begin data acquisition with program start-up 

Minimize After Start – to reduce the acquisition window to only its banner with program 
start-up 

  

Images and Video 

The Images and Video tab is available by selecting General Options under the Options menu.  
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 Select:  

Keep Live Video window(s) inside application window – to keep the Live Video window within 
the main application window. Unchecking this box will allow the user to drag the Live Video window 
outside the main application window. Note that for BandiT, this option does not matter because the 
only image possible is a pyrometric oscillation image (used for measuring growth rate) and there is 
no live video window.  

Show pixel intensities as percentage – toggle between pixel intensity as a percentage of the 
maximum possible pixel intensity or the raw signal count in digital numbers. For example, with a 
12-bit camera, a raw signal count of 2048, when expressed in terms of a percentage, is 50%.  

Scale pixel values – if acquiring something of a known size, select this option to scale it to the 
acquired number of pixels  

With Scale pixel values selected, select:  

1 Pixel equals – a number and any units of measurement (centimeters, feet, inches, 
microns, meters, and millimeters).  

Default image compression – select either none or ZLib, which is a loss-less compression 
option. This option is disabled in BandiT.  

Logging 

The Logging tab is available by selecting General Options under the Options menu. The software can 
keep a record (log) of many details every time the program runs. It is useful both for recording software 
use and for capturing the reasons for errors, if any occur. Note that program errors prompts a pop-up 
window; logging allows the user to see why the error occurred. The log is saved as a text (*.txt) file. 

There are five thresholds of logging: 

• None – for no logging at all 
• High (1) – to capture high-level details such as start/stop times, acquisitions, system information, 

and any program errors 
• Medium (2) – to capture all High (1) details as well as any program warnings 
• Low (3) – to capture all Medium (2) details as well as any program notes 



BandiT User Manual 

14 

• All – to capture all system information 

 

For each Category – 

• General 
• User commands 
• External/command prompt commands 
• Software license 
• Acquisition 
• Plotting 
• I/O boards and other devices 
• Images 
• Image filters 

Specify: 

Allow – what threshold level of logging to allow 

Allow by default – to specify which threshold level is default. Under the Allow drop-down menu is 
a Default selection, which selects the value chosen here. 

Save/Load - Save and Load logging preferences by using these buttons. 

Delete Saved - to delete all saved log files 

Reset - to reset all logging levels to Medium 

Log File – where the log file is saved 
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Click the View button to see the log. 

Pane Configuration 

The Pane Configuration tab is available by selecting General Options under the Options menu.  

Pane Configuration allows the user to select which folders will be displayed in up to three panes open in 
the BandiT application window. 

The Current Output  folder is automatically synchronised with the Output directory set in the General tab 
of the General options. The My Data folders can be selected by using the browse buttons, for example to 
set the locations where data has been archived.  

Tick the check box by each folder selection so that the folder can be opened in a pane in the BandiT 
application window. The panes can then be temporarily shown or hidden using the View menu. 

 

  

Input Output Devices 

Configure Input/Output Devices 

Installed in the BandiT Rack Mount Controller is a USB Input/Output Board (for example Model, DT9802 
or DT9806). This board allows the software to send/receive analog and digital signals. Once the board is 
properly installed on the host computer; it will need to be configured in the BandiT software. 
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1. Open the BandiT software by double-clicking on the desktop icon. 
2. Select Options / Input/Output Devices. This will open the Input/Output Device Options  dialog. 

 

 
3. Configure the tabs Analog Input, Analog Output, Digital Input and Digital Output for the DT9802 

or DT9806. The Board Number should be 0. 
4. Once each tab is configured, select Apply and then close the BandiT program. 

Input/Output Devices 

The Input/Output Device Options (found under the Options menu) allow configuration of the various 
data acquisition boards present including mapping board channels to voltage ranges that match any 
input/output devices needed for process control or data acquisition. These boards perform analog 
input/output, digital input/output, counter/timer functions, and other functions depending on the system 
and whether capability has been activated on the USB Security Key. The various types of input/output 
(I/O) boards are divided using multiple tabs on this dialog: 

There are ten options: 

 

Analog Input Board 

Analog Output Board 

Digital Input Board 

Digital Output Board 

Environmental Alarm 

External Acquire Indicator 

Options Motion Hardware 

Process Step Input 

Rotation Monitor 

Spectrometers 

Analog Input Board 

Analog Input Board is one of the Input/Output Device options found under the Options menu. The 
system supports various analog input boards for real-time analog input (e.g., voltage for triggers). 
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Specify: 

Board Settings 

Model – choose from among the following analog input board types: 

• Computer Boards CIO-DAS08 – ISA legacy 
• Computer Boards CIO-DAS08/Jr/16 – ISA legacy 
• Computer Boards CIO-DAS08/Jr/16-AO – ISA legacy 
• Computer Boards PCIM-DAS1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DAS6014 
• Data Translation DT9802 
• Data Translation DT9806 
• Use [None] when no analog input board is installed. 

Base address(decimal) or Board number (depending on Model) – if it is a Measurement 
Computing Board, run the InstaCal control software, which will specify a board number. Input that 
here. 

Input type (available depending on Model) – choose: 

Single ended – which measures the voltage between the input signal and ground. 

Differential – which measures the difference between two distinct input signals (also used 
for when the system has a floating ground). More immune to EMI (Electro-Magnetic 
Interference) For low-noise applications, differential input is the preferred analog input 
method because induced noise is largely negated with a differential signal. 

Channel mappings 
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Voltage range – (Note the ranges available depend on Model) – these default to the proper setting 
and should not, in general, need to be changed 

Analog Output Board 

Analog Output Board is one of the Input/Output Device options found under the Options menu. The 
system supports various analog output boards for real-time analog output e.g., voltage for output trigger 
(internally to detector or to other acquisition devices). 

 

Specify: 

Board settings 

Model – choose from among the following analog output board types: 

• Keithley Metrabyte DAC-02 – ISA legacy 
• Computer Boards CIO-DAC02/16 – ISA legacy 
• Computer Boards CIO-DAC16/16 – ISA legacy 
• Computer Boards CIO-DAC08/16– ISA legacy 
• Computer Boards CIO-DAS08/Jr/16-AO – ISA legacy 
• Computer Boards PCI-DDA08/16 
• Computer Boards PCIM-DAS1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DDA02/16 
• Computer Boards PCI-DAS6014 
• Computer Boards USB-3101 
• Data Translation DT9802 
• Data Translation DT9806 
• Use [None] when no analog input board is installed. 



BandiT User Manual 

19 

Base address(decimal) or Board number (depending on Model) – if it is a Measurement 
Computing Board, run the InstaCal control software, which will specify a board number. Input that 
here. 

Channel mappings 

Voltage range – (Note the ranges available depend on Model) – these default to the proper setting 
and should not, in general, need to be changed 

Control channel – these default to the proper setting and should not, in general, need to be 
changed unless additional input/output is required for a very specific process control 

Digital Input Board 

Digital Input Board is one of the Input/Output Device options found under the Options menu. The system 
supports various digital input boards for real-time digital input (e.g., voltage for input trigger). Digital 
boards are becoming the standard because they are less susceptible to Electro-Magnetic Interference 
(EMI). 

 

Specify: 

Board settings 

Model – choose from among the following digital input board types: 

• Computer Boards CIO-DAS08/Jr/16 –ISA legacy 
• Computer Boards CIO-DAS08/Jr/16-AO – ISA legacy 
• DT3153 Frame Grabber – legacy board 
• PIO/CIO-12/24 – legacy 
• PXD Frame Grabber 
• Data Translation DT302 
• Computer Boards PCIM-DAS1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DIO24 
• Computer Boards PCI-DDA02/16 
• Computer Boards PCI-DAS6014 
• Data Translation DT9802 
• Data Translation DT9806 
• Computer Boards USB3101 
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Base address(decimal) or Board number (depending on Model) – specified by manufacturer’s 
installation instructions when properly installing the digital input board 

Digital Output Board 

Digital Output Board is one of the Input/Output Device options found under the Options menu. The 
system supports various digital output boards for real-time digital output (e.g., voltage for output trigger for 
an external event). Digital boards are becoming the standard because they are less susceptible to 
Electro-Magnetic Interference (EMI). 

 

Specify: 

Board settings 

Model – choose from among the following digital output board types: 

• PIO/CIO 12/24 – ISA legacy 
• Computer Boards PCI-DIO24 – legacy 
• Computer Boards CIO-DAS08/Jr/16 – ISA legacy 
• Computer Boards CIO-DAS08/Jr/16-AO – ISA legacy 
• DT Frame Grabber – legacy 
• PXD Frame Grabber 
• Computer Boards PCIM-DAS1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DDA02/16 
• Computer Boards PCI-DAS6014 
• Computer Boards USB-3101 
• Data Translation DT9802 
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• Data Translation DT9806 

Base address(decimal) or Board number (depending on Model) – specified by manufacturer’s 
installation instructions when properly installing the digital output board 

Output – choose: 

Normal output – sending out signal from low to high 

Inverted output – sending out signal from high to low 

Channel mappings 

Control channel – these default to the proper setting and should not, in general, need to be 
changed unless additional input/output is required for a very specific process control 

Environmental Alarm 

The Environment Alarm is a customer specified feature, one of the Input/Output Devices found under 
the Options menu. It can accept a digital input from any system to signal BandiT to pause or resume 
depending on whether the alarm is triggered. 

 

Specify:  

Board settings Model – choose from available board types:  

Board settings Base address(decimal) or Board number (depending on Model) – specified by 
manufacturer's installation instructions  

Alarm - a name for this alarm  
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Channel:  – channel to be used for this alarm. This channel number can then be used as the input 
channel in the Pause/Resume Trigger Option of the Advanced Acquisition Options  

#Beeps - select the numbers of beeps to sound on alarm 

Check: 

Open alarm dialog on app launch - to open the alarm dialog when the application is launched 

Allow alarm dialog to close - allow the user to close the alarm dialog box 

Alarm on low voltage - if the alarm will be triggered by low voltage  

Audible Alarm - to get an audible alarm, and then select the number of beeps for this alarm so 
that the alarm can be easily identified  

External Acquire Indicator 

External Acquire Indicator is one of the Input/Output Device options found under the Options menu. It is 
used for mapping a signal to a specific analog input channel. 

 

Specify: 

Board settings 

Model – choose from among the following board types: 

• PIO/CIO 12/24 – ISA legacy 
• Computer Boards PCI-DIO24 
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• Computer Boards CIO-DAS08/Jr/16 –ISA legacy 
• Computer Boards CIO-DAS08/Jr/16-AO –ISA legacy 
• DT Frame Grabber 
• PXD Frame Grabber 
• Computer Boards PCIM-DAS 1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DDA02/16 
• Computer Boards PCI-DAS6014 
• Computer Boards USB-3101 

Base address(decimal) or Board number (depending on Model) – specified by manufacturer’s 
installation instructions when properly installing the digital output board 

Output – choose: 

Normal output – sending out signal from low to high 

Inverted output – sending out signal from high to low 

Channel mappings 

Control channel – select a channel for Acquiring. 

Optics Motion Hardware 

Optics Motion Hardware is one of the Input/Output Device options found under the Options menu. It is 
used to map the board monitoring the motion of the optics to a port number which is then monitored by 
the Rotation Monitor. 

 

Select the Servo board in use in the system. 

Specify the Port number that is assigned to the board by the Windows computer system.  

The ports that are in use can be checked by going to the Control Panel on the BandiT 
computer system, selecting System and then Device Manager. Expanding the section 
Ports (COM & LPT) will show all the connected ports which might be similar to the image 
below. 
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Process Step Input 

Process Step Input is one of the Input/Output Device options found under the Options menu. It typically 
only available in systems equipped for multi-wafer applications as it is used to process the analog input 
signal specifically for processing stepcode signals that indicate a new procedure or process has begun 
during acquisition. 

  

 

Specify: 

Board settings Model – choose from among the following board types: 

• Computer Boards CIO-DAS08—ISA legacy 
• Computer Boards CIO-DAS08/Jr/16 –ISA legacy 
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• Computer Boards CIO-DAS08/Jr/16-AO –ISA legacy 
• Computer Boards PCIM-DAS 1602/16 
• Computer Boards USB-PMD1208FS 
• Computer Boards PCI-DAS6014 

Base address(decimal) or Board number (depending on Model) – specified by manufacturer’s 
installation instructions when properly installing the board 

Input type (available depending on Model) – choose: 

Single ended – which measures the voltage between the input signal and ground. 

Differential – which measures the difference between two distinct input signals (also used 
for when the system has a floating ground). More immune to EMI (Electro-Magnetic 
Interference). For low-noise applications, differential input is the preferred analog input 
method because induced noise is largely negated with a differential signal. 

Channel mappings Voltage range – (Note the ranges available depend on Model) – these default 
to the proper setting and should not, in general, need to be changed 

Rotation Monitor 

Rotation Monitor is one of the Input/Output Device options found under the Options menu. It is usually 
used in Multi-Wafer BandiT systems to monitor the rotating platen and trigger acquisition of data for each 
sample on the platen. 

The Rotation Monitor menu is used if the BandiT system has the Teensy rotation controller. Go to Check 
Hardware Rotation Board to check 
whether the system has this controller 
before enabling it. 

Check: 

Enable Rotation Monitor - To 
activate the Rotation Monitor. An 
error will occur if no trigger is 
provided indicating a home 
pulse from a rotating platen. If 
this happens check that you 
have this controller, as above. 

 In Pulse Pull Up Resistor - 
Configured for anticipated 
trigger system that may not be 
at least 3.8V (TTL high). Should 
always be enabled. 

 In Pulse Rising Edge - This is 
the home pulse that is coming 
into BandiT and is dependent on 
if the platen trigger is active high 
or low. Check this box if the 
trigger pulse is active high (so 
normally low voltage and the 
trigger rises to above 3.8V) for 
the rising edge of incoming 
pulse. Deselect if the trigger is 



BandiT User Manual 

26 

active low to trigger on the falling edge. 

 Out Pulse rising Edge -  Deselect the box to trigger on the falling edge. 

High Speed RPM -  For rotation speeds over 50 RPM. 

 In pulse - This is a sampling function. Specifies how many rotations BandiT will skip between 
accepting a home pulse trigger. 

 Use RPM Only - Use only the RPM without an incoming trigger. 

  

 Specify: 

# Controllers - Allows for inputs from multiple defined controllers. If multiple controllers exist 
specify which controller goes to which port and also the Acquire source type. Only special 
combined kSA systems have the option of multiple controllers. This will be greyed out for normal 
systems. 

Port - Specify the port number that is assigned to the Teensy controller. See Check Hardware 
Rotation Board  to find the port number. 

Rotation Positions - Determines the resolution of the rotation monitor. 100 positions will give a 
position every 3.6 degrees on the platen. A maximum of 180 positions is possible. NOTE: updates 
may soon allow more rotation positions. 

Stability threshold - % tolerance of what BandiT considers a calculated stable RPM to lock on to. 
Data Acquisition will not take data if the calculated RPM is unstable. 

Instability threshold - % tolerance of RPM that will pause the data acquisition. Currently, just set 
the instability threshold to be the same as the Stability threshold value. 

RPM estimate - Anticipated RPM, to help the system converge faster. The software will correctly 
calculate the RPM of any rotation, but a more accurate estimate specified here will help the 
software calculate a stable RPM faster. 

In Pulse Timeout (sec) - The allowed time duration to detect a home pulse. An error will occur if 
no home pulse is found within the specified timeout. 

Gear Ratio - Most systems detect the rotation home pulse directly from the rotation shaft 
connected to the rotating platen. However, if there are additional gears and/or the home pulse is 
not triggered off of the rotating platen gear, then a ratio must be specified. 

Spectrometers 

Spectrometers is one of the Input/Output Device options found under the Options menu. It shows the 
Spectrometer devices included in the BandiT rack. Check the Enable check box to choose the 
Spectrometer(s) that will be used. 
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If no Spectrometers are shown here it may be that they have not been fully installed on the computer. Go 
to Configure Spectrometer for information about checking Spectrometer configuration and drivers. 

Check Hardware Rotation Board 

BandiT has two different methods of tracking rotation of a platen. Older systems use a Counter Timer 
Board, while newer systems use a Teensy USB controller. These hardware methods have different 
software control menus so it is important to know which method is in use in your system. 

Go to the Control Panel on the BandiT 
control computer and open System:  

 

and then Device Manager, as shown on 
the right: 

Counter Timer Board 

This is installed as a Data 
Acquisition module labelled "ACCES 
USB-CTR-15" as shown with the red 
arrow on the right. 

The software control menus for the 
Counter Timer Board are found by 
right clicking the Live Spectrometer 
window and selecting Properties. 
Select Home Pulse Monitor and 
Position Monitor and click the 
Enable check box in each menu to 
activate them. 

Teensy USB Controller 
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This is installed under the Ports section labelled as "USB Serial (Communication Class, 
Abstract Control Model) (COM4)",  would appear where the green arrow is on the right, and is 
shown below. 

 

The software control menu for the Teensy Controller is found by selecting the Options Menu and 
then Input/Output Devices, then selecting the Rotation Monitor tab. Click the Enable check box to 
activate the Rotation Monitor. 

  

More information about setting up the rotation monitoring for each device can be found by clicking the 
links above for the appropriate device. 

Spectrometer 

Align Spectrometer 

Follow these steps to align spectrometers (10º to 60º from normal). 

Using the Alignment Laser 

(Note: Users without optical access to the 
chamber should skip this section.) 

The alignment laser is a Class IIIA laser 
(wavelength 630-660nm, max. output 4 
mW), so please follow all laser safety 
guidelines. 

The BandiT system has an integrated laser 
inside the rack mount which helps users 
with optical access align the detector to the 
sample. The alignment laser illuminates the 
area of the sample where the detector is 
directed. It does not demonstrate the area of 
detection on a wafer. 

At this point in the installation, the detector 
should be securely mounted to the flange 
and the optical fiber should be in place. If 
not, follow the steps in the Tilt and Rotate 
Detector Installation section to install and 
mount it to the detector and controller. 

(Note: If the optical fiber supplied does not 
have the second leg, you will need to move 
the fiber from the SMA Fiber Input to the 
Alignment Laser SMA fitting.) 
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After ensuring all the proper connections are made, turn On the Laser Power and turn the Laser 
Interlock to On. Both are found on the front of the BandiT rack: 

 

On the wafer, look for a dim laser spot. If it is hard to locate, rotate the Micrometer on the detector so the 
spot moves to the platen’s edge. It may be that the laser beam through the detector lens is too diffuse. 
Use the Focusing Lens on the detector to focus it, see Align Tilt and Rotate Detector for more 
information. When finished, turn off the Laser Interlock, and then turn off the Laser Power. 

Configure Spectrometer 

The first time that a Spectrometer is connected to the BandiT computer system, or if a new Spectrometer 
is connected to the system, the software will need to be configured to use it. 

Connect the new rack to the BandiT computer and allow all the hardware devices to install themselves as 
described in First Power On. Several devices will be found and will install, wait until all new hardware 
devices are installed. Then start the BandiT software and check that the Spectrometer has been correctly 

found by selecting View/Spectrometer from the main menu or by clicking the   icon on the toolbar. 
If it hasn't several error messages will be displayed, close the BandiT software and follow the instructions 
below to get the Spectrometer Setup. 

After connecting to a new Spectrometer the BandiT software will give you the option to copy any recipes 
that you have saved from a different Spectrometer. Select the Spectrometer you want to copy from using 
the down arrow, checking the recipe by using the View button. Click OK to copy the recipe. 
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Get Spectrometer Setup from Spec32 

Go to My Computer, open the C: drive and open the folder CDI32. Run the program Spec32.exe. This 
should find the Spectrometer and show a screen similar to the one below, showing the spectral range of 
the Spectrometer. If it doesn't see Install Spectrometer Drivers below. 

 

Go to File, Save Setup and save the new Spectrometer in Device0 with the filename the same as the 
Spectrometer, SNAB0379 in the case above. This saves the setup as a number of files in the folder 
Device0. This folder can then be saved in the KSA area by copying it to: 

C:\Program Files\KSA\KSA BandiT\PROGRAM\Spectrometers\ 

and renaming it to the Spectrometer name. 

Start the BandiT software, which should now find the Spectrometer. 

Install Spectrometer Drivers 

If the program Spec32 does not find the Spectrometer, it may be that the drivers for this Spectrometer 
have not been correctly installed. If this is the case you will get an error message from Spec32. 

To install drivers run the program instdrvgui.exe which is in the same folder as Spec32.exe. This should 
install any drivers that you need. Run Spec32 again and it should find the Spectrometer. 

If the BandiT software can still not see the Spectrometer then Contact us. 
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Live Spectrometer 

The kSA BandiT system utilizes a solid-state spectrometer for acquiring and viewing the diffuse 
reflectance spectra from the substrate. To view the live spectrometer data, select View/Spectrometer from 

the main menu or click the    icon on the toolbar. 

  

 

The Status Bar (at the bottom of the spectrometer live data window) always displays the minimum 
spectra intensity, maximum intensity, spectrometer integration time (10.00 msec as shown above), and 
the device temperatures, if enabled in the Spectrometer tab of Spectrometer Properties. Up to three 
temperatures can be displayed "Rack" temperature is the temperature of the internal spectrometer board 
(28.75°C as shown above), the "Sensor" temperature is the temperature of the array (32.41°C as shown 
above) and the "Optic" temperature is the temperature of the optic which is not available for un-cooled 
spectrometers for example most NIR spectrometers. If the Status Bar is not displayed, select it under the 
View menu. 

To change the spectrometer settings, right-click the Live Spectrometer window. 
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Or use the Edit Menu and the Live Data Menu which bring up some of the same options, as shown below: 

     

Select: 

Snapshot - to take a snapshot of the current Spectrometer Spectrum into a file 

Properties - to change the Spectrometer Properties  

Plot Properties - to change the plot properties of the current plot. 

Pause, Resume and Refresh - to pause or resume the live display of the Spectrometer output 

Use the Set X Min, Set X Max etc. to set the range of data displayed on this plot. Position the cursor at 
the boundary that you want to use for X Min or X Max and then right click and select the appropriate 
command. And range boundaries set can be reset by clicking Auto X Range or Auto Y range. 

  

Spectrometer Properties 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties dialog. 
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Select: 

Advanced – to change the number of skipped frames during a data acquisition 

Averaging – to change the number of spectra to be averaged during a data acquisition 

Data Sets - specify parameters for data sets 

Home Pulse Monitor – to specify the parameters of triggering the home pulse during rotation 

Spectrometer – to change the acquisition properties of the spectrometer 

Wavelength Filter - to specify the parameters for the wavelength filter 

Advanced 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties. Use the Advanced tab to specify the number of skipped frames during a data acquisition. 
This is useful for reducing the amount of data without changing the other acquisition parameters. This can 
also be done by setting a Delay in the Advanced Acquisition Options.  
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Specify the Skip frames number for the number of frames BandiT skips between acquired frames.  

Averaging 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties. 

Use the Averaging tab to change the number of spectra to be averaged during a data acquisition. 
Averaging frames reduces the amount of data and reduces noise by the square root of the number of 
frames averaged. 

 

Specify: 

Average (# of frames) – the number of frames to average together in order to generate a data 
spectra. Each pixel from each frame is averaged individually. 

Range – the range of values for averaging. Choose Short, Medium, or Long from the drop down 
box to change the range for the Average (# of frames). 

Data Sets 

Accessed from Spectrometer Properties use the Data Sets tab to identify data sets with names. In Multi-
wafer BandiT a data set is assigned to each marker and only information collected at that marker is saved 
in the corresponding .kdt file. To allow proper post acquisition analysis it is crucial that each data set is 
identified so that the user knows which wafer or which position on a wafer is stored in the file. 



BandiT User Manual 

35 

 

Specify: 

Number of data sets - the number of data sets required 

Data set names - select the number of the data set from the drop down menu and enter a unique 
name that identifies the wafer or wafer position 

Device output control - check Enable to allow device output control and click the Mappings 
button to set up the parameters for each Output Device. 

External digital input data set detection - this is an advanced feature contact kSA for 
implementation 

  

  

Home Pulse Monitor 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties. 

Use the Home Pulse Monitor tab to specify the parameters of the home pulse during rotation if the 
system uses the "Counter Timer Board" to monitor rotation. Go to Check Hardware Rotation Board to 
check whether the system has this board. 

Learn more about triggering temperature acquisition and how to set up the Home Pulse Monitor in the 
topic How-To Trigger Temperature Measurement. 
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With the Enable checkbox ticked, select: 

Software Controlled Delay and specify: 

Device Name – this is the name of the 
I/O device. For most users this will be 
CB(0,1) For users with the DT9806 the 
name will be different. This will be 
normally be specified by the k-Space 
engineer who sets up the system. 
Details for finding the correct name can 
be found at the end of this page. 

With the One sample per home pulse 
checked, the Samples per home 
pulse box is greyed out and 1 is used 
as the Samples per home pulse no 
matter what number is displayed. 
Uncheck the box to specify more 
samples per home pulse (in positive 
integers). Use this to take a number of 
consecutive samples (as fast as 
possible) when the home pulse is 
received (once per rotation). 

Home Pulse Edge – select Rising or 
Falling depending on whether the 
pulse is as a rising or falling edge. 

 

or 

Hardware Controlled Delay and specify: 

Falling Edge Only - **** 

 RPM – revolutions per minute of the wafer. This should be set to the maximum RPM expected. 

Phase Delay (ms) – time in milliseconds after the trigger pulse is detected before the data point is 
gathered. Use this to gather data from another position on the wafer other than the center. The Phase 
Delay can be set by using the Phase Delay Selection Acquisition 

Timeout (sec) – number of seconds before acquisition stops if no data point is gathered 

Stop on timeout: for now, this option is default checked and cannot be changed. On timeout, the Live 
Spectrometer will be stopped/paused until the user manually resumes. 

  

How to find the Device Name 

Determine whether the kSA BandiT system has a DT9800-series or Measurement Computing 
PMD-1208FS board. 
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To do this, open the Computer's Device Manager (found on the Control Panel, System, Device 
Manager). 

 

If "DT-Open Layers Acquisition Devices" (or some close variant) is listed, then the system has a 
DT9800-series board. Click the + icon to find the name of the device (e.g., DT9806(01)). Enter that 
name exactly as it appears into the Device Name box. Note that some systems will not have any 
parenthesis for the name (e.g., DT9806). 

If it is not a DT9800-series board, then (except in a few specialty cases), it is a Measurement 
Computing Board. Click Start  All Programs, and run the InstaCal program (it may be listed 
under "Measurement Computing"). In the InstaCal window, find the Measurement Computing 
board and note the board number. In the Device Name box, enter CB(<boardnumber>,1), where 
<boardnumber> is the number reported by the InstaCal software. 

For example, CB(0,1) would be entered if InstaCal reported that the board number is 0. 

If after clicking Apply a dialog appears stating that the Home Pulse monitor could not be found, 
then the device name is wrong. Please ensure that the device name is entered exactly as 
described above. If you need further assistance with this step, please contact us. 

Rotation Monitor 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties.  

Use the Rotation Monitor tab for multi-wafer BandiT  if the system uses the "Teensy" to monitor 
rotation. Go to Check Hardware Rotation Board to check whether the system has this board. The 
Rotation Monitor menu sets the number of positions to track across the rotating platen. 

 

Specify: 

Rotation Positions -  the number of rotation positions on the platen. This determines the 
resolution of the rotation monitor. 100 positions will give a position every 3.6 degrees on the platen. 
A maximum of 180 positions is possible. 

Spectrometer 

Right-clicking the Live Spectrometer window and selecting Properties brings up the Spectrometer 
Properties. 

Use the Spectrometer tab to change the acquisition properties of the spectrometer. 
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Specify: 

Subtract Hardware Background – to subtract the 
dark background from every raw spectra acquired. 
Note that the software subtracts the appropriate 
dark background given any changes in the 
spectrometer integration time. 

Integration Time (ms) – this is the amount of time 
that the spectrometer collects signal before 
digitizing and reading out this signal. The typical 
range of integration times for kSA BandiT 
spectrometers is 10 - 300msec. Use Integration 
Time to decrease (low values) or increase (high 
values) the intensity. The integration times available 
here are those that are set when the latest Dark 
Background was taken. If the range or the step 
sizes do not match your requirements you will need 
to take a new Dark Background. 

DAC Offset – (not user-adjustable) – this is 
determined internally by the BandiT software and is 
based on the minimum dark background for each 
integration time. 

Flat Field Correction -  Flat Field Correction is only 
needed when performing Blackbody Pyrometry. 
Check this box and select the Flat Field Correction 
file that corresponds to your Spectrometer. the 
default directory is C:\Program Files\kSA\kSA 
BandiT\PROGRAM\Spectrometers\SNABnnnn, and 
the file will normally be named "SNABnnnn 
Blackbody FFC.kdt", where SNABnnnn is the 
spectrometer's serial number. 

Optionally select to apply the correction to only part 
of the wavelength range. 

Check: 

External Trigger – spectrometer data can 
only be acquired when an external trigger 
input signal is sensed on the trigger input line 
of the spectrometer. This is a legacy option for kSA BandiT built before August, 2006. See more 
information in the topic How-To Trigger Temperature Measurement. Please contact us for details 
on wiring for external trigger input. 

High Gain – put the spectrometer in a high gain mode. In this mode, the spectrometer is much 
more sensitive and can better detect weak signals. However, the high gain mode also results in 
high noise, so the signal-to-noise (S/N) ratio is reduced. 

Bin All Rows – (Default: unchecked) – checking this option is a hardware function that adds up all 
the rows on the CCD for increasing speed (visible to about 4 ms integration) but decreases signal-
to-noise (because it adds dummy rows (non-image information) from the CCD). Do not check this 
option in triggered mode as it will not clear the CCD non-imaged rows and noise may increase over 
time. 
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Interpolate between pixels – not user selectable (Default: ON) – interpolates between raw pixels 
from CCD detector 

Read Device Temperatures - (Default: Checked) - reads the real time temperature of the 
embedded thermocouples inside the Spectrometer and displays them at the bottom of the Live 
Spectrometer window. This real time display of the temperature can be disabled to optimize 
performance, but the temperatures will still be recorded in the kdt file. Up to three temperatures 
can be displayed "Rack" temperature is the temperature of the internal spectrometer board, 
"Sensor" temperature is the temperature of the array and the "Optic" temperature is the 
temperature of the optic although this is not available for un-cooled spectrometers for example 
most NIR spectrometers. 

Wavelength Filter 

Accessed from Spectrometer Properties the Wavelength Filter is used to select which portion of the 
Spectrometer source to use as source data for BandiT. It can be useful if there is something 
contaminating the spectrum, for example if an Argon emission line is contaminating the spectrum the 
Wavelength Filter can be used to "Remove and Interpolate" the region of peaks (e.g. 908-916 for the 912 
emission line). Bandit removes the region and interpolates the spectrum, smoothing out the line. It is also 
useful during Black Body measurements, for example for filtering out a bandedge. 

 

Check Remove and Interpolate to enable the filter 

Specify: 

Min Wavelength - the lower wavelength to filter 

Max Wavelength - the upper wavelength to filter 

Device Output Mappings 

This is accessed from  the Data Sets tab of the Spectrometer Properties by clicking the Mappings button. 

Use Device Output Control Mappings to map any real-time parameter—including BandiT temperature 
—to a configurable analog output channel. 

In the example shown below, Channel 1 is used to map the BandiT temperature: 0 – 800°C maps to 0 – 
10V output. 



BandiT User Manual 

40 

 

Specify: 

Output Device – through which output signals can be made. This device is typically a data 
acquisition board with digital or analog output channels. If the device is detected by the k-Space 
software, it will be present in the Output device dropdown box. 

Control channel – of the of the selected device that you want to use for signal output. The Control 
channel dropdown list will list only those channels currently available on the selected Output 
device. 

Parameter – to be mapped to the output channel. For example, it could be the BandiT 
temperature, band-edge wavelength, elapsed time, etc. All available data parameters will be listed 
in the Data parameter dropdown box. 

Window/line # – if the acquisition mode utilizes window or line regions, then this parameter selects 
which region to use for the data output mapping. Note that this parameter is not available in some 
acquisition modes, in which case this parameter text box will be disabled (such as above). 

Parameter range – to define the range of parameter values mapped to the output channel. In the 
example above, the temperature range is 0°C (min) to 800°C (max). Many other parameters are 
available. 

Voltage output – to define the voltage range to which the Parameter is mapped. Common ranges 
include 0-10V, 0-5V, and -5-+5V. 

Boxcar Smooth – to employ a simple, common data smoothing routine whereby a given data 
point is smoothed, or averaged, into the data surrounding it. As an example, for a 3-point boxcar 
smooth, each data value is averaged with its nearest neighbor data point on each side, replacing 
the original data value with this "smoothed" average. Note that the boxcar smooth value must be 
an odd number. When 1 is chosen, no smoothing is done. 

Set to Min at End - will set the specified mapped minimum voltage after the acquisition is 
complete. This is useful to keep active high boards in the ‘off’ state when not in use. 

Note: For smoothing on analog outputs, the software waits until it gets the boxcar smooth number of data 
points, and then averages these numbers to smooth the data. 

Light Source 

Standard Light Source 

BandiT has a few different light source options, including a liquid light guide. The most common is a 
halogen bulb (shown in the image below). 
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The standard light source is shipped fully assembled (including halogen bulb). Before mounting the light 
source to the view port, please follow these steps to make sure the bulb is seated correctly: 

1. Carefully unpack the light-source housing and inspect it for any damage caused by shipping. 

2. Next, remove the cover and inspect the optics. 

3. The socket connector lever should be in the forward position. The lever allows removal of the 
lamp. 

4. The lamp should be seated in the lamp assembly. Be sure to press down firmly so that the bulb 
is completely seated in the socket. 

5. Replace the cover. 

Signal strength is best if BandiT’s light source is mounted on a normal incidence view port. If such a port 
is not available, then please choose another port with the smallest angle from normal as possible. Bench 
tests have shown that signal strength is reduced only by 30% at angles as large as 60 degrees from 
normal, which is sufficient for accurate temperature measurement. But, of course, the greater the range of 
signal strength, the greater the precision in temperature measurement. 

Mounting to the view port: 

Typically, BandiT comes supplied with both 4.5” and 2.75” mounting rings. A 4.5” ring comes attached to 
the light source, so if mounting the light source to a 2.75” view port, change the mounting ring. Then, 
using the four 10-32 set screws located around the 4.5” mounting ring, secure the light-source housing to 
the view port. For exact alignment and focus of the light source on the view port see Align Light Source. 

Configure Light Source Controller 

BandiT’s light source is completely controlled through the software so it is important to ensure the 
interface is properly set up.  

Follow these steps to ensure the lamp interface is properly set up: 
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1. If the Main Power switch is not already On from the software installation procedure, verify that all 
cables are connected and then turn on the Main Power. 

2. Turn On the Lamp Power. The lamp may come on depending on the default conditions of the 
lamp driver board. 

3. If the BandiT application is not already open from the software installation procedure, open it by 
double-clicking on the kSA BandiT icon on the desktop. The application should open in the default 
condition with no windows open. If it does not, then close all windows within the application. 

4. From the top of the application go to the View menu and select Light Source Control. 

 

5. Click the Detect button. The indicators should be green, intensity set at 5%, and the lamp placed 
in standby: 

6. Take the light source out of Standby mode and use the slider to increase the intensity. Ensure 
the lamp’s intensity is corresponding with the change in the slider. 

7. Return the intensity slider to 5% and place the lamp in Standby mode.  

Align Light Source 

After the light source has 
been properly mounted 
and tested, focus and align 
the unit following these 
steps: 

1. Remove the light 
source from the 
view port and set 
the unit on a 
workbench or flat 
surface facing a 
wall. 

2. Determine what 
the Focusing 
Distance is from the 
light source to the 
sample. The 
Focusing Distance 
will be the distance 
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from the front of the light source to the center of the sample (see diagram on right). 

3. Using the lamp control window in the BandiT application, take the lamp off of standby mode and 
set the intensity to the minimum (5%). 

4. Remove the top cover of the light source. 

5. Move the light source so it is the same distance from the wall as the Focusing Distance. 

6. Set the Adjustable Iris diaphragm to a desired position. Keep in mind that the larger the opening 
of the iris, the more the sample will heat up at lower temperatures. 

7. Using the light spot on the wall as a guide, set the focus using the Focusing Lens. 

8. To keep the focus from changing, tighten the set screws in the Focusing Lens to the guide rail. 

9. Using the lamp control window in the BandiT application, return the lamp to standby mode. 

10. Remount the light source to the view port. 

 

Light Source Control 

Light Source Control is opened by using the    icon on the toolbar or by using the View menu. 
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Click the Detect button to detect the light source - the indicators Online and Lamp Status should turn 
green. 

Use the Intensity slider to increase/decrease the light source intensity - it can be left at about 5% when 
not in use. 

Click Standby to put the light source into Standby mode - the light source will normally be left in standby 
mode when not in use. 

Click Settings to open the settings dialog box as shown below: 

 

Comm Port - is the Communication port used for communicating with the light source 

Calibration - the factory-configured value that is based on the lamp controller. In general, this will 
not need to be changed by the user. 

Max Percent Output - allows for less than 100% of the lamp output to be used if required 

  

  

Tilt and Rotate Detector 

Tilt and Rotate Detector 

The Tilt and Rotate Detector is available in two formats Manual and Motorized.  
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The Manual Detector has a Micrometer that can be used to align the detector onto the wafer at the 
desired position. 

 

The Motorized Detector has a Servo motor which is powered from the BandiT rack and controlled by the 
BandiT software. This is required to enable the Full Platen Temperature Scan (a BandiT Multi-Wafer 
Acquisition mode) to be used.  

 

  

Tilt and Rotate Detector Installation 

The tilt and rotate detector effectively collects light and its design allows users the ability to adjust where 
the detector is collecting light reflected from or transmitted through the sample. 

1. Carefully unpack the detector and inspect it for any damage caused by shipping. 

2. Next, remove the covers and inspect the lens. The curved side of the lens should be facing towards the 
front of the detector. 
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Before mounting the detector on the view port, you will want to install the optical fiber into the fiber mount. 
In order to attach the fiber, the detector first must be partially 
disassembled. Please follow these steps to attach the optical fiber 
into the detector: 

1. With covers removed, unscrew the back plate from the 
rails. 

2. Loosen the set screws from the fiber mount and slide the 
mount off the rails. 

3. Locate the optical fiber in the accessories packaging and 
remove the end cap on one end. 

4. Taking care not to scratch the end of the optical fiber, guide 
the fiber into the SMA fitting (located in the Fiber Mount) and 
rotate the mount until the fiber is flush to the front of the 
mount (see example picture on the right). 

5. Connect all the components back onto the rails of the detector. Finally, connect the top and 
bottom housing covers to the detector. 

Mounting to the view port: 

Typically, BandiT comes supplied with both 4.5” and 2.75” mounting rings. A 2.75” ring comes attached to 
the detector, so if mounting the light source to a 4.5” view port, change the mounting ring. Then, using the 
four 6-32 set screws located around the 2.75” mounting ring, secure the detector housing to the view port. 
For exact alignment and focus of the detector see Align Tilt and Rotate Detector. 

The Motorized version of the Tilt and Rotate Detector will 
also need to be connected to the Servo port on the back of 
the BandiT rack. The Servo motor is powered and controlled 
from the BandiT rack so it is important that the interface is 
correctly set up, see Detector Motion Configuration for more 
details. 

Align Tilt and Rotate Detector 
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(Note: All Tilt/Rotate Detectors are pre-focused at a distance of 2 feet. If the sample-to-viewport distance 
is greater than 2 feet, focus adjustments for the detector may be needed.) 

 

To align the detector and focus the input, follow these steps: 

If you have optical access to the chamber 

1. Connect and turn on the Alignment Laser and look for a red laser spot on the wafer. If it is not 
visible try adjusting the Micrometer a little. 

2. If the spot is large and diffuse the Focusing Lens mount and Fiber Input mount  will need to be 
adjusted in order to focus the laser spot. Remove the detector covers  loosen the set screws 
around the Focusing Lens mount and slide them until the light is focused. If necessary adjust 
the Fibre Input mount as well. Then, tighten all the set screws. The goal is to have a sharply 
focused spot that is the same size (or slightly larger) than the fiber input (which is quite small). 

3. The Micrometer can be adjusted to align the detector with the required position on the wafer. 
4. Turn off the Alignment Laser. 

If you do not have optical access to the chamber 

1. If you have not adjusted the Micrometer using the alignment laser or do not have optical access 
to the chamber, then adjust the Micrometer so there is no observable tilt between the detector 
and the mounting ring. 

2. Using the lamp control window in the BandiT application, take the lamp off standby mode and set 
the intensity to the minimum (5%). 

3. Both the Focusing Lens mount and Fiber Input mount may need to be adjusted in order to 
focus the light coming into the detector. The goal is to have a sharply focused spot that is the 
same size (or slightly larger) than the fiber input (which is quite small). 

4. With the detector covers removed, place a business card or other small piece of paper flush with 
the Fiber Input. If the light coming through the focusing lens is too large or is not focused on the 
paper, then loosen the set screws around the Focusing Lens mount and slide them until the light 
is focused. Then, tighten all the set screws. 

5. Once the light is focused, tighten all the set screws. 

Detector Motion Configuration 
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The Motorized Tilt and Rotate Detector is completely controlled through the BandiT software and it is 
important that it is correctly set up. Follow these steps to check the Detector: 

  

1. Go to Options, Input/Output Devices and open the Optics Motion tab. Check that the Servo 
selected corresponds with that installed on your detector and that the COM port is the one that 
Windows has assigned to the Servo board. 

 

2. Use the    icon on the toolbar or select Detector Motion from the View menu to open the 
Detector Motion dialog. 

 

3. Click Home on the Detector Motion dialog and ensure that the Detector comes on and move the 
Position slider to confirm that the motor can move. 

Detector Motion Control 

Detector Motion is opened by using the    icon on the toolbar or by using the View menu. 

This is used to control the motorized Tilt and Rotate Detector which can scan across the platen and is 
required during Full Platen Temperature Acquisition (a BandiT Multi-Wafer Acquisition mode). 
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When first opened the Detector Motion dialog opens in the Reset state as shown on the left. 
Click Home to turn the Detector Motion On and activate the rest of the controls. 
The arrow button in the centre can be used to show/hide the platen properties and calibration part of the 
screen as shown in the right hand image. 

Position - With the Detector Motion On set the Position, use the slider to select a radius for the detector 
to move to, or type the require radius value into the Detector box. The motor will then move to drive the 
Tilt and Rotate Detector to the specified radius. It can be stopped at any time by clicking STOP. 

Platen Presets - The Platen Presets are used so that the detector can be moved to a specified position 
either by clicking the Preset button on this dialog box, or automatically at the end of the Full Platen 
Temperature scan. To set the Preset buttons, drive the detector to the required position, check the Set 
box and then click the Preset button that you want to set. Up to four different positions can be Preset. 
Once set these cannot be cleared but they can be set to new positions. 

Clicking the Properties button brings up the dialog box below. The Maximum  Velocity, Acceleration 
and Maximum and Minimum Positions, and the Position Resolution for the Servo motor that is installed 
in your Detector will be set automatically when the Servo board is initialized, but they can be changed 
here if required. 

 

Velocity and Acceleration can be selected using the sliders on the Detector Motion dialog up to the 
maximum velocity specified in the Detector Motion Settings. 

Platen Calibration - use this to calibrate the Detector positions with the actual Platen Radius. The 
number of positions available on the detector will depend on the model in use. If it is a Goniometer model 
then 0 will be in the centre of the movement and positions will be defined +/- this, for example from -30 to 
+30 positions. The Platen dimensions are in mm. In the Full Platen Temperature Acquisition mode the 
scan parameters are set in mm, for the actual platen radius not in detector positions. 

 



BandiT User Manual 

50 

Specify the Inner and Outer Radius of the Platen in mm. Specify the Inner and Outer Positions 
 of the Detector that correspond to the Platen radius. 

The Use Cur button can be used to take the Current Position of the Detector. 

  

  

CAR Port Unit 

CAR Port Detector Installation 

Designed for use specifically on Veeco’s GEN II and GEN III reactors configured with a light pipe facing 
the backside of the wafer, the CAR port detector unit is used for transmission mode only. Because the 
light source unit must be mounted on the pyrometer port—illuminating the wafer at all times—the 
substrate heater cannot be used as a light source. 

 

  

Included with the CAR port single-axis tilt 
detector assembly, please find: 

• 2 12mm acromat lens 
• 1 x/y fiber translation stage 
• 1 optical fiber 

Carefully unwrap the cage detector and inspect 
the unit. If the lens needs to be cleaned, do so 
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before mounting it on the chamber. Use only clean alcohol and dry with clean laboratory-grade 
compressed air, argon, or nitrogen. 

Next, please find in the accessories box the 10-meter dual optical fiber. Carefully unpack it and do not 
remove the end caps. Taking care not to scratch the end of the fiber, feed the single end into the SMA 
connector in the x/y translation stage. 

Finally, mount the complete assembly to the CAR port flange and secure it using the four set screws 
around the perimeter of the mini adapter. 

 

Align CAR Port Detector 

At this point, the detector should be securely mounted to the view port and the optical fiber should be in 
place. If not, follow the steps in the CAR Port Detector Installation section to install it. 
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Then follow the steps below to align the detector. 

1. Take whatever steps are necessary so that light is coming into the detector. 
2. Loosen the 4 set screws around each lens. 
3. Move Lens 1 until it is positioned against the front mounting plate, then tighten its set screws. 
4. Position Lens 2 close to Lens 1, but do not allow the lenses to touch. The goal is to have a 

sharply focused spot that is the same size (or slightly larger) than the fiber input (which is quite 
small). 

5. Place a business card or other small piece of paper flush with the Fiber Input. If the light coming 
through the Lens 2 is too large or is not focused on the paper, then move Lens 2 until the light is 
focused. If that is not possible, then pull Lens 1 slightly back from the front mounting plate and try 
again until the light is focused. 

6. Once the light is focused, tighten all the set screws. 
7. In the BandiT application under the Acquire menu, select BandiT Temperature Acquisition and 

open the Real-time Bandit Spectra Real Time Chart. Use the fine adjustment on the on the sides 
of the Fiber Input X/Y Tilt Adjustment to maximize the signal detected in the Real-time BandiT 
Spectra window. 

Rack Mount Controller 

Rack Mount Controller Installation 

The BandiT controller is a standard 19-inch, 5.25-inch height rack mount. Install the controller in a well-
ventilated rack and ensure that the top cover vents are not obstructed. To ensure proper airflow, please 
also install a spacer between the top of the BandiT controller and any other equipment in the rack. 
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Important note: turn off main power before making the next set of connections. 

 

Follow these steps to install the controller: 

  

1. Install the laser interlock key on the front of the controller. 
2. For those using a light source, connect the black lamp power interface cable to the back of the 

controller (labeled Lamp Interface) and to the light source housing. 
3. Connect the supplied USB cable to the back of the controller (labeled USB) and to the computer’s 

USB port. 

  
4. Connect the optical fiber from the detector housing to the SMA fiber input on the back of the 

controller. 
5. Connect the I/O Adapter Cable to the back of the controller (labeled I/O-Interface). 
6. Connect the USB sentinel key to the back of the controller (labeled Sentinel Key). 

 
Note: the USB Sentinel Key is your software license. It is important not to lose it. It may be 
inserted into a USB hub, but do not connect more than one computer to the hub, or, if having 
more than one system, then installing more than two keys to the same hub. It will not work and/or 
may disable some of the functionality because the options on one USB Security Key will override 
the other. 

7. Ensure that the Main Power, Laser Interlock, Laser Power, and the Lamp Power switches on 
the front of the controller are all in the OFF position (rocker switch down), then plug in the AC 
power cord. 
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I/O Interface and BNC Connections: 

The BandiT system can be configured to read and output a variety of analog and digital signals. Most 
users will use the analog voltage output BNC labeled “Temp Out” to send a linear voltage output to MBE 
control software. Alternatively BandiT can generate a TC voltage output on the I/O interface connector. 
However it is not generally a good idea to use BandiT as a direct feedback control to the substrate 
temperature controller. When the BandiT system is unable to detect a band edge and is unable to make 
a temperature measurement, then the output will be 0 volts and 0°C (unless Disregarded data below 
threshold is selected, which is in the Compute Band Edge Configuration Option). 

I/O Interface (DB-15 female): 

  

Pin Signal 

1 Analog Input High (Channel 
0) 

2 Analog Input Low (Channel 
0) 

3 Analog Output 1 High 
4 Analog Output 1 Low 
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5 Digital Input 0 
6 Digital Input 1 
7 Digital Output 0 
8 Digital Output 1 
9 Digital GND 
10-15 N/C 

  

BNC Connections: 

The remaining three BNC connections (Falling Edge H.P., Rising Edge H.P. Encoder Pulese) are for 
BandiT user’s using the multi-wafer software option. The reactor’s home pulse and encoder pulses (if 
available) connect to the appropriate BNC. 

• Falling Edge Home Pulse - Used for timing with substrate rotation. A falling edge (5V-0V) pulse 
from the reactor. 

• Rising Edge Home Pulse - Used for timing with substrate rotation. A rising edge (0V-5V) pulse 
from the reactor. 

• Encoder Pulses - Used for timing with substrate rotation. 
Pulse polarity does not matter. 

Switch Setting: 

To the right of the BNC connections there is a switch for controlling 
the correct home pulse polarity received into the BandiT rack. This 
switch is only to be used if the system is being triggered for substrate 
rotation applications. The switch setting will correspond to the same 
home pulse (rising or falling) connected to one of the BNC 
connectors. 

  

Servo Connector: 

The SERVO connector supplies power and controls the 
BandiT servo detector mount. This is only used if the Multi-
Wafer Scanning option is purchased. 

  

  

Diagnostic Connector: 

The DIAGNOSTIC connector is to be used only by properly trained k-Space 
Associates, Inc. personnel. No connections should be made to this 
connector, unless instructed by a k-Space Associates representative. 

  

Schematic diagrams 

BandiT Systems are available in both one and two rackmount units. The diagrams below show schematic 
diagrams of both of these systems with the cable connections to the deposition chamber, computer and 
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power. They also show differing configurations of the back panel that may be seen in different BandiT 
systems. 
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System recommendations: 

• Although the BandiT system is not sensitive to changes in transmission from coated view ports, it 
cannot measure the temperature when ports become so coated that it cannot detect the signal. 
So, to keep the ports in operation as long as possible, we suggest heated view ports to minimize 
the rate of coating. 

• To ensure the most accurate temperature measurement, use a shutter on the detector port to 
block chamber light from entering the spectrometer during BandiT Dark Background calibration 
(described in further detail later in this guide). 

Alignment Laser 

The BandiT system rack is supplied with an integrated Alignment Laser which is very useful for aligning 
the optics to the sample. The alignment laser illuminates the area of the sample where the detector is 
directed. It does not demonstrate the area of detection on a wafer. 
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To use the laser remove the fiber optic cable from the SMA Fiber Input socket and connect it instead to 
the Alignment Laser socket. Some systems have an optical fiber with a second leg, in which case there is 
no need to move the fiber as this second leg will be connected to the Alignment Laser. 

Take great care when using the laser. Never look directly at the focused beam from the detector 
and always use laser goggles when aligning the system. The alignment laser used in the BandiT 
system is a CLASS IIIA laser (only CLASS I lasers present no eye hazard). 

Insert the key into the Laser Interlock on the front panel of the BandiT rack and turn it to ON, then switch 
on the Laser Power. The laser will now be shining down the fiber optic cable into the Detector on your 
system. 

 

When Alignment is complete, turn off the Laser Power, switch OFF the Laser Interlock and move the fiber 
optic cable back to the SMA Fiber Input socket. 

Software 

Software Installation 

The BandiT software application and 3rd party device drivers are all located on the BandiT installation 
CD. Follow the installation instruction below to ensure that the software and device drivers install 
properly. If you come across any errors during the software installation, please contact k-Space 
Associates for technical assistance. 
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If you have already attached cables between the BandiT rack controller and the computer, please detach 
them and be sure the rack controller power is off. Several device drivers should be loaded before the 
hardware is detected. 

Install Third Party Device Drivers First 

Before beginning the software installation, please close all other applications. Then insert the CD into the 
computer’s CD-drive. Installation should begin automatically. If it does not, double click on the CD-ROM 
icon to open it and then run BanditInstallStartup.exe from the CD. Doing so will bring up the following 
dialog box. 

 

When the screen above appears, first select Install Third Party Drivers (This installation will automatically 
load all the drivers needed for the BandiT system). A new dialog will appear. Click OK to start. Then 
please be patient as many screens will appear and you may hear system alerts: do not click anything until 
the following pop-up window appears: 

 

Click OK to close that pop-up window. 

Install BandiT 

After the third party device drivers are installed, the next step is to load the BandiT application software. 
Follow through the installation instructions to load the BandiT software properly. Click the Install BandiT 
button to begin. 

Important note: do not insert the USB Sentinel Key until after the BandiT software has been 
loaded and the computer has been restarted. This is so important that we have built in a prompt 
during the installation of the BandiT software: 
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During the installation, you will be asked to choose among three setup types: 

• Typical – installs all components (this is the recommended choice) 
• Compact – installs only the application (no help manual, no samples, etc.) 
• Custom – installs components as selected by user 

 

When installation is complete, the computer needs to be restarted for changes to take effect. Restart the 
computer. 
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Now the BandiT software installation is complete. 

  

Power on the BandiT Rack 

Turn on the BandiT’s MAIN POWER switch on the front of the rack, but do not yet start the software. The 
computer will recognize the new devices and ask you to load drivers. At this point, you may want to open 
the Device Manager (Control Panels / System / Hardware / Device Manager). Before the drivers are 
loaded, it will look like 

 

Windows Hardware Wizard will start up. Because there are many components within the BandiT rack, this 
will happen many times. Whenever the dialog shown in Figure 8 appears during the installation process, 
please select “No, not this time” and then click Next. 
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Each time this screen appears, select “Install the software automatically” and then click Next. 

 

After each hardware device driver has loaded, click Finish. This process will be repeated several times, 
and may include the dialog box shown below appearing as well. 
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Each time this dialog box appears, select “Continue Anyway.” k-Space Associates has thoroughly tested 
the hardware’s compatibility. When all the BandiT hardware has been installed, the Device Manager 
should no longer have any question marks or exclamation points as it did before. If not, then please 
contact k-Space Associates. 

Substrate Material 

Select Substrate Material 

Whatever Acquisition mode is being used it is necessary to select the Substrate Material. 

 

Use the drop down arrow to select the base Substrate Material, then use the Select button to open the 
table of materials for which there are calibration files. Select the one that best matches your substrate. 
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It may be the case that the Library does not contain the exact specification of the substrate material being 
used. Generally, the closest match will produce perfectly acceptable results, but if higher precision is 
required, it is possible to apply small correction terms using either 3) Band Edge Correction or 4) 
Temperature Correction. A final option is that k-Space can provide a calibration service for wafers that are 
not already listed in the Library. 

The details of the material selected can be seen in the Acquisition window by using the >> button.  

 

  

Substrate Materials Setup 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user. 

Input/View/Alter the properties substrate materials used in BandiT Temperature acquisition by using this 
dialog found under the Options menu. 
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Click the Properties button to view the full list of properties of each substrate material, or click New to 
create one. Either button brings up a new window with the following options: 

File – view/choose the raw data file used for calibration 

Material Identifier – view/choose the material and material attributes 

Fit – view/choose/create a new fit to the raw data, and/or change fit properties 

Material Identifier 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user.  

Clicking the Properties button from the Substrate Materials Setup window brings up the Material Identifier. 
Use this property to view/choose the material and material attributes.  
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Specify:  

Material – the substrate material  

Revision – separates the files when calibration is done more than once using the same 
parameters  

Thickness (ìm) – thickness of the substrate  

Polish – choose either Unknown, SSP, or DSP. (SSP = Single-Sided Polish, DSP = Double-Sided 
Polish)  

Conductivity – choose either Unknown, n, p, or SI  

Dopant – this substance (e.g., boron) has been added in small amounts to a pure semiconductor 
material to alter its conductive properties. Type in the name of the dopant.  

Carrier conc. (cm^3) – the carrier concentration of the substrate in cubic centimeters  

Resistivity (ohm-cm) – the intrinsic property of a material that is measured as its resistance per 
unit length for a uniform cross section  

Absorption mode – choose either Unknown, Reflection, or Transmission for specifying how the 
BandiT system acquired the data  

File 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user.  

Clicking the Properties button from the Substrate Materials Setup window brings up the File. Use this 
property to view/choose the raw data file to be used for calibration.  
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Click the View button to see a plot of the raw data.  

Click Browse to select a raw data file 

When this window is opened from the New button on the Substrate Material Setup: 

Check Store definition in separate calibration file and enter a new file name into the box to 
create a new calibration file 

Fit 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user.  

Clicking the Properties button from the Substrate Materials Setup window brings up the Fit. Use this 
property to view/choose/create a new fit to the raw data, and/or change fit properties.  
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Click the Properties button to view/change the wavelength range, toggle the type between Explicit 
polynomial or Derived cubic spline, and specify fit parameters.  

Click the New button to specify new fitting segments.  

Fit Properties 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user. 

From Fit, click the Properties or New button to bring up the Fit Segment Properties. 

  

For Wavelength range, choose: 

All – to fit the entire range of data 

From… to – to select a subset of data. The units are 
nanometers. 

For Fit type, choose: 

Explicit polynomial – to fit the raw data to an explicit 
polynomial 

Specify: 

0 for the constant value in the polynomial, 1 for the 
linear constant, 2 for the quadratic, and so on 

Click the Paste button to paste these values from 
the Windows® clipboard (copied from a plot that has 
had Poly Fit w/ extrapolation analysis done on it – 
use the View Output Pane by right-clicking the plot 
and then copy the coefficients from the bottom of the 
chart. 

or 

Derived cubic spline – to fit the raw data to a derived 
cubic spline function. 

Specify: 

Interp. Interval – (interpolation interval) this is the 
interval size for filing in connecting points of data, 
i.e., not simply to smooth between two regions of 
data but to interpolate between them 

Menus Options and Toolbars 
Main Controls 

Navigate the program’s many features by using global 
controls, accessing menu and view options, clicking 
buttons on toolbars, and setting properties. 
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Global controls 

Right-click – view and change properties and other options of any window in the program by right-
clicking it. 

Double-click – view the properties of any image, movie, or live video window by double-clicking it. 

Keyboard – use standard keyboard conventions. For example, select File by pressing Alt+F. 

Menu options – located along the top of the application window, these options change based on which 
file or acquisition mode is active 

 

View options – the most commonly used menu option. Options change based on which file or 
acquisition mode is active. 

  

Toolbars allow for quick accessibility to the most useful controls: 

Main Toolbar – for general options, acquisition, plots and help 

kdt Toolbar – controls the most frequently used features of the *.kdt file 

  

Properties help in setting up the system, viewing images or movies, and changing how data is plotted. 

General Notes: 

1. Setting invalid parameters prompt error messages. Acquisition/Analysis will not proceed until 
valid input parameters are set. Invalid parameters include attempting to acquire more data than 
the computer can store. 

2. Inputted parameters are retained, so the most recent used value remain even if the program is 
restarted. 

Main Toolbar 

The main toolbar is along the top of the kSA application window.  

 

Standard: Open / Save / Cut / Copy / Paste / Print / Zoom-in / Zoom-out.  

These are standard Windows® options. Notice that the Cut and Paste options will never be highlighted. 
Copy is available, and copies to clipboard for pasting in documents in other applications.  
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BandiT toolbar: Live Spectrometer / Light Source / Detector Motion / Dark Background / Reference / 
Phase Delay Selection / Temperature 

These are the BandiT controls, the three on the left open the control windows for the Spectrometer, Light 
Source and Detector Motion. The four on the right open the Acquisition modes to acquire a Dark 
Background; to acquire a Reference; to calculate Phase Delay Selection; to acquire BandiT Temperature. 

 

Help: Context-Specific Help / User Manual (this file)  

Click the Arrow/? button and then click anywhere in the program window. Doing so will bring the user to a 
page in this Help File, specified by what is clicked.  

Note: While this Help File is comprehensive (with a page for each dialog, menu item, analysis tool, plot 
property, etc.), not every button, window banner, menu item, or background is mapped to a mouse click. 
This is because the program relies on dynamic dialog creation. So, for example, clicking for help on any 
of the real-time charts brings the user to the same page in this help file, from which the user can easily 
navigate to the particular topic of interest.  

kdt Toolbar  

The *.kdt Toolbar is available by selecting a *.kdt file and then selecting the View/Status Bar from the 
main menu.  

The toolbar gives the user control over the most often used features of *.kdt files.  

 

  

From left to right –  

The first six icons act just like the controls on a Digital Video Disk (DVD) player, with jump to 
beginning, back one frame, play, pause, forward one frame, and jump to end.  

Loop – enable this button and the file will repeat from the beginning after it reaches the end. 
Note that this is for playback only. To loop the source for BandiT Temperature Acquisition, use the 
Loop checkbox at the top of the BandiT Spectra Acquire Source plot property, found by right-
clicking the *.kdt window and selecting Properties. Note that for multi-wafer BandiT, there is no 
such thing as a multi-wafer *.kdt, so it cannot be used as a source for multi-wafer BandiT 
temperature acquisition – this is because a separate *.kdt is created for each marker.  

Snapshot – click this button to take a single frame from the *.kdt file – results in a single spectra 
data plot (for BandiT Spectral Data) and a single point (for BandiT Computed Data). See chart 
tabs below. 

To change the speed of playback, right-click the *.kdt window and select Properties. Then use options 
found in the Playback tab.  
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At the bottom of the window up to three tabs allow selection of the two chart types: BandiT Computed 
Data and BandiT Spectral Data and Spreadsheet Data. For *.bsrf files, these tabs toggle between a 
spreadsheet view and the single spectra.  

 

  

Menu Options 

Menu options change based on which window is active. The blue banner at the top of the window 
indicates which window is active, and the bottom right corner of the window (View/Status bar) shows how 
much a window is magnified or reduced.  

the window to full-screen size in order to see the entire status bar.  

When program opens, the user has the following menu options:  

 

Open a saved image or plot by using the File menu option.  

Or use the Acquire menu option to access the Acquisition Modes.  

Opening or acquiring an image or plot changes the menu options:  

 

Notice that Analysis appears. The analysis available depends on whether an image or plot is selected.  

For menu options that do not change based on Acquisition Mode (available via the Acquire menu) there 
are the standard Windows® options:  

File – Open / Close / Save / Save As / Export / Batch Export / Print / Print Preview / Print Setup / 
Exit  

This menu option also shows the last four files that the user accessed.  

Edit – Copy / Properties (Undo / Cut / Paste are not available) 

Window – to toggle between active windows and arrange windows on the screen  

Help – user manual (this file), registration, contact and support information, and version  

The View menu item is used to control what is open on the screen during acquisition. Real Time Charts 
are opened from here. 

The Options menu item is for options in the program itself.  
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The Filter menu item is always present, however functionality depends on which window is active.  

View Options 

View options allow the user to see various features of the kSA software and real-time charts during 
acquisition. Available options depend on which acquisition mode is selected.  

  

A. Show/hide toolbars; depends on which 
window is active.  

B. Show/hide the bottom of a window (called 
the Status Bar) when available. If no window 
is selected, the program’s status bar is 
toggled.  

C. Show/hide the Spectrometer. There will 
be as many spectrometers as are hooked up 
and active in the system.  

  

  

  

  

  

D. Show/hide available Real-Time Charts.  

  

  

  

  

  

  

  

  

E. Show/hide available controls:Digital 
Output Control, Light Source Control and 
Detector Motion. Note that Status Display 
(LCD) will never be available to the user.  

  

F. Show/hide IDL Filter Output.  

G. Show/hide Current Output 
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H. Magnify or Reduce the active window. Clicking the magnifying glass icons available on the the Main 
Toolbar does the same thing.  

Options 

BandiT has several kinds of options available from the Options menu: 

 

General Options – Colors, General, Images and Video, Logging, BandiT Settings. 

Input/Output Devices – analog/digital options and how the software will interact with installed PCI boards 

Substrate Materials Setup – for inputting/viewing file, material identifier, and fit for substrate materials 
used in BandiT Temperature acquisition. 

Logging - sets the level of logging that will be used, can be set at High, Medium or Low, see Logging for 
more information. 

Save Settings - saves the current program settings. 

Load Settings - loads previously saved program settings 

  

Light Source Control 

The lamp control is found by selecting View/Light Source Control from the main menu. It is used to control 
the lamp that provides the light that is, in turn, reflected off the sample and collected by BandiT’s optics. 

 

  

If both the Online and Lamp Status indicators are green, then – 
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use the slider or click in the box and type in a number to vary the Intensity of the light 

check the Standby button to keep the filament hot but emitting less than 5% intensity – this is 
useful for Acquiring Dark Background as well as preserving lamp life. 

The rest of this topic addresses the Online and Lamp Status indicators. 

The indicator Online turns green to indicate that the software is communicating with the lamp 
controller. 

After Online turns green, the indicator Lamp Status turns green to indicate that the lamp is 
functioning correctly. Of course, if it remains red then the lamp may need a new bulb. 

If both indicators are red, click the Detect button and the software will automatically determine the 
Comm Port for communications (see Lamp Settings below). If the Online indicator is still red, then 
please refer to the document kSA BandiT Install and Getting Started Guide supplied with the 
BandiT system for details on wiring and testing the system. 

Clicking the Settings button brings up this dialog: 

 

  

Specify: 

Comm Port – the communications port on the computer to which the lamp controller is connected 

Calibration – the factory-configured value that is based on the lamp controller. In general, this will 
not need to be changed by the user. 

Max Percent Output - the maximum output as a percentage of total lamp output 

Detector Motion Control 

Detector Motion is opened by using the    icon on the toolbar or by using the View menu. 

This is used to control the motorized Tilt and Rotate Detector which can scan across the platen and is 
required during Full Platen Temperature Acquisition (a BandiT Multi-Wafer Acquisition mode). 
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When first opened the Detector Motion dialog opens in the Reset state as shown on the left. 
Click Home to turn the Detector Motion On and activate the rest of the controls. 
The arrow button in the centre can be used to show/hide the platen properties and calibration part of the 
screen as shown in the right hand image. 

Position - With the Detector Motion On set the Position, use the slider to select a radius for the detector 
to move to, or type the require radius value into the Detector box. The motor will then move to drive the 
Tilt and Rotate Detector to the specified radius. It can be stopped at any time by clicking STOP. 

Platen Presets - The Platen Presets are used so that the detector can be moved to a specified position 
either by clicking the Preset button on this dialog box, or automatically at the end of the Full Platen 
Temperature scan. To set the Preset buttons, drive the detector to the required position, check the Set 
box and then click the Preset button that you want to set. Up to four different positions can be Preset. 
Once set these cannot be cleared but they can be set to new positions. 

Clicking the Properties button brings up the dialog box below. The Maximum  Velocity, Acceleration 
and Maximum and Minimum Positions, and the Position Resolution for the Servo motor that is installed 
in your Detector will be set automatically when the Servo board is initialized, but they can be changed 
here if required. 
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Velocity and Acceleration can be selected using the sliders on the Detector Motion dialog up to the 
maximum velocity specified in the Detector Motion Settings. 

Platen Calibration - use this to calibrate the Detector positions with the actual Platen Radius. The 
number of positions available on the detector will depend on the model in use. If it is a Goniometer model 
then 0 will be in the centre of the movement and positions will be defined +/- this, for example from -30 to 
+30 positions. The Platen dimensions are in mm. In the Full Platen Temperature Acquisition mode the 
scan parameters are set in mm, for the actual platen radius not in detector positions. 

 

Specify the Inner and Outer Radius of the Platen in mm. Specify the Inner and Outer Positions 
 of the Detector that correspond to the Platen radius. 

The Use Cur button can be used to take the Current Position of the Detector. 

  

  

Digital Output Control 

The Digital Output Control is found by selecting View/Digital Output Control from the main menu. This 
allows control of the Digital Outputs from the BandiT system. 
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Click Properties to bring up the Saved 
Settings menu where each channel can be set 
and the settings saved. 

Saved settings name - select a set of saved 
settings from the drop down list or click : 

New - to create a new set with a new 
name. 

Delete - to delete a set of saved settings 

Rename - to rename the current set of 
settings 

Saved settings values - values can be 
entered manually for each channel or by 
clicking: 

Reset to Zero - to reset all values to 
zero 

Copy from Device - to copy the current 
settings from the output device 

Click the General tab to specify the Device 
response time as shown below: 
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The set of Saved Settings that has been selected can be Applied by click Apply Saved Settings. 

Types of Properties 

There are three main kinds of properties. Each can be accessed by right-clicking the window of interest 
and selecting Properties. 

Spectrometer Properties – to view/change how the spectrometer acquires data 

Image Properties – add comments and view/change other scan mode image properties – in BandiT, the 
only images are those created by generating a pyrometric scan image for growth-rate analysis. Please 
see the help topic Pyrometric Oscillations, an advanced acquisition option, or the guide How-To Measure 
Growth Rate. 

Plot Properties – to view/change how the data is plotted 

Quick Start and How To Guides 
Quick Start 

Please see the document titled kSA BandiT Install and Getting Started Guide to set up the system. That 
guide includes step-by-step instructions for the following operations. 

1. Install Software on the computer that will control the system 
2. Install Hardware using the Schematic diagrams to help with connections  

1. Standard Light Source 
2. Tilt and Rotate Detector or CAR Port Detector 
3. BandiT Rack 

3. Power on the BandiT rack and wait for devices to install 
4. Configure the Input/Output Devices 
5. Acquire a Dark Background - without acquiring a background, the kSA BandiT system will not 

operate properly. 
6. Configure the Light Source Controller 
7. Align the Light Source 
8. Align the Spectrometer 
9. Align Tilt and Rotate or CAR Port Detector 

The system is now fully set up and should be checked to ensure that it is configured correctly as follows: 

• From the Acquire menu, select BandiT Temperature. 
• That brings up the BandiT Temperature Acquisition Window: 
• Ensure the Spectra source has defaulted to your type of spectrometer. 
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• Select the Substrate Material that you are using, and then click the Select button to choose the 
proper calibration file. 

• Click the Continuous (no data saved) button. 
• Before clicking Start, click the Config button. 
• Within the Configuration Options, choose the Automatic Intensity Control tab. 
• Click the Enable Auto Intensity Control and use the defaulted values. 
• Then click OK at the bottom of the window and the Configuration Options dialog will close. 
• Under the View menu, select Real-time BandiT Spectra (Normalized). 
• Then click the Start button in the BandiT Temperature Acquisition window. 

In the Real-time Bandit Spectra (Normalized)  window, a shape similar to this below should appear, 
with a “Band Edge” extending up about 20% from the bottom, as pictured below. 

 

Now the system is all set up and ready to go because BandiT is acquiring a “Band Edge.” 

(Note: users often keep many Real-Time Charts open (including Real-time BandiT Temperature) during 
acquisition. Note also that these measurements have been performed without substrate rotation. Further 
information on the role of rotation can be found at How-To Trigger Temperature Measurement .) 

If you encounter any problems in completing these steps, please contact us. 

Next, learn how to perform the most commonly-used routines in the kSA BandiT by reading the How-To 
Guides.  

How-To Guides 

There are several How-To Guides that cover the procedures for executing BandiT’s most commonly-used 
routines. 

How-To Acquire a Dark Background - to take the dark background reading of the Spectrometer 

How-To Measure Temperature – this is the most common use of kSA BandiT 

How-To Capture an Individual Spectrum – to acquire a single spectrum for analysis or for saving 
for reference 
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How-To Capture Continuous Spectra – to acquire spectra continuously for a specified interval 

How-To Measure Film Thickness - to acquire the thickness of films 

How-To Measure Growth Rate – a post-acquisition analysis procedure for determining the rate of 
growth 

  

How-To Acquire a Dark Background 

The first time the BandiT software is run it should prompt you to acquire a dark background. If your 
computer was supplied by k-Space, this may already have been done, but it will need to be done again at 
regular intervals. Some users do this before each temperature acquisition, or at least once a day.  

Taking a dark background at the various spectrometer integration times results in clean, noise-free 
spectra for analysis because the dark backgrounds will be subtracted automatically from the live spectra. 
It is important to generate a dark background that includes all the integration times that you will want to 
use for BandiT temperature acquisition as only those included in the dark background will be possible for 
acquisition. 

It is important that all light is eliminated from the chamber when the Dark Background is acquired. 
Remove the fiber out of the SMA Fiber Input and cover the SMA fitting or cover the detector so no light 
can get into the spectrometer. Make sure that the Light Source is not switched on or is in standby mode 
and that the substrate heater is turned off as this may contribute some radiation to the chamber.  

Select BandiT Dark Background from 
the Acquire menu or by using the 

    icon on the toolbar. 

Specify:  

Spectra source – this is the 
spectrometer. If more than one 
spectrometer is set up on the 
system, choose the one that will 
be used for temperature 
acquisition.  

Archive Name - The archive is 
named automatically by the 
software and is shown here for 
reference. 

Samples per - Samples per 
datapoint. Typically this is set at 
1. 

Min (msec) -- the minimum 
desired integration time (in 
milliseconds) for the 
spectrometer. Typically this is 10 
msec.  

Max (msec) – the maximum 
desired integration time (in 
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milliseconds) for the spectrometer. Typically this is 200 msec. 

Step (msec) – the integration time step size for the spectrometer, in milliseconds. A step size of 10 
msec will yield available spectrometer integration times in intervals of 10 msec.  

Make sure the check box Light source in standby during acquisition is checked. 

Typically, the values shown above yield plenty of range and resolution for proper temperature 
measurement. These will result in spectrometer integration times of 10, 20, 30, …, 190, 200 (msec)  being 
available for temperature acquisition. 

Click  Start to run the acquisition. 

When acquisition is complete, the Status Bar at the bottom of the kSA BandiT application window will 
read “Acquisition complete.” Click the Close button on the acquisition window 

Single Wafer Temperature 

How-To Measure Temperature 

The most common use of BandiT is measuring temperature. Note that these guides are written for single-
wafer BandiT. 

Choose which procedure depending on material and spectrometer, or measure via pyrometry:  

BandiT NearIR – for narrow band-gap substrates such as GaAs, InP, and Si using kSA BandiT’s 
NearIR spectrometer  

BandiT Visible – for wide band-gap substrates such as SiC or depositing GaN on sapphire using 
kSA BandiT’s Visible spectrometer  

BandiT Pyrometry – for simulating a single wavelength conventional pyrometer (used without a 
light source), by converting the black-body radiative intensity from the sample into a temperature 
reading. Note that such intensity is usually only significant in the Near IR wavelength range, so the 
corresponding spectrometer must be used. 

BandiT Black-Body Pyrometry - for making a wide wavelength-range pyrometric measurement, by 
fitting the radiated black-body intensity distribution to the temperature-dependent Planck equation. 
Again, this is only useful with a Near IR spectrometer, and does not need  a light source. 

For externally triggered temperature acquisition please refer to How-To Trigger Temperature 
Measurement  

BandiT NearIR 

This is one of four ways of How to measure temperature using BandiT. This procedure outlines how to 
measure temperature using kSA BandiT’s NearIR spectrometer for substrates GaAs, InP, and Si. 

1. Acquire a Dark Background 

The first step in any BandiT temperature acquisition is always to acquire a BandiT Dark Background. 
While the software does prompt the user to acquire a dark background, if that has not yet been done, 
then please take a look at the BandiT Dark Background topic in this help manual. 

2. Select Substrate Material 

After acquiring a dark background, select BandiT Temperature from the Acquire menu. 
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That brings up the BandiT Temperature 
Acquisition window.  

Specify the Substrate material (typically 
GaAs or InP) and use the Select button to 
open the table of materials, selecting the one 
that best matches your substrate. 

 

The details of the material selected can be 
seen in the Acquisition window by using the 
>> button. 

It may be the case that the Material Selection 
Library does not contain the exact 
specification of the substrate material being 
used. Generally, the closest match will 
produce perfectly acceptable results, but if 
higher precision is required, it is possible to 
apply small correction terms using either 3) 
Band Edge Correction or 4) Temperature 
Calculation (see How-To Apply Corrections). A final option is that k-Space can provide a calibration 
service for wafers that are not already listed in the Library. 

3. Set Configuration Options 

Next click the Config button to bring up the Configuration Options. This is where all the parameters for 
controlling the temperature acquisition process are set including the Band Edge settings for pre-
processing and calculating the Band Edge, Pyrometry settings, Thickness and Roughness. Check that 
are set to your requirements. 

Select the Band Edge tab to open the Band Edge configuration options and then load a Recipe for 
the substrate if desired. Then select 1) Pre-Processing. Please ensure the checkbox Divide 
datapoint by reference is not ticked 
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under the Reference tab, please ensure that No Reference is selected. 

 

Click OK to close the Configuration Options. 

4. Check Advanced Acquisition Options 

There are many advanced acquisition options available for specifying parameters of the acquisition. Click 
the Advanced button to specify such parameters as BandiT I/O Settings, Document Generation and 
Triggers. 

Recommendations: If choosing not to run in continuous mode and have selected a Duration 
longer than five minutes, it is recommended that you select Minimum data output (default) in the 
BandiT I/O Settings tab. (Note that such data cannot subsequently be re-analysed off-line, which 
requires full data storage.)  Storing raw and fully processed BandiT files mean the files can 
become so large that they cannot be reopened without increasing the amount of RAM in the 
system. Also, for any duration longer than five minutes, it is recommended that you select Store 
Incrementally in the Document Generation tab. Checking this option yields an occasional, very 
small disruption in data acquisition rather than the larger disruptions that can occur when the 
system has filled its RAM and must write it all to disk before continuing data collection. A further 
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method of reducing the amount of data stored is to record only a fraction (say 1 in 10) of the 
available data points. This is achieved by right-clicking on the spectrometer window, selecting 
Properties and opening the Advanced tab. Enter an integer in the ‘Skip frames’ box (e.g. 9 for a 1 
in 10 reduction) and close the window. 

At this point, most users simply need to click the Continuous (no data saved) radio button which does 
as it says and does not save any data. 

The Duration radio button sets the maximum amount of time for which the temperature reading can be 
taken, and data stored; however, the acquisition can still be stopped at any earlier time. These data files 
can become so enormous that the system may not be able to re-open them - see Recommendations 
above. 

The All available data from source is enabled when the Spectra source is a previously saved *.kdt file 
that is open on the desktop. These *.kdt files are created by acquiring for a specific Duration. Find more 
on this topic in the How-To Capture Continuous Spectra topic. 

Learn more about the various options in the BandiT Temperature Acquisition topic. 

5. Open Real Time Charts and Start Acquisition 

The View menu lists the data which can be shown in real time. Click to select the required displays, for 
example Real-Time Bandit Temperature (LED). 

  

That brings up the following window with the temperature given in degrees Celsius (°C). 
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Click the Start button to start the Temperature Acquisition. During acquisition, the Start button becomes a 
Pause button. Pausing acquisition causes the same button to become a Resume button. 

The Status bar (View/Status bar) at the bottom of the window displays the data point, elapsed time (in 
seconds), and confidence in the fit. 

BandiT Visible 

This is one of four ways of how to measure temperature using BandiT. This procedure outlines how to 
measure temperature using kSA BandiT’s Visible spectrometer for SiC or for depositing GaN on sapphire. 

1. Acquire a Dark Background 

The first step in any BandiT temperature acquisition is always to acquire a BandiT Dark Background. 
While the software does prompt the user to acquire a dark background, if that has not yet been done, 
then please take a look at the BandiT Dark Background topic in this help manual. 

2. Acquire a BandiT Reference 

After acquiring a dark background, select BandiT Reference from the Acquire menu or click the   
 icon on the toolbar. This acquisition mode is used to acquire a spectrum of the lamp intensity so that this 
can be used to normalize the spectra acquired during the BandiT temperature acquisition. As the aim is to 
acquire information about the lamp intensity this should be done either without a wafer present or at low 
temperature. 

  

 

This brings up the BandiT Reference 
Acquisition window as shown on the 
right. 

The Spectra source should be a visible 
spectrometer as there is no need to take 
a reference for NearIR acquisition. 

Specify the Archive name - the format of 
this is determined by the Document 
Generation tab in the Advanced 
Acquisition Options (found by clicking 
the Advanced button). The document 
name may be set as "Manual Run Name" 
in the Document Generation in which 
case the Archive name box will be white and will allow you to enter the name manually as is shown in the 
example on the right. Alternatively if the Archive name box is grey then the name will have been set 
automatically in Document Generation. To change this click Advanced and select Document Generation. 

Also in the Advanced window, click the General tab and specify the number of samples to collect (one is 
usually enough). Then select Delay to ensure no delay is set (use the drop-down Delay type menu to 
check no delay is set for any of the three types). 
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After specifying the parameters, click Start. 

When acquisition is complete, the reference file opens (e.g., "BanditReference.bsrf" based on the name 
given above) and should be saved (if not already automatically saved via the Document Generation tab 
selections). 

Close the BandiT Reference Acquisition window. 

  

3. Select Substrate Material 

 Select BandiT Temperature from the 

Acquire menu or click the    icon on the 
toolbar. 

 

This brings up the BandiT Temperature 
Acquisition window as shown on the right. 

  

Specify the Substrate material (SiC or GaN, 
typically) and use the Select button to open 
the table of materials, selecting the one that 
best matches your substrate. 

 

The details of the material selected can be seen in the Acquisition window by using the >> button. 

It may be the case that the Library does not contain the exact specification of the substrate material being 
used. Generally, the closest match will produce perfectly acceptable results, but if higher precision is 
required, it is possible to apply small correction terms using either 3) Band Edge Correction or 4) 
Temperature Correction (see How-To Apply Corrections). A final option is that k-Space can provide a 
calibration service for wafers that are not already listed in the Library. 

4. Set Configuration Options 
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Next click the Config button to bring up the Configuration Options. This is where all the parameters for 
controlling the temperature acquisition process are set including the Band Edge settings for pre-
processing and calculating the Band Edge, Pyrometry settings, Thickness and Roughness. Check that 
are set to your requirements. 

Select the Reference tab and select the reference just taken: 

  

Select the Band Edge tab to open the Band Edge configuration options and then select 1) Pre-
Processing. Ensure that the check box Divide datapoint by reference is ticked. 

  

Then click OK to close this window and return to the BandiT Temperature Acquisition window. 



BandiT User Manual 

88 

5. Check Advanced Acquisition Options 

There are many advanced acquisition options available for specifying parameters of the acquisition. Click 
the Advanced button to specify such parameters as BandiT I/O Settings, Automatic Intensity Control and 
Triggers. 

Recommendations: If choosing not to run in continuous mode and have selected a Duration 
longer than five minutes, it is recommended that you select Minimum data output (default) in the 
BandiT I/O Settings tab. (Note that such data cannot subsequently be re-analysed off-line, which 
requires full data storage.) Storing raw and fully processed BandiT files mean the files can become 
so large that they cannot be reopened without increasing the amount of RAM in the system. Also, 
for any duration longer than five minutes, it is recommended that you select Store Incrementally 
in the Document Generation tab. Checking this option yields an occasional, very small disruption in 
data acquisition rather than the larger disruptions that can occur when the system has filled its 
RAM and must write it all to disk before continuing data collection. A further method of reducing the 
amount of data stored is to record only a fraction (say 1 in 10) of the available data points. This is 
achieved by right-clicking on the spectrometer window, selecting Properties and opening the 
Advanced tab. Enter an integer in the ‘Skip frames’ box (e.g. 9 for a 1 in 10 reduction) and close 
the window. 

At this point you need to select a data acquisition mode, most users simply need to click the Continuous 
(no data saved) radio button, which does as it says and displays the data as it is collected but does not 
save it. 

The Duration radio button sets the maximum amount of time for which the temperature reading can be 
taken, and data stored; however, the acquisition can still be stopped at any earlier time. These data files 
can become so enormous that the system may not be able to re-open them - see Recommendations 
above. 

The All available data from source is enabled when the Spectra source is a previously saved *.kdt file 
that is open on the desktop. These *.kdt files are created by acquiring for a specific Duration. Find more 
on this topic in the How-To Capture Continuous Spectra topic. 

Learn more about the various Advanced Acquisition Options in the BandiT Temperature Acquisition topic. 

6. Open Real Time Charts and Start Acquisition 

The View menu lists the data which can be shown in real time. Click to select the required displays, for 
example Real-Time Bandit Temperature (LED) or Real-time Bandit Spectra. 

 

That brings up the following window with the temperature given in degrees Celsius (°C). 
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Click the Start button to start the Temperature Acquisition. During acquisition, the Start button becomes 
a Pause button. Pausing acquisition causes the same button to become a Resume button. 

The Status bar (View/Status bar) at the bottom of the window displays the data point, elapsed time (in 
seconds), and confidence in the fit. 

BandiT Black-Body Pyrometry 

This is one of four ways of how to measure temperature using BandiT. This procedure outlines how to 
measure temperature by performing non-linear least squares fitting of a blackbody thermal radiation curve 
to spectra in real time. This allows a measurement of the temperature which is independent of the band 
edge method. 

Generally, this technique is inferior to using a band edge thermometry. However, the band-edge 
technique often fails when depositing a very absorbing layer, so the Pyrometry technique (such as the 
Black-Body Pyrometry described here or the conventional Pyrometry method) is available for such 
situations. The Blackbody technique allows measurement over a wide wavelength while conventional 
Pyrometry is restricted to a narrow wavelength. 

Important note: do not use a light source when using this technique to measure temperature. Because 
this technique is signal-level dependent, any light source will add potentially variable signal and so affect 
the temperature conversion, which will lead to an improper temperature reading. 

This guide assumes the system is calibrated to read the correct temperature using transmission mode 
(without a light source) using one of BandiT’s spectrometers. See How-To Measure Temperature. 

1. Technical background 

Spectral radiance is the fundamental measure of the amount of light that can reach a detector from a 
diffuse source. It is defined as the emitted power per unit area of emitting surface, per unit solid angle, per 
unit wavelength. The image below is a plot of the spectral radiance of a blackbody for several different 
temperatures commonly used in semiconductor processing. Note that the peak shifts to shorter 
wavelengths as the temperature increases. 
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This behavior can be expressed mathematically in the form of Wien’s displacement law: 

 

Here T is the temperature (in Kelvin), and b is a constant which equals 2.8978×106 nm-K. 
Note that in the temperature range of interest for typical semiconductor processing, the peak lies in the 
mid-IR portion of the spectrum. Thus, for the most part, BandiT spectral data comes from the short-
wavelength exponential tail below the peak. This often poses a challenge, as the signal intensity is 
relatively weak in this region. 

According to Planck’s law, the spectral radiance I (λ, T) of a blackbody at a given temperature is given by: 

 

In fitting a function of the form described in Planck's law to spectra there are four adjustable parameters: 
the material’s emissivity ε, the tooling factor T.F., the temperature T (in Kelvin), and an optional constant 
background C. The tooling factor incorporates system-dependent geometrical and sensitivity factors, and 
therefore must be determined empirically. 
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The tooling factor can be determined by calibrating to a blackbody curve at a known temperature (e.g. 
from a band edge measurement, RHEED transition, or Si/Al eutectic). In this case the temperature is held 
fixed at the known value, and the tooling factor is allowed to vary to obtain the best fit. Once the tooling 
factor is known, a blackbody fit can then be performed in real-time during BandiT data acquisition. In this 
case, the tooling factor is held fixed, and the temperature is allowed to vary to obtain the best fit. This is 
the so-called “Locked” mode of operation. This approach assumes that the tooling factor and sample 
emissivity do not change after calibration. 

Alternatively, in cases where this assumption may not be valid, the “Free Fit” mode of operation can be 
used. In this mode both the temperature and tooling factor are allowed to vary in order to obtain the best 
fit. In principle, this approach is insensitive to viewport coatings as the tooling factor can vary over time to 
accommodate the resulting decrease in signal intensity. The same holds true for the emissivity. 

However, in practice the best results are typically obtained by calibrating at the highest practical 
temperature and locking the tooling factor. If the calibration temperature is not known via some other 
means, a free fit can be done to determine it. Then the tooling factor can be determined as described 
above. This is the so called “Self-Calibration” method (Figure 2). 

Whichever mode is chosen, the non-linear least squares fitting routine requires initial guesses for the four 
adjustable parameters in Equation 2. The routine is sensitive to the accuracy of these values; if they differ 
too much from the actual values, the fitting routine will fail to converge. In order to minimize this 
occurrence, “Auto” mode may be selected. In this mode, approximate values of these parameters are 
automatically calculated and used as the initial guesses. 

A simplified version of the Planck expression can be used to obtain these values. This is the so-called 
“Wien approximation” (Equation 3). This approximation is valid in the limit that hc / λkT >> 1. This applies 
when the wavelength is well below the peak of the spectral radiance in Figure 1, which is typically the 
case at low temperatures. 

 

Neglecting the background C, and performing a suitable transformation, this can be expressed as a linear 
function of 1/λ (Equation 4). 

 

Thus a simple linear least-squares fit can be performed to the transformed spectra. The tooling factor can 
be extracted from the intercept, and the temperature from the slope. These values can then be used as 
the initial guesses in fitting to the full Planck expression (Equation 2). Note that this works well in many, 
but not all circumstances. If for some reason the fitting routine fails to converge when using “Auto” mode, 
then starting guesses will have to be manually entered in the usual fashion. 

In addition to providing initial guesses for the fit to Equation 2, the linearized spectra provide a better 
visual representation of any deviations from an ideal blackbody curve across the spectral range. This 
allows the user to improve the robustness of the fit by excluding portions of the spectrum. This is 
particularly useful at low temperatures, where noise can have a significant impact at the shorter 
wavelengths where the expected blackbody intensity is quite low. The images below show the Real-time 
Wien linearization chart and the corresponding conventional fit to a low temperature Blackbody (note the 
deviation from linearity at short wavelengths). 
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2. Choose Measurement Mode 

The choice of measurement mode, either Free Fit or Locked determines the processes that are required 
in order to calculate the Blackbody temperature. 

Locked mode is used where a temperature can be measured by some means, for example conventional 
BandiT Band Edge mode, and then the Tooling Factor can be obtained during the Calibration process. 
The Tooling factor can then be "Locked" during acquisition so that Blackbody temperature can be 
measured. 

Free Fit mode is used where it is not possible to measure a temperature using the conventional BandiT 
Band Edge mode, for example when measuring Antimonide materials where an absorption edge is 
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outside the spectrometer range. In this case there is no known temperature to use to calibrate the Tooling 
Factor and both the temperature and tooling factor are allowed to vary in order to obtain the best fit. 

The flow chart below shows the sequence of processes: 

 

The steps that follow below describe the Locked Mode which requires the use of the Calibration 
Procedure. 
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3. Enable Flat Field Correction (FFC) 

The spectrometer output has been corrected to yield a 
flat response as a function of  wavelength. This 
correction is unique to each individual spectrometer. 
Before attempting to calibrate blackbody, make sure this 
correction is enabled. 

Right-click anywhere in the live spectrometer window 
and select Properties. Select the Spectrometer tab, and 
verify that the Flat Field Correction checkbox is 
enabled. If not, select the Browse button and select the 
appropriate FFC file for the spectrometer in question. 
 When finished, select OK to return to the live 
spectrometer window. 

  

4. Set Chamber Temperature 

Select BandiT Temperature from the Acquire menu or 

the  icon from the toolbar. This brings up the 
BandiT Temperature Acquisition. 

In the BandiT Temperature Acquisition window, make 
sure that Continuous (no data saved) mode is selected and that BandEdge/Pyrometry/Blackbody is 
selected. Also, tick the Control Light Source based on mode, which ensures the light source stays off. 

Next, open the Real-Time Bandit Temperature (LED) Real Time Chart from the View menu. 

Now, click Start on in the BandiT Temperature Acquisition window and ramp up the chamber 
temperature until it reads the BandiT temperature that you want to use for calibration in the Real-time 
BandiT Temperature (LED) window. 

Then, leave the temperature where it is and press the Stop button in the acquisition window and close 
the Temperature Acquisition mode. 

  

5. Calibration 

In order to run in Locked mode the Tooling Factor must be calibrated first. To do this open the 
Blackbody Calibration Acquisition mode from the Acquire menu. Also open the Real-time Blackbody 
Spectra Real Time Chart from the View menu. 
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Select the Spectra source from the pull-down 
menu. 

Enter the desired wavelength range over which 
to perform the blackbody fit. Entering zeros will 
cause the software to automatically select the 
spectrometer’s min and max wavelengths. The 
values can be locked using the check boxes. 
Alternatively, if one or both boxes are 
unchecked, the software will attempt to optimize 
the goodness of fit by successively reducing the 
range each time the Calibrate button is pressed. 

Enter the Threshold, which specifies the 
minimum number of counts for performing a 
blackbody fit. Spectra which don’t have at least 
this many counts will be ignored. 

Enter the calibration sample’s Emissivity. If not 
known, a value of 1 can be entered. In this case 
the emissivities of the subsequent samples will 
need to be expressed relative to that of the 
calibration sample, instead of entering the actual 
values. 

 Enter the Goodness of Fit Threshold. This 
allows rejection of spectra with poor fits, as 
measured by the reduced chi-squared statistic. 
The default value is 20, meaning spectra which 
have reduced chi-squared greater than this 
value will be ignored. 

Enter the Blackbody Fit Tolerance. The fitting 
routine stops when chi-squared decreases by 
less than this tolerance value upon successive 
iterations (default is 1.0E-3). 

Enter the Raw Spectra Boxcar value (must be 
odd, default is 9). This specifies the number of 
points used to perform a moving average, a.k.a. 
boxcar smoothing of the spectra before 
attempting to fit. 

Enter the Calibration mode. Select Lock 
Temperature if the calibration temperature is known, or Free Fit to self-calibrate. 

Enter the calibration Temperature (ºC). If self-calibrating, enter an estimate of the temperature to be used 
as an initial guess by the fitting routine. Note that the results are fairly sensitive to the initial guess. 
Typically, it should be within ~20%, but the routine tends to be more forgiving if this represents an over-
estimate rather than an under-estimate. If Auto mode is selected, this will be calculated automatically. 

Enter an estimate of the Tooling Factor to be used as an initial guess by the fitting routine. If Auto mode 
is selected, this will be calculated automatically.  Selecting Allow constant offset permits the constant C 
to be calculated automatically. Otherwise, it is forced to zero. 

Select Start. The software will determine the temperature by attempting to fit a blackbody curve to the 
source spectra in real-time using the most recently saved tooling factor and emissivity values. These 
values can be found in the BandiT Temperature Acquisition settings. The Real-time Blackbody Spectra 
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Real Time Chart displays the source data in blue and the resulting fit in black. At the top of the window it 
displays the temperature, tooling factor, emissivity, and the goodness of fit statistic (i.e. the reduced chi-
squared). If the goodness of fit statistic exceeds the threshold value, a message will appear. Pressing 
Calibrate will cause the fitting routine to attempt to perform a fit according to the current settings. If 
successful, the corresponding tooling factor will be calculated. If needed, the wavelength range can be 
adjusted for optimum results. Every time Calibrate is pressed, the settings are automatically saved. 

 

  

6. Set Up Blackbody Processing Recipe 

Select BandiT Temperature from the Acquire 

menu or the  icon from the toolbar. This 
brings up the BandiT Temperature Acquisition. 

Ensure that BandEdge/Pyrometry/Blackbody is 
selected. Also, tick the Control Light Source 
based on mode, which ensures the light source 
stays off. 

Select Config to open the Configuration Options 
and then select the Blackbody tab. 

Select Compute Blackbody Temperature to 
enable blackbody fitting. 

The user has the option to clip the raw spectrum 
below a min wavelength, and/or above a max 
wavelength. This is intended to allow the removal 
of noisy portions of the spectrum which may exist 
under certain circumstances. 
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Enter the Raw Spectra Boxcar value (must be odd, default is 9). This specifies the number of points 
used to perform a moving average, a.k.a. boxcar smoothing of the spectra before performing attempting 
to fit. 

Enter the Threshold, which specifies the minimum number of counts for performing a blackbody fit. 
Spectra which don’t have at least this many counts will be ignored. 

Enter the sample’s Emissivity. Note that this is not necessarily the same as the emissivity used in the 
calibration procedure. This allows the user to perform the calibration on a sample which is different than 
the sample under test. If a value of 1 was entered during calibration, the sample’s emissivity will need to 
be expressed relative to that of the calibration sample, instead of entering the actual value. 

Enter the mode. Select Lock Tooling Factor if it is desired to run in Locked mode, or Free Tooling 
Factor and Temperature if Free Fit mode is desired. 

Enter the Tooling Factor. If a calibration was performed as described above, this will already contain that 
value. If in Locked mode, this will be the value used for all calculations. If in Free Fit mode, this will be 
the initial guess, unless Auto is selected, in which case it will be calculated automatically. 

Enter an Initial Temperature estimate. Note that the results are fairly sensitive to the initial guess. 
Typically, it should be within ~20%, but the routine tends to be more forgiving if this represents an over-
estimate rather than an under-estimate. If Auto mode is selected, this will be calculated automatically. 

Selecting Allow constant offset permits the constant C in to be calculated automatically. Otherwise, it is 
forced to zero. 

Enter the Blackbody Fit Tolerance. The fitting routine stops when chi-squared decreases by less than 
this tolerance value upon successive iterations (default is 1.0E-3). 

Selecting Discard data above goodness threshold allows rejection of spectra with poor fits, as 
measured by the reduced chi-squared statistic. Spectra which have reduced chi-squared greater than the 
entered Goodness of Fit Threshold will be ignored. The default value is 20. 

Specify the Wavelength Range. This can be fixed, or the upper limit can be adjusted dynamically relative 
to the sample’s band edge. In this way the measurement is restricted to the “above-gap” portion of the 
spectrum where the sample is opaque. This is based on the “knee” in the spectrum, which is located at 
the peak of the 2nd derivative, i.e. the wavelength where the slope is increasing most rapidly. If this 2nd 
derivative option is selected, the smoothing and number of data points to offset from the knee must be 
specified. 

When satisfied with all the settings, select OK to return to the Temperature Acquisition window. 

  

7. Acquire Blackbody Temperature 

Once the spectra processing recipe has been set up, acquisition can begin by selecting Start in the 
BandiT Temperature Acquisition window. During data acquisition, in addition to the live spectrometer 
window, the user may view a number of real-time charts and stats which provide useful information. 
These can be accessed from the View menu. For example, the Realtime Blackbody Spectra chart which 
displays the raw data and the resulting fit, as shown above during Calibration, Realtime Blackbody 
Temperature (LED), and Real-time Blackbody Temperature (Time) which plots the blackbody temperature 
versus time as shown below. 
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BandiT Pyrometry 

This is one of four ways of how to measure temperature using BandiT. This procedure outlines how to 
measure temperature using the intensity of black-body radiation over a narrow wavelength. Generally, 
this technique is inferior to using a band edge thermometry. However, the band-edge technique often fails 
when depositing a very absorbing layer, so the Pyrometry technique (either a conventional method 
described here, or the Black-Body Pyrometry method) is available for such situations. 

Important note: do not use a light source when using this technique to measure temperature. Because 
this technique is signal-level dependent, any light source will add potentially variable signal and so affect 
the temperature conversion, which will lead to an improper temperature reading. 

This guide assumes the system is calibrated 
to read the correct temperature using 
transmission mode (without a light source) 
using one of BandiT’s spectrometers. See 
How-To Measure Temperature. 

1. Set Chamber Temperature 

Select BandiT Temperature from the 

Acquire menu or the  icon from the 
toolbar. 

  

 

This brings up the BandiT Temperature 
Acquisition window as shown on the right. 

In the BandiT Temperature Acquisition 
window, make sure that Continuous (no 
data saved) mode is selected (as shown ) 
and that BandEdge/Pyrometry/Blackbody is 
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selected. Also, tick the Control Light Source based on mode, which ensures the light source stays off. 

Next, select Real-Time Bandit Temperature (LED) from the View menu. 

  

 

  

Now, click Start on in the BandiT Temperature Acquisition window and ramp up the chamber 
temperature until it reads a BandiT temperature of, for this example, 500°C in the Real-time BandiT 
Temperature (LED) window. 

Then, leave the temperature where it is and press the Stop button in the acquisition window. 

  

2. Calibrate the system for Pyrometry 

Next calibrate the system for Pyrometry. 

Open the BandiT Pyrometry Calibration 
acquisition mode from the Acquire menu. 

In this window, set the material-dependent 
Center Wavelength, here it is set at 950 nm 
and set the Width which is the overall width 
around the centre wavelength that bandit will 
use to detect blackbody radiation, here set to a 
width of 20 nm, so the algorithm is looking 
between 940 and 960nm. It is important that the 
wavelength range chosen is within the absorbing 
range of wavelengths for the material being 
measured, otherwise erroneous results may be 
obtained. This is the wavelength that BandiT will 
use when looking for blackbody radiation. 

Leave the other numbers as they are, except the 
Calibration temp (C), which should be the 
current system temperature (500 in this 
example). 

Note that emis/emis_cal is 1 because in this 
case we’re calibrating the pyrometry 
temperature based on the temperature of the 
material being measured. Learn more about this 
in the Pyrometry tab topic. 
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Set a Duration of a few seconds, this is the time that will be used to perform the calibration. 

Click Start to start the acquisition process and then click Calibrate. The system will show "Calibrating" in 
the task bar . When the calibration is complete click Stop and then Close to finish the acquisition and 
close the dialog box. 

The system is now set up to use Pyrometry of the selected wavelength to measure the BandiT 
Temperature. 

  

  

3. Check Config Options 

Open the BandiT temperature Acquisition mode , click on the Config button and select the 
Pyrometry tab. 

 

You will see that the Scal (counts) value has been entered automatically by the Calibration procedure. 
This is the signal calibration, and will be a large number (many thousands to several million, depending 
on signal strength). The Calibration system will also have set the Integration Time to the Spectrometer 
integration time during the calibration procedure. 

5.  Acquire Temperature via Pyrometry 

At this point, the system is calibrated to use Pyrometry for measuring temperature. To check, select Real-
Time Pyrometer Temperature (LED) and the Real-time BandiT Temperature (LED) from the View menu. 
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Next, again select Continuous (no data saved) in the BandiT Temperature Acquisition window. 

 Click Start. Both the Real-time BandiT Temperature (LED) window and Real-time Pyrometry (LED) 
window should have the same temperature (or very nearly the same – within a degree or two at most). 

That’s it! Use the Real-time Pyrometry Temperature (LED) window to view the temperature via 
Pyrometry. 

How-To Trigger Temperature Measurement 

If the system has not yet been set up to gather temperature, go to the How-To Measure Temperature 
guide and work through steps to acquire a dark background, a BandiT reference if required and to set up 
the parameters for Temperature acquisition. 

Once the system is set up to gather temperature, temperature measurements can be acquired via kSA 
BandiT: 

Continuously – for NearIR, Visible, and via Pyrometry 

Externally triggered – for NearIR and Visible (legacy – before August, 2006) 

Externally triggered with software control – for NearIR and Visible 

This how-to manual describes each type of temperature measurements and the steps needed to 
implement an external trigger (with and without software control). It should be noted here that this 
capability is for "Single-Wafer BandiT," which can be configured to capture the temperature measurement 
of any single wafer in a platen, but not more than one wafer except through continuous mode (capturing 
all data from whatever is placed in front of the BandiT system). k-Space Associates also offers "Multi-
Wafer BandiT," which gathers data from each wafer as it rotates in front of the BandiT system, omitting 
contributions from the platen. 

  

1. Continuously 

Continuously measuring temperature has been described in the other How-To Measure Temperature 
Guides and is currently the only way to set up the system to measure via pyrometry. For the Near IR and 
Visible spectrometers running on a standard desktop PC, the “continuous” setting usually results in about 
40 measurements per second. The main performance limiter is the integration time of the spectrometer, 
which is running in an asynchronous reset mode and polling for a new spectrum as fast as the system 
can operate. For example, an integration time of 25 ms yields the 40 measurements per second. Note 
that these measurements are initiated by software and are prone to a small amount of jitter. 
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2. Externally Triggered 

  

Externally triggered acquisition utilizes the 
trigger line of the spectrometer and gathers a 
temperature measurement the moment a trigger is 
received. This is a legacy feature for systems that 
shipped before August, 2006, and is configured in 

just a few steps: 

1. Connect the external TTL-signal to the 
BNC connection labeled "Ext. Trig" on the 
back of the kSA BandiT rack.  

  

2. From the BandiT software main menu, 
select View and click the Spectrometer 
name to open the Spectrometer [live] 
window.  

 

3. On the Spectrometer [live] window, right 
click on the window and select 

Properties.  

  

4. Select the Spectrometer tab and tick the External Trigger check box at the bottom of this tab.  

  

5. Click Apply. The spectrometer is now configured to take data only when an external trigger is 
received. 

 
 

  

3. Externally Triggered Through Software Control 
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Externally triggered through software control means setting in a delay after receiving a trigger and 
gathering one or multiple data samples. This option is useful for gathering the temperature measurement 
across a single wafer as it spins by the BandiT system in a platen. (Note that k-Space also offers "Multi-
wafer BandiT," which performs this same temperature measurement for each wafer as it spins by the 
BandiT system.) Please follow the steps below to configure the system for software control of external 
triggers:  

1. Depending on your system (older models use 
pin X on the 15-pin connector, all recent 
systems use BNC connection labeled "Ext. 
Trig"), connect the external TTL-signal to the 
back of the kSA BandiT rack. If you need further 
assistance in this, please contact us. 

2. From the BandiT software main menu, select 
View and click the Spectrometer name to open 
the Spectrometer [live] window. 

  

 

  

3. On the Spectrometer [live] window, right click 
on the window and select Properties. 

4
.
 
S
e
l
e

ct the Spectrometer tab and be sure the External 
Trigger check box is not ticked at the bottom of 
this tab - as shown on the right. 

  

5. Next, select the Home Pulse Monitor tab and 
tick the Enable checkbox.  

For the Device Name – determine whether the 
kSA BandiT system has a DT9800-series or 
Measurement Computing PMD-1208FS board. 

To do this, open the Computer's Device Manager 
(found on the Control Panel, System, Device 
manager). 
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If "DT-Open Layers Acquisition Devices" (or some close variant) is listed, then the system 
has a DT9800-series board. Click the + icon to find the name of the device (e.g., 
DT9806(01)). Enter that name exactly as it appears into the Device Name box. Note that 
some systems will not have any parenthesis for the name (e.g., DT9806). 

If it is not a DT9800-series board, then (except in a few specialty cases), it is a 
Measurement Computing Board. Click Start  All Programs, and run the InstaCal program 
(it may be listed under "Measurement Computing"). In the InstaCal window, find the 
Measurement Computing board and note the board number. In the Device Name box, enter 
CB(<boardnumber>,1), where <boardnumber> is the number reported by the InstaCal 
software. 

For example, CB(0,1) would be entered if InstaCal reported that the board number is 0. 

For the other parameters of this dialog, please see the descriptions in the Home Pulse 
Monitor topic. 

6. Click Apply. If a dialog appears stating that the Home Pulse monitor could not be found, then 
the device name is wrong. Please ensure that the device name is entered exactly as described 
above. If you need further assistance with this step, please contact us. 

  

4. Select Phase Delay 

The Phase Delay in the Home Pulse Monitor 
menu shown above is the delay after the 
Home Pulse has been detected and before 
the temperature is measured. This can be set 
up using the Phase Delay Selection 
Acquisition mode. 

Open Phase Delay Selection from the 

Acquire menu or by using the   icon on 
the toolbar. 

One type of hardware to monitor rotation must 
be installed and enabled in the BandiT system 
for the Phase Delay Selection acquisition to 
work. Go to Check Hardware Rotation Board 
to locate and enable the correct option for 
your system. 

Select Spectra source and Substrate 
material as usual for BandiT Temperature 
Measurement. 

Enter the number of Rotation Positions that 
will be  tracked by the system. The number of 
positions chosen depends on a combination 
of the rotation speed, exposure time and the 
processing that is being done. For most 
purposes a range between 100 and 128 will 
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be sufficient. If the platen is very large then a larger number of positions would be needed to get the 
resolution high enough. 

Enter  the  RPM,  revolutions per minute, of the sample rotation stage, if known. 

If the Hardware Rotation method can detect the RPM the Auto RPM  check box will become available, 
select it to allow the automatic synchronisation to RPM. 

Open the Real-time Bandit Phase Delay Selection Real Time Chart from the View menu. This Real-Time 
Chart should be set to plot the Peak Intensity against the rotation positions. If it is not, right click the plot 
and select Properties and then Plot value, and select Peak Spectra Intensity from the drop down list. 

Click Start. The Real-time BandiT Phase Delay Selection chart will start to update with an active trace 
which will re-trace itself as the sample rotates. Let it stabilise so that it retraces itself reliably as shown in 
the first image below, then click Stop. It is now possible to move the red marker from the left hand side of 
the chart by clicking and dragging the triangle at the top of the marker line. Move this marker to the 
position of greatest peak intensity - this will be the location where data will be collected - as shown in the 
lower image. 

 

  



BandiT User Manual 

106 

 

When the marker is in the correct position click Set Phase Delay. The delay (in ms) will be entered into 
the Phase Delay field in the Home Pulse Monitor screen, found by right clicking the Live Spectrometer 
window and selecting Properties. From this point onwards the system will be triggered to only take a 
snapshot of data when the stage rotation reaches the marker. 

The system will now acquire the 
specified number of samples after the 
specified delay after receiving the home 
pulse. Please refer to the How-To 
Measure Temperature guide for more 
information on temperature 
measurement. 

How-To Capture 
Continuous Spectra 

Capturing a spectrum continuously for a 
specified interval is useful because it can 
be used as if it were a data source for 
analysis. This makes it easy to analyze 
at any time because it can be stored for 
future reference. It also makes it easier 
for  us to troubleshoot your temperature 
analysis: contact us and then send us 
the full *.kdt movie. Then we can replay it 
and analyze it, seeing the data exactly as 
it was acquired. 

To capture a continuous spectra of a 
specified interval, first select BandiT 
Temperature from the Acquire menu. 
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Next, choose Duration and specify an acquisition time period, for example 5 minutes as shown on the 
right. 

  

Then click the Advanced button. That brings you to the Advanced Acquisition Options. Next, select the 
BandiT I/O Settings tab and choose Store raw and fully processed spectra. 

  

 

  

If acquiring for more than 5 minutes, then click over to the Document Generation tab and click the 
Store Incrementally button. This also will automatically select Auto-save, Auto-close, and Auto-hide 
and prevent the user from disabling those selections. 
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That’s because storing raw and fully processed spectra means saving enormous files that will interrupt 
acquisition significantly if the system only saves when RAM is full. Storing incrementally means the 
system will regularly take data from RAM and store it to disk. While this will cause slight disruptions in 
acquisition, they may not be noticeable at all. And even if it is, the disruptions will be regular and small. 
Most modern machines have enough RAM to store five minutes worth of this kind of data before needing 
to store it to disk. 

Important Note: files can be so large that it literally may take minutes for one to open. Also, it is possible 
to generate files—using the Store Incrementally option—that are so large that they cannot be re-opened 
until more RAM is made available (or purchased!). 

Click the OK button at the bottom of the Advanced Acquisition Options window to return to the BandiT 
Temperature Acquisition window. 

Then click the Start button. At the end of acquisition, a *.kdt file has been archived as specified in the 
Document Generation Advanced Acquisition Option. Open it and, using the *.kdt toolbar, play the file as a 
movie. You can also use it as an acquisition source. 

How-To Capture an Individual Spectrum 

Capturing individual spectra is useful for analysis and for saving for future reference.  

To capture an individual spectrum, simply select SnapShot from the Edit menu on the Live Spectrometer 
window, as shown below.  
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A new window will open up with a single spectrum.  

How-To Measure Growth Rate 

The kSA BandiT system has the ability to determine deposition rate from pyrometric interference 
oscillations in radiated light from the sample surface. These oscillations occur when a film is being 
deposited with different index of refraction from the under layer or substrate. 

Specifically, when the sample is hot enough to emit blackbody radiation, this radiation is emitted in all 
directions. Radiation that is emitted back into the sample is reflected off the interface between the film 
and the substrate (provided there is a refractive index difference at this interface). This reflected radiation 
then interferes with radiation that is forward-emitted from the surface. BandiT collects this interference, 
allowing users to observe the oscillations in intensity at any given wavelength. Growth rate may be 
extracted by fitting these oscillations to simple optics equations. 

Requirements for this type of analysis with the BandiT system are: 

• a film and substrate of different material composition, 
• a semi-transparent film and substrate (this requirement is satisfied by most semiconductor 

materials), and 
• a sufficiently thick film, on the order of 2000 Å or more. 

To measure growth rate, first execute the same steps in the How-To Capture Continuous Spectra, but do 
not yet click OK at the bottom of the Advanced Acquisition Options window after specifying Store raw 
and fully processed data. Instead, select the Pyrometric Oscillations tab and click Generate pyrometric 
scan image for growth rate analysis. To see the image being created during acquisition, click the Show 
pyrometric scan image in real-time. 

 

Click the OK button at the bottom of the Advanced Acquisition Options window to return to the BandiT 
Temperature Acquisition window. 

Next click the Start button. That will start acquisition. A typical kSA BandiT spectra is shown below. This 
spectra shows the collected light intensity at each wavelength in the range from 870nm-1400nm. Spectra 
in this range is typical for monitoring the temperature of GaAs, Si, and InP substrates. 
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At the end of acquisition, locate and click the BandiT Scan Mode Image window. (The following image 
has had IDL 40 palette applied to it.) 
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Looking from left to right, the absorption edge of the substrate material corresponds to the color change 
from black (above the band gap where absorption occurs) to violet, blue and green (below the band gap 
where the sample is transparent). 

Looking from the top to the bottom of the image (in the colored area), first notice that there are no 
oscillations. That’s because all shutters were closed. Then a shutter was opened and some growth 
occurred (oscillations data begins about a sixth of the way down). Then the shutter was closed (about half 
way down). Then a different shutter was opened and growth occurred at a different rate (different rate and 
amplitude of oscillations). This is easily seen with a Line Profile, which is needed for analysis. 

From the Analysis menu, select Line Profile. 

 

With a vertical Line Profile of a Scan Mode Image, the plot shows the time-dependence of intensity at 
each wavelength within the range of the spectrometer. 
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For the data run shown here, deposition of GaAs on AlGaAs began at approximately 1150 seconds. 
Growth was then stopped at 5200 seconds, and commenced again at 5500 seconds with the deposition 
of AlGaAs on GaAs. Deposition of the AlGaAs layer stopped at 9600 seconds. 

The Line Profile is at wavelength 1228 nm. Simply move the vertical Line Profile across the image to 
see similar data at different wavelengths. In doing so, however, the range of the Intensity axis will change. 

For growth rate determination, choose the largest intensity amplitude possible: as above, the range 
between maximum and minimum may only be a couple of percentage points. It is also important only to 
choose one set of oscillations (so that it only measures one deposition process) and does not contain any 
data when growth was not occurring. This can be done in two ways: 

• Place the cross-hairs on the Line Profile window to the immediate left of the oscillation data. 
Right-click and select Set X Min. The graph will be cropped to that value. Right-click on the value 
to the immediate right of the oscillation data and select Set X Max. Then the Line Profile will only 
include the oscillation data. 

• Reduce the size of the line itself on the Scan Mode Image, which automatically adjusts the Line 
Profile. For example, the portion selected below is the GaAs growth rate, a subset of the full data 
set. 
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Next, with the Line Profile window highlighted, select the Pyrometric Growth Rate from the Analysis 
menu. 
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Right-click the Pyrometric Growth Rate window and select properties. In the plot below, the Index of 
Refraction parameter is set to 3.62, markers are placed on the data Series, and Discrete Fourier Analysis 
(DFT, recommended) is chosen in the Fourier Transform plot property. 

 

The growth rate is determined from this equation: 

 

where 

G = growth rate 

T = period (determined by the frequency analysis of the acquired data set) 

λ = wavelength (depends on the placement of the line in the Line Profile) 

η = index of refraction 

This is because the emitted radiation reflects off the interface between the film and the substrate and 
interferes with radiation emitted directly outward from the surface. A peak intensity occurs whenever the 
optical path length of the film is a multiple of the wavelength of light. That is, a peak in detected intensity 
occurs at thickness intervals of (λ/2η), where η is the index of refraction of the film. It follows that the 
oscillation period will be 

, 

which is trivially manipulated to give the equation above. 

Only the index of refraction (η) is unknown. A direct way to determine η is by taking simultaneous 
pyrometric interference data and RHEED oscillation data. By determining G from RHEED and T from the 
pyrometric interference data, one can solve for η. Furthermore, one can determine the dispersion curve 
for η at a given wavelength by solving for η at every wavelength. 
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A dispersion curve for η for GaAs is shown below (determined using the methodology described here) in 
the wavelength range 900-1280nm. 

 

Once η is determined for a given wavelength and temperature, then the equation above may be used to 
accurately determine growth rate with BandiT. Absolute rates accurate to within 2-3% should be 
obtainable. 

How-To Measure Film Thickness 

In addition to band edge thermometry, BandiT software has the capability of using the interference 
patterns observed in the reflectance spectrum from a thin film to obtain thickness information. (Note that 
to see such oscillations, there needs to be a refractive index difference between the film and substrate, 
preferably with that of the film being higher.) This can be exploited to determine a film’s thickness by 
comparing the wavelengths of the extrema of these oscillations, provided the index of refraction is known 
as a function of wavelength. This is to be distinguished from the use of temporal reflectivity oscillations 
over a narrow wavelength range to calculate film thickness during growth. 

1. Technical Background 

As one approaches the absorption edge from the below-gap direction (i.e. long wavelengths), absorption 
starts to become significant and the spectral oscillations therefore become damped. Thus these 
measurements are best done as far below gap as is practical (i.e. at wavelengths greater than the 
absorption edge wavelength). 
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The image above shows a plot of the below-gap portion of a normalized reflectance spectrum from a 
GaAs film. It has been normalized using a reference spectrum in order to remove the effects of the 
spectral variation of the light source output. The spectrometer output has also been corrected to yield a 
flat response as a function of wavelength. The spectrum has been scaled so that the maximum value is 
unity. In the below-gap portion of the spectrum (where the film’s absorption is small), the film thickness 
can be determined using the following expression: 

  

In this equation: 

 λi   - are the wavelengths of the extrema, which are found from the zero crossings of the first 
derivative of a digitally smoothed spectrum. 

ni   - represents the indices of refraction at those wavelengths 

di  - the resulting thickness values. 

Thus, a thickness value is obtained for each extremum. Note that this method requires only the 
wavelengths of the interference peaks and valleys, and therefore does not rely on knowledge of 
absolute reflectance values. It assumes the measurements are done at normal incidence, but non-
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normal incidence can be accounted for by scaling the results as described in the next section of 
this document. 

m   - represents the integer order number at each extremum. As can be seen in the annotated 
spectrum below, the order increases by unity (i.e. the phase changes by π) from one extremum to 
the next with decreasing wavelength. The order numbers are calculated using an iterative method 
by selecting the set of m values that minimizes the spread in the calculated thickness values (see 
graph below). 

δ   - represents a phase shift due to the film/substrate interface. Likewise, the optimum delta value 
is determined by minimizing the spread in the individual thickness values.  These values are 
averaged to get the final thickness result, with the standard deviation giving a figure of merit.  As 
can be seen in the graph below, the best figure of merit (i.e. the least variation in the calculated 
thickness using all the extrema) is obtained using a starting order of m=20 (blue curve). 
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The index of refraction at each extremum is calculated using a Sellmeier dispersion curve of the form 
given in the equation below. This form has been found to work well over the wavelength range of interest. 

 

This has three free Sellmeier parameters:  A0(dimensionless), A1 (nm), and A2 (nm). 

A non-linear least squares fitting routine is used to extract these parameters from a given dispersion 
curve. The image below shows an example of such a curve for GaAs at room temperature. Note that 
these values are temperature dependent; therefore for best accuracy a dispersion curve corresponding to 
the film growth temperature should be used. 
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2. Calculating and Collecting Film Thickness Data 

Open the BandiT Temperature Acquisition 
Mode from the Acquire menu or by using the 

  icon on the toolbar. 

Click the Config button to open the 
Configuration Options dialog and select the 
Thickness tab. 

Tick the Enable Film Thickness Calculation 
box so that the data will be calculated and 
collected and then select the method of 
calculation, either by elapsed time - Calculate 
thickness by time - or by spectral 
interference oscillations - Calculate 
thickness based on oscillations. 

If you select Calculate thickness by time 
enter the values for m and b 

m: Growth rate in units/hr. 

b: Starting thickness in the specified 
units. 
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If you select Calculate thickness based on oscillations enter the values for these parameters: 

Floor (counts) - Any raw spectra which have maximum intensity below this noise floor value will 
be ignored. This is intended to reject spectra which contain only noise. Default: 1,000 cts. 

Ceiling (counts) - Any raw spectra which have maximum intensity above this noise ceiling value 
will be ignored. This is intended to reject spectra which might saturate the spectrometer.  Default: 
60,000 cts. 

Min. # extrema required - Any spectra having fewer than this number of extrema will be ignored. 
Default: 4. 

Boxcar - Specifies the number of points used to perform a moving average, a.k.a. boxcar 
smoothing of the thickness result (must be odd). For example, a setting of N results in each data 
point being averaged with the (N-1)/2 neighboring data points on either side. Default: 1 (i.e. no 
smoothing). 

Enable slope removal - If this is enabled, the software will attempt to remove any background 
slope over the wavelength range specified in the Settings dialog. This is intended to improve the 
accuracy of the extrema wavelength measurement by providing a flat baseline. 

Scale thickness  - Performs a linear scaling of the thickness with scaling factor m and offset b. 
The scaled thickness is obtained via the equation:                   t’ = m * t + b. 

m: Scaling factor (dimensionless). Default: 1. 

b: Thickness offset in the specified units. Default: 0. 

Divide datapoint by reference - If this is enabled, the raw spectrum will be divided by a saved 
reference spectrum. This is intended to normalize the spectrum to remove the effects of spectral 
variation of the light source output. This provides a flatter baseline and makes determination of the 
wavelengths of the extrema more 
accurate. Reference spectra can be 
acquired from any surface giving a 
diffuse reflection. Commonly used 
materials include sapphire wafers(SSP) 
and PBN. Note that it is critical that the 
reference be taken at the same lamp 
power that will be used during data 
acquisition, as the shape of the lamp’s 
output spectrum is strongly power-
dependent. The desired reference file 
can be specified in the Reference tab in 
the Configuration Options. 

Click the Settings button to enter the 
settings for analysis of the spectra. This 
opens the Thickness Calculation 
Parameters dialog box as shown below. 

Number of Slopes - Specifies 
the minimum number of 
consecutive data points required 
with slope having the same sign 
(either increasing or decreasing) 
before a potential extremum is 
considered valid. The purpose of 
this setting is to filter valid 
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extrema from background noise. Default: 20. 

Min. slope - Specifies the minimum slope required before a potential extremum is 
considered valid. The purpose of this setting is to filter out small extrema which may be due 
to background noise. Default: 5E-5. 

Boxcar - Specifies the number of points used by the digital smoothing filter that is applied to 
the spectrum before analysis (must be odd). For example, a setting of N results in each data 
point being filtered using the (N-1)/2 neighboring data points on either side. Default: 65. 

Min wavelength - Minimum wavelength for analysis (nm). 

Max wavelength - Maximum wavelength for analysis (nm). 

Select the dispersion curve corresponding to the film material. The user has the option to 
select from a preset list, or manually enter the three Sellmeir parameters A0 
(dimensionless), A1 (nm), and A2 (nm). For more information see the Technical Background 
section earlier in this How-To Guide. 

  

When all the required parameters have been set, close the Configurations Options dialog boxes using the 
OK button. 

Use the View Menu to open some Real-Time Charts to see the acquisition of the data you require. You 
might want to open: 

• Real-Time Thickness Spectra - which shows the thickness intensity against wavelength, the 
normalized reflectance spectrum, similar to the first plot in this How-To Guide 

• Real-Time Thickness (Time) - which shows a plot of thickness against elapsed time 
• Real-Time Thickness (LED) - which gives a numeric read-out of calculated thickness 

Note that the saved data files will contain the thickness (in the specified units), and the fit sigma (in nm), 
as described in the technical background section, which is a figure of merit of the quality of the fit. 

Acquisition 
Acquisition Modes 

Acquisition Modes 

BandiT has a number of Acquisition modes which can be access via the Acquire menu and also from the 
BandiT toolbar. 
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BandiT Temperature - toolbar icon   - used to acquire BandiT temperature 

BandiT Dark Background - toolbar icon    - used to take a dark background before any other 
acquisition 

BandiT Reference - toolbar icon    - used to take a reference scan when using a Visible 
Spectrometer 

Bandit Roughness Calibration - used to calibrate the system for roughness measurements 

Bandit Pyrometry Calibration -  used to calibrate the temperature acquired by Pyrometry to the real 
BandiT temperature 

Blackbody Calibration - used to calibrate the temperature acquired by Blackbody measurements 

Phase Delay Selection - toolbar icon    - used to set the phase delay for a sample on a rotating 
platen 

BandiT Temperature Scan - used by k-Space to configure BandiT calibration files 

BandiT Substrate Calibration - used by k-Space to configure BandiT calibration files 

Flat Field Correction - used to create a flat field correction file specific to each Spectrometer for use in 
Blackbody Pyrometry - this file will normally be provided by k-Space when the instrument is shipped 

Spectrometer Calibration - used to calibrate the Spectrometer - this is normally done by k-Space before 
the instrument is shipped and it is not usually necessary for users to do this. 

BandiT Dark Background 

Available from the   icon on the toolbar or under the Acquire menu, use the BandiT Dark 
Background acquisition mode to obtain a calibration of the spectrometer dark background at various 
spectrometer integration times. Taking a dark background at the various spectrometer integration times 
results in clean, noise-free spectra for analysis because the dark backgrounds will be subtracted 
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automatically from the live spectra. It is important to include all the integration times that you will want to 
use, as these are the only ones that will be available in the BandiT Temperature Acquisition mode. 

 It is important that all light is eliminated from the chamber when the Dark Background is acquired. 
Remove the fiber out of the SMA Fiber Input and cover the SMA fitting or cover the detector so no light 
can get into the spectrometer. Make sure that the Light Source is not switched on or is in standby mode 
and that the substrate heater is turned off as this may contribute some radiation to the chamber.   

Note: These are the default values and 
should be sufficient for most systems. 

Specify: 

Spectra source – this is the 
spectrometer. If more than one 
spectrometer is set up on the 
system, choose the one that will 
be used for temperature 
acquisition. 

Archive Name - The archive is 
named automatically by the 
software and is shown here for 
reference. 

Samples per - Samples per 
datapoint. Typically this is set at 
1. 

Min (msec) -- the minimum 
desired exposure time (in 
milliseconds) for the 
spectrometer. Typically this is 10 
msec, although for fast data 
acquisition, a minimum of 5 
msec may be entered. Values 
below 10 msec may result in too 
low a signal for proper analysis. 

Max (msec) – the maximum desired exposure time (in milliseconds) for the spectrometer. Typically 
this is 200 msec, although longer exposure times may be needed. Note that as exposure times get 
longer, the background noise also grows, and noisy spectra may result when choosing very long 
exposure times (> 300 msec). 

Step (msec) – the exposure time step size for the spectrometer, in milliseconds. A step size of 10 
msec will yield available spectrometer exposure times in intervals of 10 msec. 

For example, consider the following parameters: 

Min exposure time = 10 msec 

Max exposure time = 200 msec 

Step = 10 msec 

As a result, available spectrometer integration times for temperature acquisition are (in msec) 10, 
20, 30, …, 190, 200. 
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Tick Light Source in standby during acquisition - to ensure that the light source is in standby mode to 
eliminate as much light as possible in the chamber. 

Click Advanced to open the Advanced Acquisition Options to check  BandiT I/O Settings. 

Click the Start button and kSA BandiT will acquire and store a Spectrometer Dark Background, 
subtracting it automatically from the live spectra that will be used for acquiring data. 

General Note: 

Entering a Min, Max, and Step defines the possible exposure times for acquisition. Typically, the values 
shown above yield plenty of range and resolution for proper temperature measurement. 

Single Wafer 

BandiT Temperature 

The most common mode of operation for the kSA BandiT system is the BandiT Temperature mode, 

available under the Acquire menu or by using the  icon in the toolbar. In this mode, substrate 
temperature may be acquired continuously without data storage, or temperature and (optionally) spectra 
data may be acquired for a user-
selectable amount of time. 

Specify Measurement configuration: 

Spectra source – this can be a live 
spectrometer, multiple spectrometers, or 
a previously acquired *.kdt data file. 
Selecting a *.kdt file allows for playback 
of a previously acquired data set. 

When choosing to use a *.kdt data file - 
open the file first only then is the radio 
button All available data from source 
enabled. 

To perform Continuous (no data 
saved) acquisition, check the 
Loop checkbox in the BandiT 
Spectra Acquire Source, found by 
right-clicking the *.kdt file and 
selecting Properties. Note that 
the Loop button in the *.kdt toolbar 
only affects playback, not 
acquisition. So it does not matter 
whether it is clicked or not. 

Click Config - to open the Configuration 
options menu where all the parameters 
for band edge calculation, pyrometry, 
automatic intensity control etc. are 
specified 

Substrate material – use the drop-down 
list to choose the type of substrate. Then 
click the Select button to view the 
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material table for that material, see Select Substrate Material for more details. At any time, click the >> 
button to view the selected substrate material details in the acquisition window itself: 

Archive name – is editable in the Document Generation tab of the Advanced Acquisition Options, 
selected by clicking the Advanced button. 

Choose one of: 

Duration – amount of time in hours, minutes and seconds for acquisition 

Continuous (no data saved) – acquire data continuously without storing any data. Typically, this 
mode is used simply to see the temperature and not the time evolution of the temperature. 

All available data from source – only available when *.kdt files are selected as the Spectra 
source, above. This option allows reprocessing of a file when it is selected as the source. 

Choose Measurement Mode: 

BandEdge – kSA’s band-edge thermometry 

Pyrometry – generally inferior to kSA’s band-edge thermometry, but the band-edge technique 
often fails when depositing a very absorbing layer, so the pyrometry technique is available for such 
situations. Do not use a light source when using this technique as it is signal-level dependent and 
any light source will add potentially variable signal and affect the temperature conversion and lead 
to an improper temperature reading. 

Both BandEdge and Pyrometry – for dual measurement. This is recommended only for acquiring 
via transmission as any light source will add potentially variable signal and so affect the 
temperature conversion, which will lead to an improper temperature reading. 

Tick the Control Light Source based on mode checkbox to ensure that the light will only be on during 
BandEdge and will not be on (i.e., in standby mode) with either of the two pyrometry modes above. 

Tick the Turn off Light Source at end of run checkbox to turn off the light source when the run ends. 

Click: 

Advanced – to access the Advanced Acquisition Options to specify BandiT I/O settings, 
Configurable Temperature Output, and Triggers 

Click the Start button to begin acquisition. During acquisition, the Start button becomes a Pause button. 
Pausing acquisition causes the same button to become a Resume button. 

BandiT keeps track both of Elapsed Time and of Adjusted Elapsed Time. Adjusted elapsed time captures 
time spent only in acquisition (so it is shorter than Elapsed Time if the Pause button was clicked during 
acquisition). When plotting data over time (in BandiT Computed Data plots), select Elapsed Time or 
Adjusted Elapsed time using the Data tab (found by right-clicking the plot and selecting Properties.) 

Click the Close button to close this dialog. 

BandiT Reference 

Available from the   icon on the toolbar or from the Acquire menu, use the BandiT Reference 
Acquisition mode to obtain a reference for acquiring via a Visible spectrometer. Learn more about the 
step-by-step procedure for using this acquisition mode in the How-To Measure Temperature: BandiT 
Visible help topic. 
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The BandiT Reference file records the spectrum of the lamp intensity so that this can then be used to 
normalize the acquired spectrum. This provides a flatter baseline and makes determination of the 
wavelengths of the extrema more accurate. Reference spectra can be acquired from any surface giving a 
diffuse reflection. Commonly used materials include sapphire wafers(SSP) and PBN. Note that it is critical 
that the reference be taken at the same lamp power that will be used during data acquisition, as the 
shape of the lamp’s output spectrum is strongly power-dependent. 

 

Specify Measurement configuration: 

Spectra source – this should be a visible spectrometer as there is no need to take a reference for 
NearIR acquisition. 

Archive name - this can be entered manually here or use the Document Generation tab in the 
Advanced Acquisition Options (found by clicking the Advanced button) to have the system 
generate one automatically. 

Samples - one sample is usually sufficient. 

After specifying the parameters, click Start. 

When acquisition is complete, the reference file opens (e.g., "BanditReference.bsrf" based on the name 
given above) and should be saved (if not already automatically saved via the Document Generation tab 
selections). 

Bandit Roughness Calibration 

The Bandit Roughness Calibration Acquisition mode, available under the Acquire menu, is used to 
calibrate the system to allow collection of roughness data for samples. Typically an increase in roughness 
of a sample increases the diffuse scatter of light collected into the spectrometer and the roughness 
calibration assigns a particular roughness metric to the above gap intensity. Calibration of at least two 
points is needed with NIST roughness standards. Once calibrated BandiT can provide a qualitative metric 
for surface roughness. 
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Specify: 

Spectra source - select the spectrometer 
to use 

Min. wavelength - the minimum 
wavelength to use when calculating 
roughness 

Max wavelength - the maximum 
wavelength to use when calculating 
roughness 

Known Roughness - enter known 
roughness 

Duration (sec) - the time that the system 
should use for calibrating the roughness 

Click: 

Start - to start the acquisition. This also 
enables the Calibrate button. 

Calibrate - to start the calibration which 
will run for the number of seconds 
specified. During calibration "Calibrating" 
is displayed in the taskbar. 

When calibration is complete click Stop to stop 
the acquisition mode and Close to close the window. The calibration process sets the Roughness Scale 
Factor in the Configuration Options Roughness 
tab. 

Bandit Pyrometry Calibration 

The Bandit Pyrometry Calibration Acquisition 
mode, available under the Acquire menu, is 
used to calibrate the system for BandiT 
Pyrometry. 

BandiT Pyrometry mode simulates a single 
wavelength conventional pyrometer (used 
without a light source), by converting the black-
body radiative intensity from the sample into a 
temperature reading. Note that such intensity is 
usually only significant in the Near IR 
wavelength range, so the corresponding 
spectrometer must be used. More information 
about how to perform the system calibration can 
be found in BandiT Pyrometry. 

Select BandiT Pyrometry Calibration from the 
Acquire menu to open the dialog box shown on 
the right. 

Select the Spectra Source using the drop down 
menu. 
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Specify Pyrometry Settings: 

Center Wavelength (nm) – this is the material-dependent primary wavelength that BandiT should 
search for when looking for black-body radiation 

Width (nm) – this is the overall width around the Center wavelength that BandiT will search for 
black-body radiation. For example, with a width of 100, the algorithm will search 50 nm on either 
side of the Center wavelength. 

emis/emis_cal – this is the material emissivity divided by the emissivity calibrated. The general 
rule is that if the system is calibrated based on the same temperature as you are going to 
measure, then this value is 1. If calibrating using a different temperature, then this parameter will 
have another value. 

For example, when calibrating the system using the procedure outlined in BandiT 
Pyrometry, this number is 1. That’s because the same material (say GaAs with emissivity 
0.68) used in calibrating the pyrometer will be the same material measured via Pyrometry 
(so 0.68/0.68 = 1) at the temperature (580°C). Other users may calibrate using blackbody 
emissivity, which is typically rounded up to one. Then emis_cal = 1 and the measured 
emissivity in the chamber (say of GaAs) is another number (say 0.68), meaning 
emis/emis_cal is 0.68/1 = 0.68. 

Calibration temp (C) – this is the temperature within the chamber and should also be the 
temperature as read by using BandiT’s transmission mode (in the Real-time BandiT Temperature 
window). 

Offset (counts) – this is a tweaking option, and typically should be left at 0 

Black Body response – each spectrometer has a slightly different response as a function of 
intensity. For NearIR spectrometers, this value is very close to one. For visible spectrometers, this 
value is close to 0.5. As a part of calibrating the system, a k-Space engineer provides this value. 

Duration (sec) - the time that the system should use for calibrating the pyrometry temperature. 

Click: 

Start - to start the acquisition. This also enables the Calibrate button. 

Calibrate - to start the calibration which will run for the number of second specified. During 
calibration "Calibrating" is displayed in the taskbar. 

When calibration is complete click Stop to stop the acquisition mode and Close to close the window. The 
calibration process sets the Scal and Integration time in the Configuration Options Pyrometry tab. 

  

Blackbody Calibration 

The Blackbody Calibration Acquisition mode is used to Calibrate the Tooling factor if Blackbody 
temperature is going to be acquired in Locked Mode. See BandiT Blackbody Pyrometry for more 
information about using Blackbody mode. 
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Select Blackbody Calibration from the Acquire 
menu, which will bring up the window shown on 
the right. 

Select the Spectra Source using the drop down 
menu 

Specify Blackbody Settings as follows: 

Min / Max Wavelength range - Enter the 
desired wavelength range over which to 
perform the blackbody fit. Entering zeros 
will cause the software to automatically 
select the spectrometer’s Min and Max 
wavelengths. The values can be locked 
using the Lock check boxes. 
Alternatively, if one or both boxes are 
unchecked, the software will attempt to 
optimize the goodness of fit by 
successively reducing the range each 
time the Calibrate button is pressed. 

Threshold - the minimum number of 
counts for performing a blackbody fit. 
Spectra which don’t have at least this 
many counts will be ignored. 

Emissivity - the calibration sample’s 
emissivity. If not known, a value of 1 can 
be entered. In this case the emissivities of 
the subsequent samples will need to be 
expressed relative to that of the 
calibration sample, instead of entering the 
actual values. 

Goodness of Fit Threshold - this allows 
rejection of spectra with poor fits, as 
measured by the reduced chi-squared 
statistic. The default value is 20, meaning 
spectra which have reduced chi-squared 
greater than this value will be ignored. 

Blackbody Fit Tolerance - the fitting 
routine stops when chi-squared 
decreases by less than this tolerance value upon successive iterations (default is 1.0E-3). 

Raw Spectra Boxcar - (must be odd, default is 9). This specifies the number of points used to 
perform a moving average, a.k.a. boxcar smoothing of the spectra before attempting to fit. 

Temperature - the calibration temperature (ºC). If self-calibrating, enter an estimate of the 
temperature to be used as an initial guess by the fitting routine. Note that the results are fairly 
sensitive to the initial guess. Typically, it should be within ~20%, but the routine tends to be more 
forgiving if this represents an over-estimate rather than an under-estimate. If Auto mode is 
selected, this will be calculated automatically. 

Tooling Factor - an estimate of the tooling factor to be used as an initial guess by the fitting 
routine. If Auto mode is selected, this will be calculated automatically. 
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Select: 

Lock Temperature - if the calibration temperature is known, to use the External Calibration 
Method 

or Free Fit - to use the Self-Calibrate Method (see BandiT Blackbody Pyrometry for more 
information) 

Allow constant offset - to allow the constant C to be calculated automatically, if not checked the 
constant is forced to zero (see BandiT Blackbody Pyrometry for more information). 

Using the View menu open the Real-time Blackbody Spectra chart. 

Click: 

Start - The software will determine the temperature by attempting to fit a blackbody curve to the 
source spectra in real-time using the most recently saved tooling factor and emissivity values. The 
real-time chart displays the source data in blue and the resulting fit in black. At the top of the 
window it displays the temperature, tooling factor, emissivity, and the goodness of fit statistic (i.e. 
the reduced chi-squared). If the goodness of fit statistic exceeds the threshold value, a message 
will appear. 

Calibrate - will cause the fitting routine to attempt to perform a fit according to the current settings. 
If successful, the corresponding tooling factor will be calculated. 

If needed, the wavelength range can 
be adjusted for optimum results. Every 
time Calibrate is pressed, the settings 
are automatically saved. 

Phase Delay Selection 

This Acquisition mode is used when a sample 
is rotating during acquisition. Available from 

the   icon on the toolbar or under the 
Acquire menu Phase Delay Selection allows 
for the selection of the phase delay position 
so that acquisition is triggered when the 
sample is in the correct position during the 
rotation. 

One type of hardware to monitor rotation must 
be installed and enabled in the BandiT system 
for the Phase Delay Selection acquisition to 
work. Go to Check Hardware Rotation Board 
to locate and enable the correct option for 
your system. 

 Select: 

Spectra Source - the Spectrometer 
that will be used. 

Substrate material - Specify the 
Substrate material and use the Select 
button to open the table of materials, 
selecting the one that best matches 



BandiT User Manual 

131 

your substrate. The details of the material selected can be seen in the Acquisition window by using 
the >> button. See Select Substrate Material for more information. 

Specify: 

Rotation Positions - The number of rotation positions tracked by the system. 

RPM - The revolutions per minute of the sample rotation stage, if known. 

Auto RPM - if the Hardware Rotation method can detect the RPM this check box will become 
available, select it to allow the automatic synchronisation to RPM. 

Multiple points per rotation - this check box will become available if the hardware allows for 
selection of multiple points. 

Measurement Mode - Select the measurement mode that you will be using for data acquisition. 

In this mode View: 

Real-time Bandit Phase Delay Selection – this Real-Time Chart should be set to plot the Peak 
Intensity against the rotation positions. If it is not, right click the plot and select Properties and 
then Plot value, and select Peak Spectra Intensity from the drop down list. 

Click: 

Advanced – to choose a number of Advanced Acquisition Options, including prompting windows 
and triggers 

Start – to begin the phase delay acquisition; a new window may appear to prompt you to Start if 
such a prompt is set in the Prompts tab. Click the Advanced button to change this option 

Once Start is clicked, the Start and Close buttons become Pause and Stop. 

Once Pause is clicked, the Pause button becomes Resume. (During Pause, the Phase 
Delay marker line cannot be moved, acquisition must be stopped first.) 

The Real-time BandiT Phase Delay Selection chart will start to update with an active trace which 
will re-trace itself as the sample rotates. Let it stabilise so that it retraces itself reliably as shown in 
the first image below, then click Stop. It is now possible to move the red marker from the left hand 
side of the chart by clicking and dragging the triangle at the top of the marker line. Move this 
marker to the position of greatest peak intensity - this will be the location where data will be 
collected - as shown in the lower image. 
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When the marker is in the correct position click Set Phase Delay. 

Set Phase Delay - Click this when the position marker has been moved to the correct position. 
The delay (in ms) will be entered into the Phase Delay field in the Home Pulse Monitor screen, 
found by right clicking the Live Spectrometer window and selecting Properties. From this point 
onwards the system will be triggered to only take a snapshot of data when the stage rotation 
reaches the marker. 
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Flat Field Correction 

The Flat Field Correction Acquisition Mode is used to generate a Flat Field correction file which is specific 
to each Spectrometer and corrects the spectrometer output to yield a flat response as a function of 
wavelength. This is used when using BandiT for Black-Body Pyrometry.  

This correction file will normally be supplied by k-Space when the system is delivered from the factory and 
most customers would not need to use this mode. 

A special Blackbody source is required to do this calibration. 
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BandiT Temperature Scan  

This is used by k-Space to configure the BandiT calibration files. It is not generally used by a BandiT 
user. 

BandiT Temperature Scan is an acquisition mode found under the Acquire menu and is used when 
creating Substrate Calibration files. A Eurotherm controller is used to control the chamber temperature so 
that the calibration can  be achieved for the full temperature range. 

 Select: 

Spectra Source - the Spectrometer 
that will be used. 

Substrate material - use the drop-
down list to choose the type of 
substrate. Then click the Select button 
to view the material table for that 
material, see Select Substrate Material 
for more details. At any time, click the 
>> button to view the selected 
substrate material details in the 
acquisition window itself:  

Archive name - this can be entered 
manually here or use the Document 
Generation tab in the Advanced 
Acquisition Options (found by clicking 
the Advanced button) to have the 
system generate one automatically.  
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Click:  

Advanced – to access the Advanced Acquisition Options  and Configuration options to specify BandiT 
I/O settings, Configurable Temperature Output, Triggers, and to set all the parameters for band edge 
calculation, pyrometry, automatic intensity control etc.  

Scan recipe - to open the Thermal Scan Recipe dialog box as shown below to set the temperatures, 
dwell time and ramp rate. 

  

  

Spectrometer Calibration 

This Acquisition Mode is used to verify or adjust the BandiT spectrometer wavelength calibration. In this 
procedure, the wavelengths of various spectral lines from a Hg-Ar line source are measured and 
compared to tabulated values. This information is used to calculate the offset, Δ that minimizes the 
discrepancies at the individual wavelengths. The corrected wavelengths are then given by: 

  

The results are used to automatically edit the existing spectrometer setup file 

IMPORTANT: be sure to allow the 
spectrometer to warm-up for at least 30 
minutes before attempting to calibrate. 
 Also allow the Hg-Ar line source to 
warm-up for at least 10 minutes for the 
output signal levels to stabilize. 

After allowing a sufficient warm-up period 
for both the spectrometer and Hg-Ar line 
source, connect the line source to the 
spectrometer fiber input. Adjust the 
spectrometer integration time to get a 
strong signal (typically 300 msec). Be 
sure to enable averaging to obtain a 
clean spectrum with good signal-to-noise 
(typically 4x averaging). 

Specify: 

Calibration configuration: 

Spectra Source - Select the 
desired Spectra Source from the 
pull-down menu. You can choose 
a live spectrometer, or any open 
data file. 

choose one of: 

Calibrate for -  to acquire 
spectral data for the 
specified period of time 
(default: 2 min). This is the 
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mode to use if collecting data from a Live Spectrometer. This will prompt you to enter the 
identification of the Operator performing the calibration. 

Continuous - to run the calibration without saving any data and without making any 
adjustment. 

All available data from source -  to use all the data in a stored *.kdt file 

Click Advanced and verify the settings for your particular spectrometer in the Advanced Settings dialog 
box.  When you are satisfied with the settings, select OK to return to main dialog. 

From the View menu, select these Real-Time Charts: 

Real-Time Calibration Averages to view the current and running average values for up to three 
spectral lines 

Real-Time Calibration Peak (Time) to view a strip chart for a given spectral line 

Real-Time Calibration Spectra to view the spectra with the selected line(s) indicated. 

Click Start to start the calibration process. 

If connected to a live spectrometer, a dialog box will appear as shown below when the acquisition is 
completed. If Yes is selected, the spectrometer’s setup file will be updated with the new settings and the 
spectrometer re-initialized in order for the new settings to take effect. A backup copy of the setup file will 
also be created. In addition, a log file will be created in order to track the calibration history. 

 

If instead an existing data file was used as the acquisition source, a dialog box summarizing the results 
will appear as shown below. 

 

Substrate Calibration 

This is used by k-Space to configure the BandiT calibration files. It is not generally used by a BandiT 
user. 

This Acquisition mode is used to create calibration files for new substrate materials, so that they can be 
included in the Library for other users to use. 
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Configuration Options 

Configuration Options 

These are found by clicking the Config button once you have selected an acquisition mode. 

(Note that in earlier versions of BandiT, these options were found under the Advanced button) 

 

Automatic Intensity Control – automate the lamp control and spectrometer integration time 

Pyrometry – used for measuring temperature via black-body radiation 

Reference – specify/acquire reference file needed for measuring GaN deposition and SiC substrates 

Band Edge – fine-tune the fitting of the absorption edge spectra 

Stray Light Removal – update the BandiT Dark Background during acquisition 

Thickness - enable thickness calculation and set up parameters 

Roughness - enable roughness calculation and set up parameters 

Blackbody - enable blackbody computation and set up parameters 

Automatic Intensity Control 

This is an Configuration Option found by pressing the Config button in the Acquisition Mode window. 

It is used for automating the lamp control and spectrometer integration time when measuring single wafer 
temperatures. 

During acquisition, conditions 
change. For example, there 
may be more or less light 
because of changes in 
temperature, heater, material 
thickness, etc.. Use this 
option to keep the intensity of 
the signal stable. 

Check: 

 Enable Auto 
Intensity Control to 
allow the system to 
use measurements of 
the minimum edge 
(Normalized BandiT 
Spectra) and peak 
(BandiT Spectra 



BandiT User Manual 

138 

signal) to adjust automatically the lamp and/or integration separately or together as needed to 
keep the signal stable. The software first adjusts the lamp. If it does not reach the Target Peak, 
then it will use Automatic Integration Control (if it is enabled). 

Auto Light Scource Control – for handing the Light Source Control over to the software check this box 
then: 

Specify: 

Min Edge – to set the decimal value (between 0 and 1) of how much of the Normalized 
BandiT Spectra is to be used for the linear fit. During acquisition, this value is seen in the 
lower right corner of the Real-Time Normalized BandiT Spectra, labeled Fit Y. Visually, this 
is the amount up the Y-axis traversed by the green fitting line. 

Range (+-) – to set the range on both sides of the Min Edge. 

For example, a value of 0.01 and a Min Edge of 0.3 means that the Min Edge is allowed to 
vary between 0.29 and 0.31. 

Step – to set the lamp power step that the system uses to adjust the Min Edge. The system 
will increase or decrease lamp power in steps specified here, reaching a minimum of 0 and 
a maximum of 1, unless another Max Power value is specified (as described below). 

Check: 

Enforce Max Lamp Power – to limit the lamp power so that it never exceeds a maximum value 
and never is set to a value that causes the minimum edge to be below a specified value. This is 
used to prevent saturation and prolong lamp life. It can be disabled independently of Automatic 
Lamp Control and Automatic Integration Control. But if disabling Automatic Integration 
Control, then be sure to enable this option. 

Specify: 

Max Power – to set the maximum lamp power as a decimal value between 0 (off) and 1 
(maximum power) 

Min Edge – to set the minimum edge as a limit for lamp brightness. This lower-limit 
parameter is meaningful only if it is set within the Range of the Min Edge set above. 

Auto Integration Control – for handing the integration time (specified in the Spectrometer Properties) 
over to the software. The Automatic Intensity Control function can only work within the range and 
resolution of the Dark Background. It can only use Integration times that are included in the Dark 
Background so it is important to make sure that sufficient steps are included. Check this box then: 

Specify: 

Target Peak – to set the desired count for the Spectrometer. This value will be used for the 
Automatic Lamp Control, whether or not the Automatic Integration Control is enabled. 

Tolerance – to set the range on both sides of the Target Peak. 

For example, a value of 5000 and a Target Peak of 30000 means that the Target 
Peak is allowed to vary between 25000 and 35000. 

Min Int. Time – to set the minimum time for integration. 

Max Int. Time - to set the maximum time for integration. 

Saturation Reduction Factor - to set a reduction factor to avoid saturating the 
Spectrometer 
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Band Edge 

This is an Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used to fine-tune the fitting of the absorption edge spectra. 

Before the BandiT software processes the absorption spectra data, the data is in its raw format, as shown 
below: 

 

The spectra processing algorithm performs several operations on the original raw spectra data. First, it 
performs background subtraction of the data. Then it determines a band edge wavelength—or "knee 
wavelength" as it is commonly known—by fitting to the linear portion of the absorption edge, as shown by 
the blue line in the figure below. 

 

In general, the default settings for all spectra processing parameters are sufficient for most substrate 
temperature measurement. While this Help file does discuss each of the parameters, adjusting these 
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parameters requires a good understanding of the proprietary kSA BandiT fitting algorithm, which is not 
discussed in this Help manual. For further information regarding the fitting algorithm, please contact us. 

Note that future versions of BandiT will allow temperature calculation from wavelength integration instead 
of band edge. Such options will need to be adjusted on a case-by-case basis, and those parameters are 
documented here as well in grey text. 

Now, to the dialog itself: 

 

  

Many users will have saved a Recipe, which when loaded will specify all the parameters in this dialog. 
Use the Load Recipe to pull up a previously saved recipe. Or, if specifying these parameters for the first 
time, click the Save Recipe when finished, this will save the current settings of all the parameters on the 
Band Edge menu. Users will normally have a recipe for each wafer. 

(Note that the parameters will remain as specified so long as BandiT is exited normally. Users with only a 
single recipe need not take the step of saving the recipe, as the latest-input parameters will be saved and 
reloaded each time the application is opened.) 

For General, check: 

Use first peak for all processing - If this is enabled BandiT will use the first peak (i.e. the lowest 
wavelength) rather than the maximum peak found in the first derivative. This is useful when the 
BandiT Spectra contains oscillations in the steepest part of the graph, to the right of the band edge 
which may cause the algorithm to select an inflection point other than the one associated with the 
band edge. This may cause the peak derivative value used for calculations to switch (and perhaps 
jump back and forth depending on the oscillations of the ripple). This is useful if either 1) Pre-
processing or 2) Band Edge Calculation is enabled. Default: Disabled 

With Use first peak for all processing checked, specify: 

Peak height (% of max) - this specifies the minimum level a peak must attain before it is 
considered valid, so that the first peak detected will not be due to noise. For example a 
value of 15 means that any peak smaller than 15% of the maximum derivative peak height 
will be ignored. Default: 15% 

Use peak smoothing - If this is enabled, the software will attempt to reject any spurious 
noise spikes. It does this by rejecting any peak candidates which don’t have at least three 
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consecutive data points on each side with slope of the same sign (i.e. either increasing or 
decreasing). Default:  Enabled. 

In the following pages, learn about: 

1. Pre-Processing 
2. Band Edge Calculation 
3. Band Edge Correction 
4. Temperature Calculation 

 Blackbody 

This is a Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used when measuring temperature using Blackbody Pyrometry. 

Select Compute Blackbody Temperature to 
enable the blackbody fitting. 

Specify: 

Clip Spectra Wavelength - to clip the raw 
spectrum below a Min wavelength, and/or 
above a Max wavelength. This is intended 
to allow the removal of noisy portions of the 
spectrum which may exist under certain 
circumstances. 

Raw Spectra Boxcar - this specifies the 
number of points used to perform a moving 
average, a.k.a. boxcar smoothing of the 
spectra before performing attempting to fit. 
(must be odd, default 9) 

Threshold - the minimum number of counts 
for performing a blackbody fit. Spectra 
which don’t have at least this many counts 
will be ignored. 

Emissivity - enter the sample’s emissivity. 
Note: that this is not necessarily the same 
as the emissivity used in the calibration 
procedure. This allows the user to perform 
the calibration on a sample which is 
different than the sample under test. If a 
value of 1 was entered during calibration, 
the sample’s emissivity will need to be 
expressed relative to that of the calibration 
sample, instead of entering the actual value. 

Tooling Factor - if a calibration was 
performed, this will already contain that 
value. If in Locked mode, this will be the 
value used for all calculations. If in Free Fit 
mode, this will be the initial guess, unless 
Auto is selected, in which case it will be calculated automatically. 
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Initial Temperature (est) - enter an initial temperature estimate. Note that the results are fairly 
sensitive to the initial guess. Typically, it should be within ~20%, but the routine tends to be more 
forgiving if this represents an over-estimate rather than an under-estimate. If Auto mode is 
selected, this will be calculated automatically. 

Select: 

Lock Tooling Factor - to run in Locked mode 

or Free Tooling Factor and Temperature - to run in Free fit mode (see How-to Use BandiT Black-
Body Pyrometry for more information) 

Allow constant offset - to allow the constant C to be calculated automatically. Otherwise, it is 
forced to zero. (see How-to Use BandiT Black-Body Pyrometry for more information) 

Discard data above goodness threshold - to allow rejection of spectra with poor fits, as 
measured by the reduced chi-squared statistic. Spectra which have reduced chi-squared greater 
than the entered Goodness of Fit Threshold will be ignored. 

Enter: 

Blackbody Fit Tolerance - The fitting routine stops when chi-squared decreases by less than this 
tolerance value upon successive iterations (default is 1.0E-3). 

Goodness of Fit Threshold - threshold above which spectra will be ignored (default value is 20) 

Fitted Wavelength Range - specify either: 

Absolute Wavelength Range, with Min and Max wavelengths 

or 2nd derivative allow the upper limit to be adjusted dynamically relative to the sample's band 
edge. This is based on the “knee” in the spectrum, which is located at the peak of the 2nd 
derivative, i.e. the wavelength where the slope is increasing most rapidly. If this 2nd derivative 
option is selected, the smoothing and number of data points to offset from the knee must be 
specified. 

Pyrometry 

This is a Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used when measuring temperature via blackbody radiation. This technique requires transmission mode 
and so make sure the light source is off (or in "standby" mode) as it will increase the noise in the signal 
and may hide it entirely. 
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Specify Pyrometry Settings: 

Center Wavelength 
(nm) – this is the 
material-dependent 
primary wavelength that 
BandiT should search 
for when looking for 
black-body radiation 

Width (nm) – this is the 
overall width around the 
Center wavelength 
that BandiT will search 
for black-body radiation. 
For example, with a 
width of 100, the 
algorithm will search 50 
nm on either side of the 
Center wavelength. 

Scal (counts) – signal 
calibration, the 
Acquisition mode 
BandiT Pyrometry 
Calibration can be used 
to obtain the number for 
Scal. This will be a large 
number (many 
thousands to several 
million, depending on 
signal strength). 

emis/emis_cal – this is 
the material emissivity 
divided by the emissivity 
calibrated. The general 
rule is that if the system 
is calibrated based on 
the same temperature 
as you are going to 
measure, then this value is 1. If calibrating using a different temperature, then this parameter will 
have another value. 

For example, when calibrating the system using the procedure outlined in How-To Measure 
Temperature via Pyrometry, this number is 1. That’s because the same material (say GaAs 
with emissivity 0.68) used in calibrating the pyrometer will be the same material measured 
via Pyrometry (so 0.68/0.68 = 1) at the temperature (580°C). Other users may calibrate 
using blackbody emissivity, which is typically rounded up to one. Then emis_cal = 1 and the 
measured emissivity in the chamber (say of GaAs) is another number (say 0.68), meaning 
emis/emis_cal is 0.68/1 = 0.68. 

Calibration temp (C) – this is the temperature within the chamber and should also be the 
temperature as read by using BandiT’s transmission mode (in the Real-time BandiT Temperature 
window). 

Offset (counts) – this is a tweaking option, and typically should be left at 0 
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Black Body response – each spectrometer has a slightly different response as a function of 
intensity. For NearIR spectrometers, this value is very close to one. For visible spectrometers, this 
value is close to 0.5. As a part of calibrating the system, a k-Space engineer provides this value. 

Integration time (ms) – this is the current integration time of the spectrometer window. This will be 
entered by the BandiT Pyrometery Calibration procedure. 

Recipe - the current settings can be saved by clicking Save Recipe, this will prompt for a file name. 
Pyrometry recipe files have the file extension .pyro 

Saved settings can be used in future by clicking Load Recipe and selecting the appropriate file. 

Reference 

This is an Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used to specify a reference spectra that is divided into the BandiT Spectra. A reference is necessary 
when using BandiT for measuring temperature for GaN deposition on sapphire or for depositing on to 
SiC. This is done using kSA BandiT’s visible spectrometer. See the BandiT Visible topic for how to 
measure temperature for these materials.  

 

Select either:  

No Reference – and BandiT subtracts off a dark background  

or  

File – to specify a file (acquired via BandiT Reference acquisition in multi-wafer BandiT) for GaN or 
depositing on to SiC. For more information about the *.bsrf, please see the File Formats topic.  

Click: 

Load - to select the file to use  

Roughness 

This is a Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used to set up the wavelength over which roughness data will be collected. 



BandiT User Manual 

145 

Click Enable to allow 
Roughness 
measurements to be 
made. 

Specify: 

Min. 
wavelength - 
the minimum 
wavelength to 
use when 
calculating 
roughness 

Max 
wavelength - the maximum wavelength to use when calculating roughness 

Roughness Scale Factor - The scale factor can be calculated automatically by using the Bandit 
Roughness Calibration Acquisition mode. Or you can enter a scale factor here. 

If the numbers to be displayed on the Real-time Roughness (LED) chart are too large the display 
will show #.### instead of numbers, in this case the scale factor should be adjusted or re-
calibrated using the Bandit Roughness Calibration Acquisition mode. 

  

Stray Light Removal 

This is an Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used to update the BandiT Dark Background during acquisition—helping to make the system immune to 
ambient light in the chamber. This is useful when making frequent changes in the deposition chamber—
such as rapid changes in temperature, adding or subtracting light through viewports, etc.. Indeed, most 
users report that they have not used this option, preferring to keep deposition chamber conditions more 
stable.  

Check: 

Enable Strobe 
Removal, and 
specify:  

Strobe every – 
to set how 
often the 
system will wait 
before 
beginning a 
cycle to acquire 
a new dark 
background. 
Ideally, keep 
this value as 
large as 
possible, but it 
will depend on 
how often or 
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rapidly changes are occurring in the deposition chamber.  

Off Delay – to set how long the system waits to acquire a new dark background after the lamp 
goes into standby mode. Usually two seconds is sufficient to allow the lamp filament to cool down 
enough so that its intensity is below 5%.  

On Delay – to set how long the system waits to resume temperature measurements (subtracting 
off the updated dark background) after the lamp is powered back up. Usually two seconds is 
sufficient to allow the lamp filament to return to previous levels.  

Enable Reference Subtraction and specify: 

Reference File - Select a Bandit reference file using the Browse button. 

Apply to wavelength range - check this to apply to only part of the wavelength range 

Below or Above - check Below or Above and enter a wavelength value 

Thickness 

This is a Configuration Option found by pressing the Config button in the Acquisition Mode window. It is 
used to configure the film thickness calculation settings. 

Enable Film Thickness Calculation - select this to 
enable the film thickness to be calculated by one of two 
methods: elapsed time or spectral interference 
oscillations. 

Units - Specify the thickness units to be used. Default: 
µm. 

Select one of the following two options: 

Calculate thickness by time - to calculate 
thickness based on elapsed time using a known 
growth rate and starting thickness. 

m: Growth rate in units/hr. 

b: Starting thickness in the specified 
units. 

Calculate thickness based on oscillations - to 
calculate thickness based on interference 
oscillations - for more information see How-To 
Measure Film Thickness 

Floor (counts) - Any raw spectra which 
have maximum intensity below this noise 
floor value will be ignored. This is 
intended to reject spectra which contain 
only noise. Default: 1,000 cts. 

Ceiling (counts) - Any raw spectra which 
have maximum intensity above this noise 
ceiling value will be ignored. This is 
intended to reject spectra which might 
saturate the spectrometer.  Default: 60,000 cts. 
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Min. # extrema required - Any spectra having fewer than this number of extrema will be 
ignored. Default: 4. 

Boxcar - Specifies the number of points used to perform a moving average, a.k.a. boxcar 
smoothing of the thickness result (must be odd). For example, a setting of N results in each 
data point being averaged with the (N-1)/2 neighboring data points on either side. Default: 1 
(i.e. no smoothing). 

Enable slope removal - If this is enabled, the software will attempt to remove any 
background slope over the wavelength range specified in the Settings dialog. This is 
intended to improve the accuracy of the extrema wavelength measurement by providing a 
flat baseline. 

Scale thickness  - Performs a linear scaling of the thickness with scaling factor m and 
offset b. The scaled thickness is obtained via the equation:                   t’ = m * t + b. 

m: Scaling factor (dimensionless). Default: 1. 

b: Thickness offset in the specified units. Default: 0. 

Divide datapoint by reference - If this is enabled, the raw spectrum will be divided by a 
saved reference spectrum. This is intended to normalize the spectrum to remove the effects 
of spectral variation of the light source output. This provides a flatter baseline and makes 
determination of the wavelengths of the extrema more accurate. Reference spectra can be 
acquired from any surface giving a diffuse reflection. Commonly used materials include 
sapphire wafers(SSP) and PBN. Note that it is critical that the reference be taken at the 
same lamp power that will be used during data acquisition, as the shape of the lamp’s 
output spectrum is strongly power-dependent. The desired reference file can be specified in 
the Reference tab in the Configuration Options. 

Click the Settings button to enter the settings for analysis of the spectra. This opens the Thickness 
Calculation Parameters dialog box as 
shown below. 

Number of Slopes - Specifies 
the minimum number of 
consecutive data points required 
with slope having the same sign 
(either increasing or decreasing) 
before a potential extremum is 
considered valid. The purpose of 
this setting is to filter valid 
extrema from background noise. 
Default: 20. 

Min. slope - Specifies the 
minimum slope required before a 
potential extremum is considered 
valid. The purpose of this setting 
is to filter out small extrema 
which may be due to background 
noise. Default: 5E-5. 

Boxcar - Specifies the number of 
points used by the digital 
smoothing filter that is applied to 
the spectrum before analysis 
(must be odd). For example, a 
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setting of N results in each data point being filtered using the (N-1)/2 neighboring data 
points on either side. Default: 65. 

Min wavelength - Minimum wavelength for analysis (nm). 

Max wavelength - Maximum wavelength for analysis (nm). 

Select the dispersion curve corresponding to the film material. The user has the option to 
select from a preset list, or manually enter the three Sellmeir parameters A0 
(dimensionless), A1 (nm), and A2 (nm). For more information see How-To Measure Film 
Thickness. 

  

Spectra Pre-Processing 

This is a part of the Band Edge Configuration Option found by pressing the Config button in the 
Acquisition Mode window. 

Perform Pre-processing to process the raw absorption spectra before fitting a band edge. Typically, the 
raw spectral data is smoothed, normalized, and background subtracted.  Smoothing removes short-range 
variations, or "noise", and therefore functions as a low-pass filter. Background subtraction is performed in 
some cases in order to enhance a weak band edge. 

Specifically: 

• The pre-processing first boxcar smooths the raw spectra. 
• Then, it is clipped at an user-defined upper wavelength. 
• Beyond that upper wavelength, all data is set to the intensity equal to the user-defined upper 

wavelength. 
• Next, its 1st derivative is taken and boxcar smoothed and peak found – thus determining the 

inflection point in the smoothed spectra. 
• Using the inflection point, the pre-processing algorithm makes a linear fit and extrapolates it to the 

x-axis. 
• A background subtraction of the entire spectra data is then taken, using the value at the x-axis 

intersection of the linear fit. 
• The spectra data to the left of 

the x-axis intersection position 
is clipped. 

• Finally, the resultant spectra is 
normalized to the peak value of 
the spectra. 

With Enable selected, the software will 
perform the selected pre-processing 
operations on the raw spectra.  Default: 
 Enabled. 

Specify: 

Clip Spectra Wavelength (nm) - 
Clips the spectra outside of a 
user-defined wavelength range. 
This is typically done to eliminate 
the possibility of finding false 
inflection points. 
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Min – (default: OFF) – select this checkbox to clip the raw spectra data at the specified 
wavelength. For example, setting this value to 400 nm will result in all the data to the left of 
400 nm to be set to the value at 400 nm. This is typically done on GaN or SiC.  We only 
need to clip to a minimum when dividing by a reference to eliminate noise. Default: Disabled 

Max – (default: ON, 1300nm (for GaAs)) – select this checkbox to clip the raw spectra data 
at the specified wavelength. For example, setting the clipped wavelength to 1300 nm will 
result in all data to the right of 1300 nm set to the value at 1300 nm. This is typically done to 
eliminate false peak finding due to strong IR signal at longer wavelengths. This can be 
seen, for example, at high temperatures when the substrate heater is outputting significant 
IR radiation. Using the Clip Spectra feature will ensure that erroneous fitting to the long 
wavelength structure does not happen. Default: Enabled, 1250nm 

Floor –  to set the intensity (in raw counts of the raw absorption spectra data) below which pre-
processing will not occur. For example, any peaks found with intensities below the noise floor will 
be ignored in the pre-processing. Default: 250 counts 

Ceiling - any raw spectra which have maximum intensity above the noise ceiling value will be 
ignored. This is intended to reject spectra which saturate the spectrometer.  Default:  70,000 
counts. 

Raw Spectra Boxcar  – the pre-processor smooths the raw spectra using a moving average, a 
boxcar, with the specified number of data points (which must be odd). For example, a setting of N 
results in averaging each data point with the (N-1)/2 neighboring data points on either side. 
Default:  9 pts. 

Divide datapoint by reference – select this checkbox to divide a reference spectra into the 
acquired raw spectra. This is done, for example, to eliminate structure in the spectra of the light 
source and would be done by dividing out a reference spectra taken directly of the light source. 
Use this option only when using a visible spectrometer (depositing GaN on sapphire or using SiC). 
Default: OFF 

Stretch zero to one –  if this is enabled, the software will scale the reference-divided 
spectrum such that the maximum value is one, and the minimum value is zero. Default: 
 Disabled. 

Blackbody Subtraction - if this is enabled, the software will attempt to fit a blackbody curve and 
then subtract it off. This is sometimes used at high temperatures if there is a significant amount of 
blackbody radiation in the above-gap portion of the spectrum, and is therefore not applicable here. 
Default:  Disabled. 

Standard Subtraction - if this is enabled, the software will attempt to subtract the background 
signal from the raw spectra using one of two methods. Default:  Enabled. 

Subtract datapoint offset  - if this is enabled, the software will first shift the entire spectrum 
such that the minimum value is zero. Default:  Disabled. 

Linear fit  – This method performs a linear least squares fit to a portion of the spectrum 
centered at or below the inflection point. The fitted line is extended down, and every point to 
the left of where it crosses the wavelength axis is set to the value at that wavelength. 
 Default:  Enabled. 

2nd derivative - this alternate method is based on the peak in the second derivative (i.e. 
“knee”), rather than the inflection point. In this case every point more than a specified 
distance left of the knee is set to the value at that wavelength. A 2nd derivative calibration 
file from k-Space is needed to be able to use this subtraction method, select a suitable file 
from the Substrate Material selection on the main Acquisition dialog box. Default: 
 Disabled. 
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Boxcar width – The first derivative is calculated numerically and smoothed using a moving 
average, a boxcar, with the specified number of data points (must be odd). For example, a 
setting of N results in averaging each data point with the (N-1)/2 neighboring data points on 
either side. Default:  19 pts. 

% of peak / Pts from 2nd deriv – If Linear Fit is selected, the fitted portion of the spectrum 
is centered at the point whose first derivative value equals this percentage of the maximum 
value. If instead, 2nd Derivative is selected, this value represents the offset from the knee. 
For example, a value of 10 means that every point more than 10 points left of the knee is 
set to the value at that wavelength. Default:  85 %. 

Num Pts. +/- for back sub linear fit – (only for linear fit) – the number of points on both 
sides of the 2nd derivative that are used to find the best line fit (using least-squares fit). 
Choose a larger value for a longer line (if the graph has only one clear inflection point) and a 
shorter value to avoid fitting if there are multiple inflection points (the software chooses the 
first inflection point from the left). For example, a setting of 9 results in fitting the 9 
neighboring data points on either side of the data point in question. Default:  9 pts. 

After the optional background subtraction the following settings are applied: 

Clip data point to min –  If this is enabled, the software will clip all data points to the left of the 
minimum value to the minimum value.  This checkbox should always be selected so that this 
happens. Default: Enabled 

Clip from peak - if this setting and background subtraction are enabled, the minimum value used 
for clipping is restricted to one that lies to the left of the inflection point. Default:  Enabled. 

Subtract data point offset –If this is enabled, the software will shift the entire spectrum such that 
the minimum value is zero. Default:  Enabled. 

Normalize data point – If this is enabled, the software will normalize the spectrum such that the 
peak value is one. This is the final step in the pre-processing algorithm. Default:  Enabled. 

Band Edge Calculation 

This is a part of the Band Edge Configuration Option found by pressing the Config button in the 
Acquisition Mode window. 

This tab contains the settings used to calculate the band edge wavelength from the pre-processed 
spectra (as determined by the settings in the Pre Processing tab). 
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Enable band edge 
computation  -- If 
this is enabled, the 
software will 
compute the band 
edge wavelength 
value using one of 
the two main 
methods described 
below. The first 
method is based on 
the inflection point; 
the second method is 
based on the knee 
wavelength. Default: 
 Enabled. 

Specify: 

1st Deriv. 
Boxcar – In 
either method 
the first 
derivative is 
calculated 
numerically 
and smoothed 
using a 
moving 
average, a 
boxcar, with 
the specified 
number of 
data points 
(must be odd). 
For example, 
a setting of N 
results in 
averaging each data point with the (N-1)/2 neighboring data points on either side. Default:  17 pts. 

For fitting the band edge, Select: 

Linear fit  - This method performs a linear least squares fit to a portion of the spectrum centered at 
or below the inflection point. The fitted line is extended down until it crosses the wavelength axis. 
The band edge wavelength is defined as the point of intersection.  Default:  Enabled. 

% of peak for band edge – The fitted portion of the spectrum is centered at the point 
whose first derivative value equals this percentage of the maximum value. To use the 
inflection point, select 100. For a value less than the peak, select a smaller percentage. For 
example, 80 means the band edge is set to be the spectra value that is 80% of the 2nd 
derivative peak height, i.e., 20% down (to the left) in the height of the peak in the 2nd 
derivative. Default: 85%. 

Num Pts. +/- for band edge linear fit –Number of points used in the linear least squares fit. 
For example, a setting of 7 results in fitting the 7 neighboring data points on either side of 
the data point in question. Default:  7 pts. 
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or 

2nd derivative - This alternative to the Linear Fit method is based on the knee wavelength. It is 
typically used if the presence of oscillations makes a linear fit difficult. There are two variants of this 
method. Default:  Disabled. 

2nd Deriv. Boxcar width – The second derivative is calculated numerically from the first 
derivative and smoothed using a moving average, a boxcar, with the specified number of 
data points (must be odd). For example, a setting of N results in averaging each data point 
with the (N-1)/2 neighboring data points on either side. Used to find the peak in the 2nd 
derivative (knee wavelength). Default 31 pts 

Cubic spline interpolation – This variant defines the band edge wavelength as the peak of 
the second derivative, or knee. It first fits a cubic spline and interpolates a number of data 
points between the original points.  Default:  Disabled. 

Num Pts - Specifies the number of data points to be interpolated between the 
original points.  Default:  10 pts. 

Thresholding - This variant defines the band edge wavelength as the point where the 
second derivative crosses a certain threshold value. This approach is intended to further 
reduce the sensitivity to oscillations. Default:  Disabled. 

Threshold - Specifies the second derivative threshold value. Default:  0.001. 

or 

Absorption edge fit - This alternative to the Linear Fit method is also based on the knee 
wavelength. It is typically used if the presence of oscillations makes a linear fit difficult. Rather than 
finding the knee numerically, it attempts to perform a non-linear least squares fit to the spectra. 
Default:  Disabled. 

Click Settings to specify the settings for this fit. 

Check: 

Discard data below threshold – In the case of a linear fit, the software calculates a confidence 
level (expressed as a percentage) based on the goodness of fit to the data. If this setting is 
enabled, the software will discard band edge wavelength values for which the calculated 
confidence is below a user-specified threshold level. Note that this only applies if the linear fit is 
selected. This is particularly useful when the user knows that reflected light may be obscured or 
altered during the acquisition process (e.g., reflected light off of a rotating platen for multiple wafers 
is a common reason). Default:  Enabled. 

Confidence threshold – Minimum confidence value for accepting a band edge linear fit. 
This sets the confidence-level below which the Real-Time Confidence meter will show red 
(indicating a poor fit) and above which it will show a green (indicating a good fit).  Default: 
 95 %. 

Band Edge Correction 

This is a part of the Band Edge Configuration Option found by pressing the Config button in the 
Acquisition Mode window. It is used to correct the Band Edge calculation made in the previous tab. In 
other words, this tab allows the user to tweak the Band Edge Wavelength value – the intercept of the 
absorption edge wavelength fit and the Band Edge Wavelength. This is seen in the BandiT Processed 
Spectra chart in the aforementioned Band Edge topic as the intercept between the blue line and the x-
axis.  
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(Note that 
temperature also 
has its own linear 
correction – 
described in 4) 
Calculate 
Temperature.)  

  

Enable Correction - 
If this is enabled, the 
software will apply a 
correction to the 
calculated band 
edge wavelength 
value using one of 
the two methods 
described below. 
Default:  Disabled. 

Choose:  

Apply linear 
correction 
(mx+b) – 
performs a 
linear scaling 
of the band 
edge 
wavelength 
with scaling 
factor m and 
offset b. The 
corrected 
band edge 
wavelength, 
λ’, is obtained 
via the 
equation: λ’=m*λ+b.  Default:  Disabled. 

m – slope of the linear correction Default: 1 

b – offset of the linear correction (nm) Default: 0 

or  

Apply thickness correction via polynomial – performs a film-thickness-dependent band edge 
wavelength correction (this will affect the final computed temperature) A correction term, Δλ, is 
calculated from the film thickness, t (expressed in microns), using up to a 5th order polynomial. 
The corrected band edge wavelength, λ’, is obtained from the calculated film thickness via the 
equation: λ’= λ+ Δλ, where Δλ = a0 + a1*t + a2*t2 + … + a5*t5.  Default:  Disabled. 

0 – the constant added to the polynomial  

1 – the coefficient of the 1st degree term of the polynomial  

2 – the coefficient of the 2nd degree term of the polynomial  
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…  

5 – the coefficient of the 5th degree term of the polynomial  

Temperature Calculation 

This is a part of the Band Edge Configuration Option found by pressing the Config button in the 
Acquisition Mode window. 

BandiT computes temperature using Band Edge data, but k-Space is investigating temperature 
calculation via spectra Integration (the area under the curve). At the time of this manual being written, no 
calibration files are available for users using spectra integration. However, users can still enable spectra 
integration while computing temperature using band edge, if desired. 

Choose: 

Compute 
temperature 
using band 
edge – the 
software will 
use a user-
specified 
substrate 
material 
calibration file 
to convert 
band edge 
wavelength to 
temperature. 
This is the 
default 
method k-
Space 
Associates 
has developed 
to compute 
temperature. 
 Default: 
 Enabled. 

or 

Compute 
temperature 
using 
integration – 
an alternate 
temperature 
calculation 
method which 
is based on integrating the spectral curve. This computes the integrated value (sum of the area 
beneath the spectra wavelength) in the *.kdt file between two user-specified wavelengths because 
it automatically enables Spectra Integration.  No calibration files are available for users using 
spectra integration. Default:  Disabled. 

Check: 
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Enable Spectra Integration - Both temperature calculation methods allow the user to integrate the 
spectral curve.  This option allows users to take advantage of the existing material-dependent 
band edge wavelength calibration files while also collecting data on the area under the spectral 
curve for refining the temperature calculation.  Default:  Disabled. 

Specify: 

Min. wavelength – set the lower limit for integration. Default: 880 nm 

Max. wavelength – set the upper limit for integration. Default: 950 nm 

Then, choose either: 

Polynomial integration – Select this option to fit the spectrum with a polynomial, and then 
compute the integral using the polynomial. Default:  Disabled. 

or 

Numerical integration – Select this option to directly integrate the spectral data. Default: 
 Disabled. 

Lastly, check: 

Apply linear correction (mx+b) - to perform a linear scaling of the temperature with scaling factor 
m and offset b. The corrected band edge temperature, T’, is obtained via the equation: T’=m*T+b. 
 Default:  Disabled. 

m - scaling factor (dimensionless). Default: 1 

b - offset (°C). Default: 0 °C 

For example, suppose during calibration that a plot of Pyrometer temperature vs. BandiT 
computed temperature does not go 
through the origin or have the correct 
slope. Use the linear correction to alter 
the slope and intercept so that future 
BandiT Temperature calculations will 
also be corrected. 

Absorption Edge Fit Settings 

The Absorption edge fit settings menu is 
accessed from the Band Edge Calculation tab 
of the Band Edge configuration option. 

The Absorption Edge Fit is an alternative to the 
Linear Fit method of Band Edge calculation also 
based on the knee wavelength. It is typically 
used if the presence of oscillations makes a 
linear fit difficult. Rather than finding the knee 
numerically, it attempts to perform a non-linear 
least squares fit to the spectra. 

Specify Parameters for the non-linear least 
squares fit - initial estimates that are near to the 
optimal values will improve the possibility of 
getting a good fit: 
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a0 - Amplitude 

a1 - Inflection Point 

a2 - Transition Width 

a3 - Baseline Offset 

Check  

Enable Slope removal - and specify the points and limits to be removed,  to remove any slope 
from the below-gap portion of the spectrum before the fitting takes place 

  

Advanced acquisition options 

Advanced Acquisition Options 

These are found by clicking the Advanced button once you have selected an acquisition mode.  

 

Options include:  

BandiT I/O Settings – set what data is stored from the acquisition  

Data Binning - sort data into separate bins 

Delay - set delays before data is collected or between data points 

Device Output Control - specify signals for external devices 

Documentation Generation – set how documents are named and saved  

General – set the number of samples per data point and other general program functionality  

Inputs - specify analog or digital inputs 

Pause/Resume Trigger- use input signals to pause and resume acquisition 

Prompts – enable/disable prompts before and after acquisition  

Pyrometric Oscillations – generate a scan mode image for growth-rate analysis  

Start/Stop Trigger – use input signals to start and stop acquisition  

Temperature Error Handling – specify how the software handles temperature analog output data  
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BandiT I/O Settings 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. 

It is used to configure what data is stored from the acquisition, as well as whether additional data input 
(via a thermocouple) is also acquired. 

  

Specify: 

Minimal data 
output (default) – 
to store only the 
BandiT processed 
data, i.e., entire 
spectra will not be 
stored. This option 
also minimizes 
data storage 
requirements and 
maximizes the 
number of data 
points that can be 
stored. 

or 

Store raw and 
fully processed 
spectra – to store 
all acquired data, 
including the raw 
and normalized 
spectrometer 
spectra. Selecting 
this option can 
result in very large 
data files. If 
needing all data 
over a long period 
of time, a delay 
between data 
points is 
recommend, so 
that acquisition 
does not occur at 
the maximum data 
rate. To create a 
delay, use the 
Spectrometer 
Properties Advanced tab to skip frames or use the Delay Advanced Acquisition Option. 

For Additional I/O, specify: 

No thermocouple – to ignore thermocouple data and not store it 
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or 

Read thermocouple (serial) – to read the thermocouple value as a serial input. This depends on 
the port. Please contact k-Space for the data format. 

or 

Read thermocouple (analog) – to read the thermocouple value as analog (i.e., voltage) value. 

Check: 

Display live spectra on open  - to display the spectrometer live spectra window automatically 
upon opening the application. 

Open Minimized to have the spectra window minimized on open 

Display Light Source Control on Open - to open the Light Source Control window 

Display temperature on Bandit rack LCD -  this keeps the rack display updated at the same rate 
as the computer readout. This can slow acquisition slightly. 

  

Data Binning 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. 

If enabled Data Binning allows the system to distinguish between bursts of data by counting the time 
between bursts. A burst can be a triggered event for example with the Pause/Resume Trigger, or can be 
detected as times when the Spectrometer is over saturated or recording zero intensity for example 
between wafers on a rotating platen. Each burst of data is then directed into a new bin. There must be a 
measurable time gap for this to work. 

 

Check Data Binning to enable the function and enter a Time in seconds which will be used as the trigger 
to direct data to be saved in a new bin. 

Delay 
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This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. 

Use a delay to leave time between data points. Users may want to take advantage of the different types 
of delays and exponential or logarithmic settings. For example, exponential settings may be useful for a 
user who wants to capture data many times at the beginning of a process but needs fewer and fewer data 
points as time passes. 

 

Note: each Delay type is independent of the other. So, for example, you can have a constant delay of 1 
second before the first data point and an exponential delay (or choose a constant again or a logarithmic) 
with (k=5 and a = 2) between each data point and a constant delay (again, or choose an exponential or 
logarithmic) between samples of 10 seconds. In order to ensure there is no delay of any kind, then you 
must ensure that No delay is selected under each delay type. 

Select: 

For Delay type, choose – 

Between data points – to specify a delay between each data point acquired 

Before first data point – to specify a delay before the first data point is acquired 

Between samples – to specify a delay between each sample of acquired data. (Set 
Samples per data point in the General Advanced Acquisition Option.) 

For Delay (seconds), choose – 

No delay 

Constant – specifies a delay of a constant value in seconds. This is similar to skipping frames, but 
is more exact because frame skipping depends on computer speed, which changes from computer 
to computer and can change during acquisition. 

Exponential (ke^at) – using this delay option means that the software samples the data in time 
intervals that follow the dependent value of an exponential curve—slowly at first and then faster 
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and faster. Use this option if capturing a process where the most important part happens at the 
end of the process. Note that the software only allows the parameter a to be positive. 

Logarithmic (k ln(at)) – using this delay option means that the software samples the data in time 
intervals that follow the dependent value of a logarithmic curve—quickly at first and then slower 
and slower. Use this option if capturing a process where the most important part happens at the 
beginning of the process. 

Check the Display live data during delay box in order to keep the data in the spectrometer window live. 
Un-checking the box means that the last sampled data point remains on the Live Spectrometer window 
until the next sample is acquired. 

Device Output Control 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window, so long as Data sets are not enabled (because mapping may be specified for each data set, 
which is set when specifying the data sets. Please see the Data sets topic for more information). In 
addition, viewing this option may require hooking up an output control device. 

Use this option to enable and specify settings for sending signals to external devices. 

 

After enabling, click the Edit output mappings button to open the Device Output Control Mappings 
dialog: 

 

Specify: 

Output Device – through which output signals can be made. This device is typically a data 
acquisition board with digital or analog output channels. If the device is detected by the k-Space 
software, it will be present in the Output device dropdown box. 

Control channel – of the of the selected device that you want to use for signal output. The Control 
channel dropdown list will list only those channels currently available on the selected Output 
device. 

Parameter – to be mapped to the output channel. For example, it could be the BandiT 
temperature, band-edge wavelength, elapsed time, etc. All available data parameters will be listed 
in the Data parameter dropdown box. 
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Window/line # – if the acquisition mode utilizes window or line regions, then this parameter selects 
which region to use for the data output mapping. Note that this parameter is not available in some 
acquisition modes, in which case this parameter text box will be disabled (such as above). 

Parameter range – to define the range of parameter values mapped to the output channel. In the 
example above, the temperature range is 0°C (min) to 800°C (max). Many other parameters are 
available. 

Voltage output – to define the voltage range to which the Parameter is mapped. Common ranges 
include 0-10V, 0-5V, and -5-+5V. 

Boxcar Smooth – to employ a simple, common data smoothing routine whereby a given data 
point is smoothed, or averaged, into the data surrounding it. As an example, for a 3-point boxcar 
smooth, each data value is averaged with its nearest neighbor data point on each side, replacing 
the original data value with this "smoothed" average. Note that the boxcar smooth value must be 
an odd number. When 1 is chosen, no smoothing is done. 

Set to Min at End - will set the specified mapped minimum voltage after the acquisition is 
complete. This is useful to keep active high boards in the ‘off’ state when not in use. 

Note: For smoothing on 
analog outputs, the 
software waits until it 
gets the boxcar smooth 
number of data points, 
and then averages these 
numbers to smooth the 
data. 

Document 
Generation 

This is an Advanced 
Acquisition Option found 
by pressing the 
Advanced button in the 
Acquisition Mode 
window. Use this option 
to set how documents 
are named and saved. 

Check: 

Store 
Incrementally – 
when acquiring for 
a long time (more 
than 5 minutes), it 
is generally a 
good idea to store 
data in smaller 
packets rather 
than saving only 
when the system’s 
RAM is full. With 
this option 
checked, small 
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delays occur regularly and large delays are avoided. 

Note that checking Store Incrementally automatically selects Auto-save documents, Auto-
close documents, and Auto-hide documents, preventing the user from changing these 
options. 

Auto-save documents – images are automatically saved in RAM, but selecting this option 
automatically saves them to disk as well. Note that the kSA Log is saved automatically unless no 
logging is selected in the General Options Logging. 

With Auto-save documents checked, 

Auto-close documents – to have documents close as soon as acquisition is complete. 

With Auto-close documents checked, 

Auto-hide documents – to briefly flash the data file on the screen while it is being saved. 
This is a visual aid to remind the user that the document has been saved and closed. 

Auto-export data to text – causes all the acquired data also to be stored to another file type in 
addition to the kSA *.kdt file. Note that auto-exporting data (such as to ASCII *.txt files) can make 
very large files and can take considerable time to save. In general it is a good idea to store data in 
the native *.kdt format (binary) as it requires less disk space and saves faster, and then, if needed, 
export the data after acquisition. 

By using the drop-down window, select how data files will be named. Choose: 

Manual run name – for typing in the name in the acquisition window for each image/movie 

Auto-incrementing run name – type in a Base run name and for each new acquisition the 
software adds one to the number (up to 9999). For example, with a Base run name of "Run," the 
first acquired image is Run0001, the second is Run0002, etc. Or click the Zero run checkbox to 
start the count at 0000. 

Date/time-based run name – type in a Base run name and for each new acquisition the software 
uses the computer’s date/time-stamp to uniquely name the file. For example, with a Base run 
name of "Run," a possible acquired image may be: 

Run20061204.135940 

where 

20061204.135940 = year-month-day . hour-minute-second 

So in this case, the file was generated at: 

13:59:40 p.m. on December 4, 2006 

  

Base run name – type in a Base run name for use with the Auto-incrementing or Date/time based 
options. 

Check: 

Create Sub-directory for each run - to have each run saved in it's own sub directory. 

General 
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This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. Use this option to set the number of samples per data point and other general program 
functionality.  

Specify:  

Samples per 
data point – 
number of 
measurements to 
take for each data 
point. For 
example, if set to 
5, then five 
measurements 
will be averaged 
together to make 
one data point. 
Note that this is 
different than 
sampling or 
averaging at the 
level of the data 
source: sampling 
of the data source 
is averaging the 
source signal, not 
averaging the 
processed or 
derived data point.  

Auto-open 
source 
properties – 
checking this 
option means that 
the properties of 
the acquisition 
source opens 
whenever an 
acquisition mode 
is selected. It is 
disabled in kSA 
BandiT.  

When acquiring from a 
movie or file, check  

Disable 
hardware input – to ignore any inputs (like triggers). When acquiring data from a file (as opposed 
to from a live data source), checking the Disable hardware input checkbox will ensure that no 
analog or digital input signals will be read during the acquisition.  

Disable hardware output – to keep from sending any outputs (like triggers). When acquiring data 
from a file (as opposed to from a live data source), checking the Disable hardware output 
checkbox ensures that no analog or digital output signals are sent during the acquisition. This is 
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useful, for example, when replaying a data file on the acquisition computer, and no output control 
is desired.  

During Long/Unlimited Acquisition, check 

Limit RTCs to History Size -  to limit the amount of data that Real Time Charts display, during 
very long or continuous data acquisition 

specify 

When over - enter the number of hours over which the data will be limited 

RTC History Size (datapoints) – the number of data points that the  Real-Time Charts 
(RTCs) will display 

Inputs 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. Use this option to enable input signal(s) for triggering and other acquisition options.  

 

Clicking the Analog Input Settings button brings up the following dialog:  
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For each input number, specify  

Channel – enable each by ticking the checkbox next to each drop-down option. In general, input numbers 
should be set to input channels (called Board channels in the Analog Input Board – while there are 
boards with sixteen input channels, only the first eight channels can be mapped at this time).  

Enabling each channel enables the corresponding map checkbox:  

Mapping – enable each map and then type in the Input Min and Max that describes the voltage 
limits received by the system. Then select the Map Min and Max for the linear scale map and 
choose a Boxcar value from the drop-down box for smoothing (1 means no smoothing).  

Sampling  – this is the number of times the system reads an input signal before giving a value. 
Increasing this number means less noise, but will slow down acquisition.  

Check: 

External trigger - If an external trigger is present  

Acquire in background - to acquire data in the background  

Check the Acquire digital input button to enable digital inputs. No special mapping is required, but 
please ensure that the Digital Input Board is set up properly.  

Pause Resume Trigger 
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This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. Enable Pause/Resume trigger in order to start and stop acquisition based on a hard-wired input 
signal (usually into the digital input board). Note that the options in this window will be enabled only if the 
hardware supports it.  

With Enable Pause 
Trigger checked, choose 
either:  

Active low or 
Active high for 
selecting whether 
the trigger 
activates on a high 
voltage or a low 
voltage. This 
depends on the 
output signal from 
the device sending 
the start trigger 
signal.  

Then use the drop-
down window to 
specify the Input 
channel, with 
options set in the 
Digital Input Board (Options menu, Input/Output Boards) and the Inputs tab in the Advanced 
Acquisition Options.  

Options for Resume Trigger are automatically enabled when the Enable Pause Trigger is checked. 
Then choose: 

Active low or Active high for selecting whether the Resume trigger activates on a high voltage 
or a low voltage. This depends on the output signal from the device sending the resume-trigger 
signal. Because the Resume trigger signal may or may not be from the same device as the 
Pause trigger signal, both options are available. If both signals do come from the same device, 
then generally the Pause activation (e.g. high) will be opposite from the Resume activation (e.g. 
low).  

Then use the drop-down window to specify the Input channel, with options set in the Digital Input 
Board (Options menu, Input/Output Boards) and the Inputs tab in the Advanced Acquisition 
Options.  

Select: 

Auto pause after - to automatically pause acquisition after a number of seconds, and specify the 
number of seconds required 

Prompts 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. Use this option to turn on/off prompts before and after acquisition.  
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 Check Before or After 
or both if you want 
prompts before or after  

Overall 
acquisition – for a 
window prompt 
that signals the 
beginning/end of 
overall acquisition  

Background data 
– for a window 
prompt that 
signals that 
beginning/end of 
acquiring 
background data  

Primary data acquisition – for a window prompt that signals the beginning/end of data 
acquisition. This dialog is different from the Overall acquisition prompt only if there is a sub loop of 
acquisition.  

Pyrometric Oscillations 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window.  

It is used to generate a Scan Mode Image needed for Measuring Growth Rate.  

  

Check:  

Generate 
pyrometric scan 
image for growth 
rate analysis to 
make a Scan 
Mode Image.  

With the above 
checkbox 
selected, check 
Show pyrometric 
scan image in 
real-time to see 
the image being 
created in real 
time.  

Select: 

Palette - the palette is false coloring; it only changes how the image is displayed. Pick among a 
large number of palettes. The color can be changed after the image is generated by right clicking 
the image and selecting Properties. 

Mapping - choose:  
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Normal – how the data comes in  

Eight Most Significant Bits – for displaying a subset of the data, keeping only the most 
significant eight bits that make up the image. This option has the effect of reducing the 
number of shades in the image to an amount that the human eye can distinguish.  

Maximized – for displaying the data scaled over eight bits, or 256 levels, so that the 
brightest part of the image is white and the darkest part black. 

Start/Stop Trigger 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. Enable Start/Stop trigger in order to start and stop acquisition based on a hard-wired input signal 
(usually into the digital input board). Note that the options in this window will be enabled only if the 
hardware supports it. 

 With Enable Start 
Trigger checked, choose 
either: 

Active high or 
Active low for 
selecting whether 
the trigger 
activates on a high 
voltage or a low 
voltage. This 
depends on the 
output signal from 
the device sending 
the start trigger 
signal. 

Then use the drop-
down window to 
specify the Input 
channel, with 
options set in the 
Digital Input Board 
(Options menu, 
Input/Output Boards) and the Inputs tab in the Advanced Acquisition Options. 

Options for Stop trigger are automatically enabled when the Enable Start Trigger is checked. Then 
choose 

Active high or Active low for selecting whether the Stop trigger activates on a high voltage or a 
low voltage. This depends on the output signal from the device sending the stop-trigger signal. 
Because the Stop trigger signal may or may not be from the same device as the Start trigger 
signal, both options are available. If both signals do come from the same device, then generally the 
Start activation (e.g. high) will be opposite from the Stop activation (e.g. low). 

Then use the drop-down window to specify the Input channel, with options set in the Digital Input 
Board (Options menu, Input/Output Boards) and the Inputs tab in the Advanced Acquisition 
Options. 

A stop trigger may not be needed if, for example, the acquisition duration is set for only a certain 
amount of time or number of data points/images. 
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Specify: 

Number of iterations - the number of cycles to complete 

Temperature Error Handling 

This is an Advanced Acquisition Option found by pressing the Advanced button in the Acquisition Mode 
window. It is used to specify how the software handles temperature analog output data.  

 Select either:  

Leave 
Temperature 
Output (analog) 
Stable – (default 
selected) – to 
keep the 
temperature 
analog output at 
the last good data 
point (before 
signal fell below 
noise floor or the 
fit falls below the 
confidence 
threshold – values 
set in the Spectra 
Processing 
advanced 
acquisition option).  

For example, some users map temperature output as an analog voltage via the Device Output 
Control and use it to help control chamber temperature. Such users would probably want to Leave 
Temperature Output (analog) Stable so that if there’s a period in which BandiT doesn’t fit the 
data that the analog output remains stable, keeping the input into the chamber-temperature 
controller the same. If it were set to zero, that potentially would cause the temperature controller to 
respond as if the chamber temperature had suddenly gone to zero and raise the temperature!  

or  

Set Temperature Output (analog) to 0V – to set the temperature analog output to zero. Users 
may want to select this option as the temperature output analog data suddenly going to zero 
clearly shows when the signal falls below noise floor or the fit falls below the confidence threshold. 
This option is for users who are not using the temperature analog output value as an input into the 
chamber-temperature controller.  

Scan Mode Image 

A Scan Mode Image is created when Generate Pyrometric Scan Mode Image is selected in the 
Pyrometric Oscillations advanced acquisition option. 

The Scan Mode Image is created by taking the Spectra Intensity versus wavelength. 
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and mapping it on to a color palette. A horizontal line is generated from each plot. 

 

Then, subsequent lines are stacked – one below another – to create the Scan Mode Image. 
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This image can be analyzed with a Line Profile and used to Measure Growth Rate. 

General Notes: 

A Scan Mode image has its own set of image properties. 

Advanced Settings 

The Spectrometer Calibration acquisition mode precisely determines the center wavelength(s) of the 
selected spectral line(s) and calculates a spectrometer offset based on the published* wavelength 
value(s). 

This is accomplished by first smoothing the spectrum using a polynomial-based digital smoothing filter. 
The first derivative is then computed and the data point nearest to the zero crossing is located. The zero 
crossing value is refined by performing a least squares linear fit to a number of neighboring data points on 
either side. 
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Specify: 

Select Spectral 
Lines - Spectral 
line(s) to be used to 
determine the 
spectrometer offset. 
 Default:  1013.976 
nm. 

Fitting Parameters: 

Smoothing 
Width - Total 
number of 
points used 
by the digital 
smoothing 
filter (must be 
odd). For 
example, a 
setting of N 
results in 
smoothing 
each data 
point with the 
(N-1)/2 
neighboring 
data points on 
either side. 
Default:  65 
pts. 

Order of 
Smoothing 
Poly  - Order 
of the 
smoothing 
polynomial 
(zero for 
boxcar). 
Default:  4. 

Min pts - 
Minimum 
number of consecutive data points with slope having the same sign (i.e. either increasing or 
decreasing) required before a candidate peak is considered valid. This is intended to reject any 
spurious noise spikes. Default:  10 pts. 

Min curvature  - Minimum curvature (i.e. second derivative value) required in order for a candidate 
peak to be considered valid. This is intended to reject small peaks. Default:  0.001. 

Linfit Pts (+/-)  - Number of points used in the linear fit. For example, a setting of 7 results in fitting 
the 7 neighboring data points on either side of the data point nearest to the zero crossing in the 
first derivative.  Default:  7 pts. 
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Peak Search Radius (nm)  - Radius of the peak search window. For example, a setting of 3 
results in candidate peaks more than 3 nm from the target wavelength being rejected.  Default:  3 
nm. 

Wavelength Correction Type: Type of correction to be applied. Default: Constant Offset 

Spectrometer Setup Parameters  - These are read-only parameters which detail the particular 
spectrometer’s setup. 

XStart: Starting wavelength in nm. 

wtc_ShiftNm: Overall wavelength shift to be applied relative to original factory settings, in 
nm. 

Lower limit (nm)  - Minimum allowable wavelength shift. Default:  0.001 nm. 

Upper limit (nm)  - Maximum allowable wavelength shift. Default:  1.5 nm. 

  

* http://physics.nist.gov/PhysRefData/Handbook/element_name.htm 

Image properties 

Image Properties 

Image Properties describe the image; they do not change it. However, the properties dialog window does 
allow the user to add to the properties or change how the image is viewed. Double-click or right-click to 
view.  

 

 
There are four image properties:  

Comments  

General  

Palette  

Scan Mode  

Comments 
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This is one of the Image Properties found by double-clicking an image or movie or by right-clicking and 
selecting Properties from the popup window.  

 

Comments – a text box that allows user-entered comments to be save with files saved in kSA proprietary 
formats. Use this feature, for example, to document that an image was acquired at a substrate 
temperature of 550°C on GaAs (100).  

General 

This is one of the Image Properties found by double-clicking an image or by right-clicking and selecting 
Properties from the popup window.  

 

File name – change the way the program names files in the Document Generation tab, found by clicking 
the Advanced button on the acquisition mode dialog.  

Image type – this is set as "Wavelength scan image" in BandiT.  
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Acquisition settings – are not meaningful in BandiT because the only images are Scan Mode Images 
created from spectra versus wavelength data.  

Image Properties –  

Width – number of pixels in the width of the image. This is also the number of wavelengths.  

Height – number of pixels in the height of the image. This is also the number of data points 
acquired.  

Mode – color or grayscale, depending on how the image is generated  

Bit depth – sometimes depends on how the image was acquired. With a bit depth of 8, for 

example, there is a maximum of  = 256 grayscale intensities (black to white) or 256 total colors.  

Compression – is set to "None" for images generated in BandiT.  

Time –  

Date recorded – often this is part of the File name too (see above).  

Elapsed time – gives the amount of time it took to create the image. This is the total time taken for 
temperature acquisition.  

Palette 

This is one of the Image Properties found by double-clicking an image or movie or by right-clicking and 
selecting Properties from the popup window.  

 

Palette – the palette is false coloring; it only changes how the image is displayed. Pick among a large 
number of palettes.  

Mapping – choose:  

Normal – how the data comes in  

Eight Most Significant Bits – for displaying a subset of the data, keeping only the most significant 
eight bits that make up the image. This option has the effect of reducing the number of shades in 
the image to an amount that the human eye can distinguish.  

Maximized – for displaying the data scaled over eight bits, or 256 levels, so that the brightest part 
of the image is white and the darkest part black  

Scan Mode 
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This is one of the Image Properties found by double-clicking an image or movie or by right-clicking and 
selecting Properties from the popup window. Only Scan Mode Images have the Scan Mode property.  

 

Num. data points – This depends on the duration settings in the acquisition window.  

Number of samples per data point – change this property in the General tab of the Advanced 
Acquisition Options.  

Regions captured – this will always be blank in BandiT.  

Analysis 
Analysis 

Analysis tools are interactive and continuous, meaning that the user can change the input at anytime 
during analysis and get a different output. For example, analysis done on an image often requires some 
type of re-sizable object (line, rectangle, etc.). While manipulating this object with the mouse, the 
corresponding data related to that object is continuously plotted in the accompanying chart window(s). In 
this manner data analysis is made fast, simple, and visual.  

There are two types of analysis:  

Real-time charts (RTCs) – allow the user to view raw and processed data during acquisition.  

Post-acquisition analysis – allow the user to perform analysis on data after acquisition.  

Post-Acquisition Analysis 

There are two kinds of post-acquisition analysis: 

• of an image 
• of a 2-D plot 

Click on an image window. 

Then click on the Analysis menu for image-based analysis options. 
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Histogram and Statistics – intensity versus window position 

Line Profile – intensity versus line position 

Triple Region Plot – original, contour, and surface plot together as one plot 

Window Contour Plot – original image separated by intensity-based contour lines 

Window Surface Plot – three-dimensional intensity plot 

Click on a 2-D plot window. 

Then click on the Analysis menu to for data-based analysis options.  

1D FFT – Fast-Fourier Transform or Discrete Fourier Transform, 
as well as weighting options 

Blackbody Fit 

Blackbody Fit Lock Temp 

Blackbody Fit Lock Tooling 

Comparison - Avg. Individually 

Comparison - Avg. Together 

Comparison - Combine All 

Comparison - Difference 

Comparison - Divide 

Contour Analysis 

Crop   

Cubic Spline Fit 

Delta Y 

Derivative 

Digital Filter Fit 

Exponential Fit 

Extrema Count 

Gauss Fit 

Growth Rate Damped Sine Fit 

Knee Fit 
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Lowpass Filter 

Poly Fit w/ extrapolation 

Polynomial Fit 

Pyrometric Growth Rate 

Sampling 

Savitzky-Golay 

Scale by Poly 

Spreadsheet 

Surface Analysis 

Analysis Sources 

A common dialog used for all the comparison analysis 
tools available for 2-D data plots. Use the buttons in 
the middle to move the analysis sources from Available 
to Selected.  

 

Real Time Charts 

Real-Time Charts 

Real-Time Charts (RTCs) allow the user to view raw 
and processed data during acquisition. Use the mouse 
to re-scale or move them during acquisition. 

Choose an acquisition mode from the Acquire menu. 
Then use the View menu to choose from among the 
RTCs. The charts available will depend on the 
acquisition mode, not all charts can be used in all 
modes. 

Real-time Absorption Edge Fit Spectra - shows 
the goodness of fit when using absorption edge 
fit as the method of Band Edge calculation 
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Real-time Bandit Confidence – confidence in the computed BandiT Temperature 

Real-time Bandit Multi LED - numeric display of Band Edge, Pyrometry and Blackbody 
temperatures 

Real-time Bandit Phase Delay Selection - used to help select the trigger delay when a single wafer 
is on a rotating platen 

Real-time Bandit Spectra – resizable plot useful for displaying the unprocessed spectra value 

Real-time Bandit Spectra (Normalized) -- completely processed data and band-edge fit 

Real-time Bandit Temperature (LED) – displays the real-time computed BandiT temperature (°C) 

Real-time Bandit Temperature (Time) – plots computed BandiT Temperature (°C) versus time 

Real-time Blackbody Spectra - plot of the Blackbody spectra 

Real-time Blackbody Temperature (LED) - displays the computed Blackbody temperature (°C) 

Real-time Blackbody Temperature (Time) - plots the Blackbody temperature (°C) against time 

Real-time Pyrometer Temperature (LED) – displays the real-time pyrometer temperature (°C) 

Real-time Pyrometer Temperature (Time) – plots the pyrometer temperature (°C) against time 

Real-time Roughness (LED) - displays the computed roughness 

Real-time Roughness (Time) - plots roughness against time 

Real-time Stats (LED) - numeric display of a selected data value 

Real-time Stats (Time) - plots selected values against time 

Real-time Thickness (LED) - displays the computed thickness 

Real-time Thickness (Time) - plots the computed thickness against time 

Real-time Thickness Spectra - plots the Normalized Reflectance Spectrum with the Interference 
Oscillations 

  

These Real-time charts are used during Spectrometer Calibration only: 

Real-time Calibration Averages - plots the current and running average values for up to three 
spectral lines 

Real-time Calibration Peak (Time) - plots a strip chart for a given spectral line 

Real-time Calibration Spectra - plots the spectra with the selected line(s) indicated 

Real-time Absorption Edge Fit Spectra 

The Real-time Absorption Edge Fit Spectra Real Time Chart is available when the Absorption Edge fit 
is selected as the method of Band Edge Calculation in the Acquisition mode Configuration Options. 
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The Bandit Temperature, Band edge wavelength and Goodness of fit can be seen at the top of the plot 
window. 

Real-Time Confidence 

The confidence meter is found by selecting View/Real-Time Confidence from the main menu. It is used to 
display the level of confidence in the computed BandiT Temperature.  

 

In the window above, the confidence in the fit is at 99%, displayed in two places so that the user can 
reduce the width of the window. Here, 99 corresponds to green, indicating that the confidence is greater 
than the Confidence threshold set in the BandiT Spectral Processing Advanced Acquisition Option. If 
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the confidence falls below that threshold, the indicator turns to red. (A standard confidence for Band Edge 
fit is 85%.)  

Real-Time Bandit Multi LED 

The Real-time Bandit Multi LED Real Time Chart gives a useful display of the different temperatures 
being measured using Band Edge, Pyrometry and Blackbody Pyrometry, when all methods of 
measurement are being used. 

 

  

Real-Time Bandit Phase Delay Selection 

The Real-time Bandit Phase Delay Selection Real Time Chart is used when a single wafer is on a 
rotating platen, to select the phase delay position so that acquisition is triggered when the sample is in the 
correct position during the rotation.  

To change the value that is plotted, right click the chart and select Properties and then select the Plot 
Value tab. Choose the value to plot from the drop down list. 

When acquisition starts the system will try to lock on to the RPM of the rotating platen, eventually after a 
few rotations of the platen the trace will begin to overwrite itself so that the dark line draws exactly over 
the light line, as shown in the example below. A single marker is displayed and can be moved to the 
desired position by clicking and dragging the red triangle at the top of the marker line. The chosen 
position will then be used to trigger data collection in subsequent acquisition modes. 
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For more information about using this Real-Time Chart go to the Phase Delay Selection Acquisition mode 
or the How-To Trigger Temperature Meaurement guide. 

Real-Time BandiT Spectra 

The Real-Time BandiT Spectra is a Real-Time Chart (RTC) that plots Spectra (Intensity) versus 
Wavelength (nm). It is useful for displaying the unprocessed spectra value. While the Live Spectrometer 
window gives the same view, it cannot be resized. This window can be resized.  
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Along the bottom of the window is the Status bar (View/Status bar), which displays the number of data 
points collected thus far, elapsed time, and minimum spectra intensity value.  

Right-click the plot and select Properties (or simply double-click) to apply data filters change the X/Y axis, 
and specify labels and colors.  

Snap Shot - Click the Snap Shot button at any time to take a snap shot of the current spectra. 

Real-Time Normalized BandiT Spectra 

The Real-Time Normalized BandiT Spectra is a Real-Time Chart (RTC) that plots Normalized Intensity 
versus Wavelength (nm). It is useful for showing the completely processed and normalized data (red) and 
the band-edge fit (blue) of that particular spectra data value. 
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Along the bottom of the window is the Status bar (View/Status bar), which displays the number of data 
points collected thus far, elapsed time, band edge, and Fit Y. Band edge gives computed band edge for 
temperature calculation. Fit Y gives the length of the fit line along the Y-axis. See the Automatic Intensity 
Control topic for specifying this value, where it is called the Min Edge. 

Right-click the plot and select Properties (or simply double-click) to apply data filters, specify X/Y axis, 
and change labels and colors. 

Real-time Bandit Temperature (LED) 

The Real-Time BandiT Temperature (LED) is a Real-Time Chart (RTC) that displays the pyrometry 
temperature in degrees Celsius (°C).  
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Right-click the read-out and select Properties (or simply double-click) to change the plot value, data 
(marker to plot), and colors.  

Real-Time BandiT Temperature (Time) 

The Real-Time BandiT Temperature (Time) is a Real-Time Chart (RTC) that plots the computed BandiT 
Temp. (°C) versus time or data point.  

  

Along the bottom of the window is the Status bar (View/Status bar), which displays the number of data 
points collected thus far, elapsed time, and min/max temperature.  

Right-click the plot and select Properties (or simply double-click) to apply boxcar smoothing, specify auto-
scrolling and X/Y axis, and choose labels and colors.  

Real-Time Blackbody Spectra 

The Real-time Blackbody Spectra Real Time chart displays the raw blackbody data and the resulting fit, 
the source data in blue and the resulting fit in black. At the top of the window it displays the temperature, 
tooling factor, emissivity, and the goodness of fit statistic. 
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Real-Time Blackbody Temperature (LED) 

The Real-Time Blackbody Temperature (LED) is a Real-Time Chart (RTC) that displays the blackbody 
temperature in degrees Celsius (°C). 

 

Right-click the read-out and select Properties (or simply double-click) to change the plot value, data 
(marker to plot), and colors. 

Real-Time Blackbody Temperature (Time) 

The Real-Time Blackbody Temperature (Time) is a Real-Time Chart (RTC) that plots the Blackbody 
temperature (°C) versus time or data point.   
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Along the bottom of the window is the Status bar (View/Status bar), which displays the number of data 
points collected thus far, elapsed time, and min/max temperature. 

Right-click the plot and select Properties (or simply double-click) to apply boxcar smoothing, specify auto-
scrolling and X/Y axis, and choose labels and colors. 

Real-time Pyrometer Temperature (LED) 

The Real-Time Pyrometer Temperature (LED) is a Real-Time Chart (RTC) that displays the pyrometry 
temperature in degrees Celsius (°C).  

 

Right-click the read-out and select Properties (or simply double-click) to change the plot value, data 
(marker to plot), and colors.  

Real-time Pyrometer Temperature (Time) 

The Real-Time Pyrometer Temperature (Time) is a Real-Time Chart (RTC) that plots the pyrometer 
temperature (°C) versus time or data point.   
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Along the bottom of the window is the Status bar (View/Status bar), which displays the number of data 
points collected thus far, elapsed time, and min/max temperature. 

Right-click the plot and select Properties (or simply double-click) to apply boxcar smoothing, specify auto-
scrolling and X/Y axis, and choose labels and colors. 

Real-Time Roughness (LED) 

The Real-Time Roughness (LED) is a Real-Time Chart (RTC) that displays the roughness of the sample 
in **** 

 

If the numbers to be displayed on the Real-time Roughness (LED) chart are too large the display will 
show #.### instead of numbers, in this case the scale factor should be re-calibrated using the Bandit 
Roughness Calibration Acquisition mode, or adjusted using the Roughness Configuration option. 
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Real-Time Roughness (Time) 

The Real-Time Roughness (Time) Real Time Chart plots Roughness against elapsed time. 

 

  

Real-Time Stats (LED) 

The Real-time Stats (LED) Real Time Chart is used to give a numeric readout of a number of different 
values. To change the value that is displayed, right click the chart and select Properties and then select 
the Plot Value tab. Choose the value to plot from the drop down list. 
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Real-Time Stats (Time) 

The Real-time Stats (Time) Real Time Chart is used to is used to plot a number of different values 
against time. To change the value that is plotted, right click the chart and select Properties and then 
select the Plot Value tab. Choose the value to plot from the drop down list. 

 

  

Real-Time Thickness (LED) 

The Real-Time Thickness (LED) Chart gives a numeric readout of the calculated film thickness. 
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Real-Time Thickness (Time) 

The Real-Time Thickness (Time) chart plots the calculated film thickness against time during 
acquisition. 
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Real-Time Thickness Spectra 

BandiT software has the capability of using the interference patterns observed in the reflectance 
spectrum from a thin film to obtain thickness information. This can be exploited to determine a film’s 
thickness by comparing the wavelengths of the extrema of these oscillations, provided the index of 
refraction is known as a function of wavelength.  

The Real-Time Thickness Spectra Chart shows the Normalized Reflectance Spectrum with the 
Interference Oscillations. 

 

Real-Time Calibration Averages 

The Real-time Calibration Averages Real Time Chart shows the current and running average values for 
up to three spectral lines. 

This is used only in the Spectrometer Calibration Acquisition mode when a BandiT spectrometer 
wavelength needs to be verified or adjusted. 

Real-Time Calibration peak (Time) 

The Real-time Calibration Peak (Time) Real Time Chart shows a strip chart for a given spectral line 

This is used only in the Spectrometer Calibration Acquisition mode when a BandiT spectrometer 
wavelength needs to be verified or adjusted. 
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Real-Time Calibration Spectra 

The Real-time Calibration Spectra Real Time Chart shows the spectra with the selected lines marked 
with an x. 

This is used only in the Spectrometer Calibration Acquisition mode when a BandiT spectrometer 
wavelength needs to be verified or adjusted. 

 

  

Plots 

1D FFT  
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This is a tool found under the Analysis menu that is available for 2-D data plots. Fast Fourier Transform 
(FFT) analysis is available for any 2D line plot. The kSA system utilizes the FFT algorithm from Numerical 
Recipes in C, Cambridge, 1991.  

Note that FFT analysis differs from the FFT image filter, which filters images.  

After performing FFT, right-click the plot and select Properties. Fourier Transform properties allow the 
user to toggle between FFT and Discrete Fourier Transform, mirror the data set (for improving accuracy), 
and choose weighted average parameters.  

General note:  

FFT analysis can be performed on any data set (independent of the units of the data set).  

Technical notes:  

1. The discussion below assumes the data set has units of time. This is for simplicity because then 
the Fourier-transform set has units of frequency.  

Performing FFT squares the real and imaginary component of each frequency value, adds them 
together, and then takes the square root of the result.  

Resultant =  

Then the resultant is plotted as a function of frequency (i.e. the power spectrum).  

Because frequency is the inverse of time, the more closely spaced the data set is in time, the less 
resolved the Fourier transform data set is in frequency space. The frequency resolution of the 
Fourier transform spectrum is given by  

Resolution =  

where  

= time interval between data points in original (time domain) data set  

scans = # of data points in original (time domain) data set, rounded up to the nearest power 
of 2  

  

2. To increase the frequency resolution of the FFT it is best to include as many scans (data points) 
as possible for the FFT analysis.  

3. The FFT routine works on data sets that are powers of 2, so it is good practice to enter a data set 
that is close to a power of 2, but not exceeding it. The software will fill in zeros where necessary, 
and exceeding a power of 2 means the software will fill in a large number of zeros. That will yield 
a large dc component to the frequency spectrum. This dc component will not alter the other 
Fourier component peaks in any way, but simply will make the dc amplitude larger, possibly 
making it the largest amplitude component.  

Blackbody Fit 
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This is a tool found under the Analysis menu that is available for 2-D data plots. This performs a non-
linear least squares fitting of a blackbody thermal radiation curve to acquired spectra to determine 
temperature.  

The Blackbody fit requires use of a spectrometer which has been flat field corrected using the Flat Field 
Correction Acquisition mode. This Flat Field Correction needs to be enabled in the Spectrometer 
Properties found by right clicking the Live Spectrometer window. 

When Blackbody Fit is used in Analysis mode the integration time, emissivity are tied into the Tooling 
Factor. This differs from the case when Blackbody is used during Acquisition mode where the integration 
time and emissivity are independent of the Tooling Factor. 

Use the Blackbody Fit plot properties to specify the properties for the fit. 

Blackbody Fit Lock Temp 

This is a tool found under the Analysis menu that is available for 2-D data plots. This performs a non-
linear least squares fitting of a blackbody thermal radiation curve to acquired spectra using a fixed 
temperature parameter specified by the user. 

A temperature is specified and BandiT superimposes the expected black body curve of the specified 
temperature over the current data plot. This is used to manually close in on a correct temperature for a 
spectrometer snapshot or kdt file. The Goodness of fit is calculated and displayed for reference.  

The Blackbody fit requires use of a spectrometer which has been flat field corrected using the Flat Field 
Correction Acquisition mode. This Flat Field Correction needs to be enabled in the Spectrometer 
Properties found by right clicking the Live Spectrometer window. 

Use the Blackbody Fit Lock Temp plot properties to specify the properties for the fit. 

Blackbody Fit Lock Tooling 

This is a tool found under the Analysis menu that is available for 2-D data plots. This performs a non-
linear least squares fitting of a blackbody thermal radiation curve to acquired spectra using a fixed Tooling 
Factor specified by the user.  

A specific Tooling Factor is used to superimpose the black body curve over the current data plot. A 
Goodness of fit is calculated and displayed for reference. This can be used to manually improve the 
goodness of fit of the superimposed curve. When Blackbody Fit is used in Analysis mode the integration 
time, emissivity are tied into the Tooling Factor. This differs from the case when Blackbody is used during 
Acquisition mode where the integration time and emissivity are independent of the Tooling Factor. 

The Blackbody fit requires use of a spectrometer which has been flat field corrected using the Flat Field 
Correction Acquisition mode. This Flat Field Correction needs to be enabled in the Spectrometer 
Properties found by right clicking the Live Spectrometer window. 

Use the Blackbody Fit Lock Tooling plot properties to specify the properties for the fit. 

Comparison - Avg. Individually 

This tool is found under the Analysis menu for 2-D data plots. It uses the Analysis Sources dialog for 
selecting the plots for comparison and computes the average values of each chart separately. The 
resultant chart has a plot of the averages versus source plot number, i.e., the horizontal axis is the source 
plot number (in the order that the plots were selected for averaging) and the vertical axis is the average of 
the entire plot.  
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Note that each chart selected must have at least two data points.  

Comparison - Avg. Together 

This tool is found under the Analysis menu for 2-D data plots. It uses the Analysis Sources dialog for 
selecting the plots for comparison and computes the point-by-point average (mean) of the plots and 
displays it in a new plot. 

Note that the plots must have the same X-axis values and at least two data points. 

This tool preserves series too. That means that plots with multiple series will be averaged series-by-
series, so that the resultant plot will have the same number of series as the originals – series one is 
averaged point-by-point with series one in each of the plots, series two is averaged point-by-point with 
series two in each of the plots, and so on. 

Comparison - Combine All 

This tool is found under the Analysis menu for 2-D data plots. It uses the Analysis Sources dialog for 
selecting the plots for comparison and creates a chart with data from all the selected plots together on the 
same chart.  

For example, selecting five plots and using the Comparison - Combine All tool results in one plot with five 
series plotted together on the same chart.  

Comparison - Difference 

This tool is found under the Analysis menu for 2-D data plots. It uses the Analysis Sources dialog for 
selecting the plots for comparison and plots the point-by-point difference between two source plots with 
the same X-axis. Order matters, with the second plot being subtracted from the first.  

Comparison - Divide 

This tool is found under the Analysis menu for 2-D data plots. It uses the Analysis Sources dialog for 
selecting the plots for comparison and plots the point-by-point quotient of two source plots with the same 
X-axis. Order matters, with the second plot being divided into the first.  

Contour Analysis 

Contour Analysis is an analysis tool for post-acquisition analysis of a Scan Mode Image. It performs a 
generic Contour Analysis algorithm on the current image. 

Window Contour Plot 

Contour Plot is an analysis tool for post-acquisition analysis of a Scan Mode Image. 

This analysis tool plots intensity as a function of window position. The window position is determined by a 
rectangle or ellipse, which is placed on top of an image. The analysis is interactive, meaning that 
changing the characteristics of the window (position, length, or width) changes the plot. 

Below is a picture of a Contour Plot performed on a test image: 

• the red rectangle is profiled by the plot; 
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• the areas inside the red rectangle of different intensity are separated by yellow lines in the 
Contour Plot. 

 

Right-click the Contour Plot window and select Properties to change such things as – 

• plotting boundaries and mesh-size used to create the plot; 
• whether the data is processed (e.g., smoothed) before it is displayed. 

To change general display options (such as raw versus percent intensity), choose the Options/General 
menu and select options in the images and video tab. 

Crop 

This is a tool found under the Analysis menu that is available for 2-D data plots. It reduces the number of 
pixels plotted. Choosing this tool immediately plots a cropped-data version of the same 2-D data plot with 
the plot title "Trim Left: [number] Trim Right: [number]." The numbers specify the data (pixels) excluded 
from the plot, counting from the left and right edges of the original plot.  

Use the Crop tab in the Plot properties to specify the number of pixels to be excluded. (Right-click the 
processed 2-D data plot (labeled with "Crop") and select Properties.)  

Cubic Spline Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. 

In Cubic Spline Fit, the spline does not have to pass exactly through every point, but instead the spline’s 
first and second derivatives must be continuous. 

Use the Cubic Spline Fit plot property to specify the Spline Fit interval. Keep the interval smaller than the 
data interval points for interpolation or make it larger for smoothing purposes. 

Delta Y 

This is a tool found under the Analysis menu that is available for 2-D data plots. It plots the difference in 
Y-values (the dependent variable) between successive data points. Use this tool as an alternative to the 
Derivative analysis tool.  

Derivative 
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This is a tool found under the Analysis menu that is available for 2-D data plots.  

It has its own Derivative plot property to specify parameters. Because the tool uses data points rather 
than a function, this tool actually calculates Δy/ Δx (Delta Y divided by Delta X) and connects resultant 
data points with a straight line. Compare this tool with the Delta Y analysis tool.  

Digital Filter Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. Use the Digital Filter Fit 
plot property to specify parameters for constructing highpass, lowpass, bandpass, and bandstop filters  

Exponential Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. It applies a generic 
exponential fit algorithm that attempts to fit an exponential curve of the form: 

 

to a spectrum. 

Use the Exponential Fit plot properties to specify initial guesses for the three parameters. 

Extrema Count 

This is a tool found under the Analysis menu that is available for 2-D data plots. It counts maxima and 
minima of the current data plot. 

Use the Extrema Count plot properties to specify details. 

Gauss Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. 

It gives the calculated fitting parameters of the non-linear least-squares fitting function: 

 

where 

. 

It has its own Gauss Fit plot property to specify parameters. 

Growth Rate Damped Sine Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. This applies a generic 
Damped Sine Fit to the current data plot to calculate growth rate.  

Use the Growth Rate Damped Sine Fit plot properties to specify the parameters for the fit. 
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Histogram and Statistics 

Histogram and Statistics is an analysis tool for post-acquisition analysis of a Scan Mode Image. 

This analysis tool plots the Count versus Intensity as a function of window position. The window position 
is determined by a rectangle or ellipse, which is placed on top of an image. The analysis is interactive, 
meaning that changing the characteristics of the window (position, length, or width) changes the plot. 

Below is a picture of Histogram and Statistics performed on a test image: 

• the red rectangle gives the boundaries (including the boundary) of the data being profiled; 
• the histogram plots count versus intensity. 

 

Right-click the Histogram and Statistics window and select Properties to change such things as – 

• plotting boundaries and colors used to create the plot; 
• fonts and labels. 

To change general display options (such as switching from raw count to percent intensity), choose the 
Options/General menu and select options in the Images and Video tab. 

Line Profile 

Line Profile is an analysis tool for post-acquisition analysis of a Scan Mode Image. 
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This analysis tool plots intensity as a function of position. The position is determined by a line, which is 
placed on top of an image. The analysis is interactive, meaning that changing the characteristics of the 
line (orientation, length, or width) changes the plot. 

Below is a picture of a line profile performed on an image: 

• the red line crossing the green image is the line that is profiled; 
• the areas beneath the red line of higher intensity corresponds with the peaks in the Line Profile. 

 

Below is a line profile of a Scan Mode image with a vertical red line. Note the horizontal axis is time. (See 
Technical Note below.) 

 

Any number of line profiles can be done on the same movie/image. Click on the image and again click on 
the Line Profile icon to bring up another line profile window. 

Right-click the Line profile window and select Properties to change such things as – 

• how and what data is displayed; 
• whether the data is processed (e.g., Boxcar smoothed) before it is displayed. 

To change general display options (such as raw versus percent intensity), choose the Options/General 
menu and select options in the Images and Video tab. 

Technical notes: 

1. If a line profile is placed vertically on a Scan Mode image, the Line Profile automatically changes 
from intensity versus pixel number to intensity versus time. This is because traversing straight 
down a Scan Mode image represents the time evolution of the acquisition. 
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2. Changing the line’s thickness (double-click the line to do so) will average out the data beneath the 
line. This is another way to improve the smoothness of the line profile (other than applying data 
filters). 

Lowpass Filter 

This is a tool found under the Analysis menu that is available for 2-D data plots. It applies a generic Low 
Pass Filter, that will pass below a specified cut off, to the current plot. 

Use the Lowpass Filter plot properties to specify the Frequency to use. 

Poly Fit w/ extrapolation 

This is a tool found under the Analysis menu that is available for 2-D data plots. It performs a Polynomial 
Fit (up to 5th degree) and allows the user to increase the range over which the polynomial is plotted.  

Use the Poly Fit w/ extrapolation plot property to specify the coefficients used for plotting and to increase 
the range beyond the data (for data extrapolation).  

Polynomial Fit 

This is a tool found under the Analysis menu that is available for 2-D data plots. It uses matrix inversion to 
do a least squares polynomial fit to the data. 

Use the Polynomial Fit plot property to specify the degree of the polynomial:. 

up to 22nd degree. 

Compare with Poly Fit w/ Extrapolation, which allows plotting of the polynomial beyond the data range. 

Pyrometric Growth Rate 

This is a tool found under the Analysis menu that is available for 2-D data plots. It is used for determining 
thin film growth rate by performing a Fourier transform and then using BandiT’s algorithm. The resulting 
plot is of the Fourier transform (either DFT or FFT, using the Fourier Transform plot property) with the 
growth rate displayed in the plot title. 

It has its own Index of Refraction plot property, and both it and the use of this analysis tool are described 
more in the topic How-To Measure Growth Rate. 

Sampling 

This is a tool found under the Analysis menu that is available for 2-D data plots. It applies a generic 
sampling algorithm. 

Savitzky-Golay 

This is a tool found under the Analysis menu that is available for 2-D data plots. It applies a Savitzky-
Golay digital smoothing polynomial (DISPO) filter to the current plot. 

The main advantage of this type of filter is that it tends to preserve spectral features with higher moments 
which are typically 'flattened' by other smoothing techniques (such as moving average, for example). It 
performs a local polynomial regression of specified order on a specified number of adjacent points in 
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order to determine the smoothed value at each point. An advantage of this technique is that derivatives 
may be trivially calculated from the smoothing polynomial. 

Use the Savitzky-Golay plot property to specify the parameters of the fit. 

Scale by Poly 

This is a tool found under the Analysis menu that is available for 2-D data plots. It applies a generic scale 
by polynomial algorithm the degree of which is determined by a number of user specified coefficients. 

Use the Scale by Poly plot property to specify the coefficients. 

Spreadsheet 

This is a tool found under the Analysis menu that is available for 2-D data plots that displays plotted data 
in a spreadsheet, with the independent variable(s) in the first column(s) on the left and the dependent 
variable(s) in the remaining column(s) on the right.  

Right-clicking the spreadsheet and selecting Properties yields only a subset of the choices available for 
the plot, allowing the user only to change spreadsheet-specific properties rather than plot-specific 
properties.  

The spreadsheet can be exported as a Text File (*.txt), Excel File (*.xls) or HTML File (*.html) by selecting 
File/Export in the main menu.  

Surface Analysis 

Surface Analysis is an analysis tool for post-acquisition analysis of a Scan Mode Image. It performs a 
generic Surface Analysis algorithm on the current image. 

Window Surface Plot 

Surface Plot is an analysis tool for post-acquisition analysis of a Scan Mode Image. 

This analysis tool plots intensity as a function of window position. The window position is determined by a 
rectangle that is placed on top of an image. The analysis is interactive, meaning that changing the 
characteristics of the window (position, length, or width) changes the plot. Surface Plot is particularly 
useful for bringing out weak features difficult to see in a 2-D image.  

The Surface plot can also be rotated by clicking anywhere on the plot window and dragging with the 
mouse. This allows the surface to be viewed from all sides.  

Below is a picture of a Surface Plot performed on a test image:  

• the red rectangle is profiled by the plot;  
• the areas inside the red rectangle of higher intensity corresponds with the higher values along the 

Z-axis in the Surface Plot.  
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Right-click the Surface Plot window and select Properties to change such things as –  

• plotting boundaries (rectangle) and mesh-size used to create the plot;  
• whether the data is processed (e.g., smoothed) before it is displayed.  

To change general display options (such as raw versus percent intensity), choose the Options/General 
menu and select options in the Images and Video tab.  

Triple Region Plot 

Triple Region Plot is an analysis tool for post-acquisition analysis of a Scan Mode Image. 

Triple Region Plot analysis plots a Surface Plot, Contour Plot and the original image as a function of 
window position. The window position is determined by a rectangle or ellipse, which is placed on top of an 
image. The analysis is interactive, meaning that changing the characteristics of the window (position, 
length, or width) changes the plot. 

The Triple Region plot can also be rotated by clicking anywhere on the plot window and dragging with the 
mouse. This allows the surface to be viewed from all sides. 

Below is a picture of a Triple Region Plot performed on a test image: 

• the red rectangle is profiled by the plot; 
• the areas inside the red rectangle – 

• of higher intensity corresponds with the peaks in the Surface Plot (top plot) 
• of different intensities are separated by lines in the Contour Plot (middle plot) 
• is copied from the image for reference purposes (bottom plot) 
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Right-click the Triple Region Plot window and select Properties to change such things as – 

• plotting boundaries and mesh-size used to create the plot; 
• whether the data is processed (e.g., smoothed) before it is displayed. 

To change general display options (such as raw versus percent intensity), choose the Options/General 
menu and select options in the images and video tab. 

Plot Properties 

Plot Properties 

Both Real-Time Charts and post-acquisition analysis tools have plots. Each plot has different sets of 
properties that can be modified and applied. Right-click a plot and select Properties to view the plot 
properties of that particular plot. 

 

The full list of plot properties is as follows: 

• Auto-Scrolling 
• BandiT Computed Data 
• BandiT Spectra Acquire Source 
• BandiT Spectral Data 
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• Blackbody Fit 
• Blackbody Fit Lock Temp 
• Blackbody Fit Lock Tooling 
• Boxcar Smooth 
• Colors 
• Contour 
• Crop 
• Cubic Spline Fit 
• Data 
• Data Filters 
• Derivative 
• Digital Filter Fit 
• Exponential Fit 
• Extrema Count 
• Factory Calibration Acquire Source 
• File 
• Fonts 
• Fourier Transform 
• Gauss Fit 
• Growth Rate Damped Sine Fit 
• Index of Refraction 
• Labels 
• Line 
• Lowpass Filter 
• Parameters 
• Playback 
• Plot Value 
• Refresh Rate 
• Poly Fit w/ extrapolation 
• Polynomial Fit 
• Rectangle 
• Samples 
• Sampling 
• Savitzky-Golay 
• Scale by Poly 
• Series 
• Shape 
• Source 
• Surface 
• X/Y/Z Axis 

General Notes: 

1. Find specific data values by simply clicking the plot and placing the mouse cross-hairs on the 
point of interest. The coordinates are given in the right lower portion of the kSA application 
window (in the Status bar). Maximize the application window and be sure the Status bar is 
selected (find it under the View menu). 

2. Control-click-and-drag across a range of interest on a plot to zoom-in on those particular plot 
values. 

Auto-Scrolling 
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This is a plot property most often associated with Real-Time Charts because it specifies how the data is 
to be displayed on the chart when the total amount of data is not known. 

 

Specify: 

Disabled – turn off auto-scrolling. Plots data by continually scaling plot. 

Continuous – scrolling continuously 

Intervals – data plotted across window and scrolls at end of window to next interval 

BandiT Computed Data 

This is a plot property. It is used for specifying which data is plotted. See also Bandit Spectral Data and 
kSA’s proprietary file formats. 

BandiT Computed Data may be called BandiT’s "narrow-column" data, e.g., data such as temperature (a 
single value) is considered a data point. It is the only type of data stored when selecting Minimal data 
output (default) in the BandiT I/O Settings Advanced Acquisition Option. 

To switch to the other data format (if it was stored during acquisition), close the plot property and click the 
Toggle Charts button in the *.kdt Toolbar. 

 

Specify: 
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Number of Data Columns – up to 4 series of data may be plotted on the same plot. This is useful 
particularly for plotting two different Y-axis data against the same X-axis data, such as BandiT 
Temperature and Analog Input (used to control a process) versus Elapsed Time. 

For each Series, specify for Y axis and X axis: 

For Data, select the data values for each axis, such as – 

• Elapsed Time 

• Data Point 

• BandiT Temperature 

• Band Edge Wavelength 

• TC Temperature – available for all calibration files 

• Confidence 

• Number of Wavelengths 

• Peak Spectra Intensity 

• Spectrometer Integration Time 

• Percent of Full Light Intensity 

Sample – this will always read "Default" and remain disabled in kSA’s BandiT 

Units – of the Data that has been selected above. It will be disabled if there is only one unit 
choice. 

Check the Apply changes to all open plots of same type, and changes made in this properties dialog 
will apply to all open plots of the "narrow-column" data type. 

BandiT Spectra Acquire Source 

This is a plot property that is used only when a *.kdt file is chosen as the Source in BandiT Temperature 
Acquisition. It is used to configure the way data is viewed as if it is live. A similar plot property is the 
Factory Calibration Acquire Source, but that is used only when making calibration files, so most users will 
not use it. 
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Check: 

Loop – for looping the *.kdt file for acquisition. This checkbox must be selected to loop the file. The 
Loop button on the *.kdt toolbar only loops playback. 

Animate during acquire – to view the *.kdt file play during acquisition 

Specify Acquisition Limits: 

Data – choose Elapsed Time or Data Point and then use the arrows with Start and Stop to set the 
lower and upper bound from which data is acquired. This trims the data, allowing the user to begin 
and end acquisition at any point. 

Note that the Start and Stop values increment based on the values in the *.kdt, so data 
points are numbered sequentially and elapsed time is as recorded. For elapsed time, this 
means that the number of decimal places may mean that the beginning (or end) of the value 
is hidden while using the arrows buttons, so simply place the cursor in the box and use the 
arrow keys on the keyboard to view either end of the number. 

(For example, in the Stop field pictured above, the end of the number 2699.9299316 is not 
displayed – the whole number is 2699.92993164063, and while scrolling through the data 
only .92993164063 is displayed.) 

The Elapsed time specifies whether the spectra will be time-compressed in the new acquisition. 

From document data – and the elapsed time will be generated from whatever data value is 
selected. Usually, users select Elapsed Time, which means that the new *.kdt acquisition elapsed 
time values will match those of the source *.kdt file. 

or 

Generate at – and the overall amount of data in the *.kdt file will be divided by this number, with 
the new acquisition will be as though it took place in the resultant number of seconds. The units 
are data points per second. 
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For example, suppose a *.kdt file has 8000 data points that were generated over the course 
of 9999 seconds. Setting Generate at to 1000 means that the new *.kdt file will have all 
8000 data points in a file that has a total elapsed time of 8000/1000 = 8 seconds. 

The Acquisition speed specifies how fast the spectra is available for processing during a new 
acquisition. Choose: 

Match elapsed time – and the data will be available for processing at the same speed at which it 
was originally acquired 

or 

Acquire at – and the data (e.g. 200 spectra per second) will be available at a user-specified speed 

BandiT Spectral Data 

This is a plot property. It is used for specifying which spectral data is plotted. See also BandiT Computed 
Data and kSA’s proprietary file formats. 

BandiT Spectral Data may be 
called BandiT’s "wide-column" 
data, e.g., data such as 
spectra (multiple values) may 
be considered one data point. 
Both it and the BandiT 
Computed Data are stored 
when selecting Store raw and 
fully processed spectra in the 
BandiT I/O Settings Advanced 
Acquisition Option. 

To switch to the other data 
format, close the plot property 
and click the other tab at the 
bottom of the chart. 

Specify: 

N. Data Columns – up to 4 
columns of data may be 
plotted on the same plot. This 
is useful particularly for plotting 
two (or more) different Y-axis 
data against the same X-axis 
data. BandiT regularly does 
this in the Real-Time 
Normalized BandiT Spectra, 
plotting BandiT Fit Linear Fit X 
Pos, BandiT Fit Linear Fit Y 
Pos, and the BandiT 
Normalized Spectra. 

For each Data column, 
specify for Y axis and X axis: 
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For Data, select the data values for each axis, such as – 

• Band Gap Linear Fit X/Y Pos 
• BandiT Normalized Spectra 
• BandiT Spectra 
• BandiT Spectra Wavelength 

Sample – this will always read "Default" and remain disabled in kSA’s BandiT 

Units – of the Data that has been selected above. It will be disabled if there is only one unit choice. 

For Where, specify the type and range of data plotted: 

Data – select what type of data is to be used for the range 

For example, in the dialog above, BandiT Spectra vs. Bandit Spectra Wavelength is plotted Where 
the Data plotted is From 0 to 10, meaning the first 11 data points are plotted together on one 
graph. 

Choose one: 

All – for plotting the whole range of Data. Selecting this option can take several minutes to plot if 
there is a lot of data. 

Is – for plotting a particular spectra based on the Data value selected 

From – for plotting a specific range of Data 

Specify Additional Column To View in order to place another title in the plot header that specifies the 
value. 

Check the Apply changes to all open plots of same type, and changes made in this properties dialog 
will apply to all open plots of the "wide-column" data type. 

Blackbody Fit 

This is a plot property unique to plots analyzed with the Blackbody Fit post-acquisition analysis tool. 
Temperature and Tooling Factor can both vary during the fitting of the Blackbody curve. 

When Blackbody Fit is used in Analysis mode the integration time, emissivity are tied into the Tooling 
Factor. This differs from the case when Blackbody is used during Acquisition mode where the integration 
time and emissivity are independent of the Tooling Factor. 
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Specify the parameters for the plot in the left hand column. The parameters used in the last attempt are 
displayed in the right hand column and can be copied across using the <<Copy button. This is useful 
when using multiple iterations to obtain the best fit. 

Tooling Factor - an estimate of the tooling factor to be used as an initial guess by the fitting 
routine. 

Temperature - an estimate of the temperature to be used as an initial guess by the fitting routine. 
Note that the results are fairly sensitive to the initial guess. Typically, it should be within ~20%, but 
the routine tends to be more forgiving if this represents an over-estimate rather than an under-
estimate. 

Constant - enter a value for the background constant, optional, enter 0 for no constant 

Fit Tolerance - the fitting routine stops when chi-squared decreases by less than this tolerance 
value upon successive iterations 

Good Fit - this allows rejection of spectra with poor fits, as measured by the reduced chi-squared 
statistic. The default value is 20, meaning spectra which have reduced chi-squared greater than 
this value will be ignored. 

Fit Goodness - the goodness of fit that is obtained is displayed 



BandiT User Manual 

212 

Enable Init Tool Temp Est - 

Blackbody Fit Lock Temp 

This is a plot property unique to plots analyzed with the Blackbody Fit Lock Temp post-acquisition 
analysis tool. Specify a Temperature which will be used to superimpose the expected blackbody curve 
for that temperature over the current data plot. The Goodness of fit of the curve will be displayed. 

When Blackbody Fit is used in Analysis mode the integration time, emissivity are tied into the Tooling 
Factor. This differs from the case when Blackbody is used during Acquisition mode where the integration 
time and emissivity are independent of the Tooling Factor. 

 

  

Specify the parameters for the plot in the left hand column. The parameters used in the last attempt are 
displayed in the right hand column and can be copied across using the <<Copy button. This is useful 
when using multiple iterations to obtain the best fit. 

Tooling Factor - an estimate of the tooling factor to be used as an initial guess by the fitting 
routine. 

Temperature - the temperature that is to be used when calculating the Blackbody curve. This is 
locked and will not vary during the fitting process 
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Constant - enter a value for the background constant, optional, enter 0 for no constant 

Fit Tolerance - the fitting routine stops when chi-squared decreases by less than this tolerance 
value upon successive iterations  

Good Fit - this allows rejection of spectra with poor fits, as measured by the reduced chi-squared 
statistic. The default value is 20, meaning spectra which have reduced chi-squared greater than 
this value will be ignored. 

Fit Goodness - the goodness of fit that is obtained is displayed  

Enable Init Tool Temp Est -  

Blackbody Fit Lock Tooling 

This is a plot property unique to plots analyzed with the Blackbody Fit Lock Tooling post-acquisition 
analysis tool. Specify a Tooling Factor which will be used to superimpose the expected blackbody curve 
for that temperature over the current data plot. The Goodness of fit of the curve will be displayed. 

When Blackbody Fit is used in Analysis mode the integration time, emissivity are tied into the Tooling 
Factor. This differs from the case when Blackbody is used during Acquisition mode where the integration 
time and emissivity are independent of the Tooling Factor. 
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Specify the parameters for the plot in the left hand column. The parameters used in the last attempt are 
displayed in the right hand column and can be copied across using the <<Copy button. This is useful 
when using multiple iterations to obtain the best fit. 

Tooling Factor - enter the Tooling Factor this is to be used when fitting the Blackbody curve 

Temperature - an estimate of the temperature to be used as an initial guess by the fitting routine. 
Note that the results are fairly sensitive to the initial guess. Typically, it should be within ~20%, but 
the routine tends to be more forgiving if this represents an over-estimate rather than an under-
estimate. 

Constant - enter a value for the background constant, optional, enter 0 for no constant 

Fit Tolerance - the fitting routine stops when chi-squared decreases by less than this tolerance 
value upon successive iterations  

Good Fit - this allows rejection of spectra with poor fits, as measured by the reduced chi-squared 
statistic. The default value is 20, meaning spectra which have reduced chi-squared greater than 
this value will be ignored. 

Fit Goodness - the goodness of fit that is obtained is displayed  

Enable Init Tool Temp Est -  

  

Boxcar Smooth 

This is a plot property.  

 

Specify Points to boxcar smooth to choose the width of the side of the smoothing window. For example, 
3 specifies a 3 by 3 smoothing window with 9 total elements. The smoothed element will be in the middle 
of that box.  

For no smoothing, choose 1 from the drop-down box.  

Smoothing can also be done using the 2-D data filter Boxcar Smooth.  

Colors 

This is a plot property used to change the colors of the plot. Every color is available.  

The number of elements available for coloring varies with the plot as shown in the examples below.  
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Additional color and palette options are available in the Contour and Surface properties for the following 
plots:  

Contour Plot  
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Surface Plot  

Triple Region Plot  

Contour 

This is a plot property available only for the Contour Plot and the Triple Region Plot.  

 

Specify:  

Contour levels – to divide the Z-Axis data into more/fewer parts. See the Z-Axis for setting the 
range and scale factor.  

Contour color – to choose the color of the contour lines  

Choose either  

Use palette – to view the image with the contour lines. Using this option, specify the palette. Note 
that the palette only changes how the data is displayed.  

or  

Use contour lines only – to hide the image and show only the contour lines  

Crop 

This is a plot property unique to cropped 2-D data plots created using the crop post-acquisition analysis 
tool.  

 

Specify the number of columns to be trimmed from the left and right to create the new, cropped data plot.  

Cubic Spline Fit 

This is a plot property unique to plots analyzed with the Cubic Spline Fit post-acquisition analysis tool.  
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Specify the Spline fit interval –  

for interpolation by typing in a value less than the data interval. Decimal values are acceptable.  

for smoothing by typing in a value larger than the data interval.  

Data 

This is a plot property. In BandiT, there are several types of data, each with their own plot property:  

BandiT Computed Data – for plots of "narrow-column" data, e.g., data such as temperature (a 
single value) is considered a data point  

BandiT Spectral Data – for plots of "wide-column" data, e.g., data such as spectra (multiple values) 
may be considered one data point.  

Bandit Platen Data - for plots of the platen surface in the Real-time Platen Surface Plot 

Multiple Markers LED Data - For plots of numeric readouts from multiple markers on a rotating 
platen 

  

Data Filters 

This is a plot property that is available for many plots. It applies Data Filters that affect the plot (replacing 
the original data with the filtered data), but does not affect the data nor how the data are gathered. The 
number of filters available depends on the plot: 2-D plots have many filters; 3-D plots have a few.  

 

Choose up to five filters. They will be applied in order, i.e., the output of the first filter is the input to the 
second filter, and so on.  

Click the Properties button to select the properties for each Data Filter. 
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Derivative 

This is a plot property unique to plots analyzed with the Derivative post-acquisition analysis tool.  

 

Specify a Derivative number to take that order of derivative. The Peak at (in same units as X-axis, 
horizontal) and Peak value (in same units as Y-axis, vertical) are not alterable and are given based on 
the derivative taken.  

Because the tool uses data points rather than a function, this tool actually calculates Δy/Δx (Delta Y 
divided by Delta X) and connects resultant data points with a straight line – for the first derivative. It does 
likewise for other orders of derivatives.  

Digital Filter Fit 

This is a plot property unique to plots analyzed with the Digital Filter Fit post-acquisition analysis tool. It is 
used to construct highpass, lowpass, bandpass, and bandstop filters.  

 

Specify:  

Low freq. – the lower frequency of the filter as a fraction of the Nyquist frequency  

High freq. – the upper frequency of the filter as a fraction of the Nyquist frequency  

The following conditions are necessary for various types of filters:  

No Filtering: Low = 0 and High = 1  

Low Pass: Low = 0 and 0 < High < 1  

High Pass: 0 < Low < 1 and High = 1  

Band Pass: 0 < Low < High < 1  

Band Stop: 0 < High < Low < 1  

Exponential Fit 

This is a plot property for the Exponential Fit plot which applies a generic exponential fit algorithm that 
attempts to fit an exponential curve of the form: 
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to a spectrum.  

 

Specify initial starting points for the three parameters A0, A1 and A2. 

Extrema Count 

This is a plot property used to specify parameters for the Extrema Count Plot. 

 

Specify: 
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Count - use the drop down list to select what to count 

Slopes required - enter the number of slopes required 

Minimum slope - enter minimum slope 

Select Plot extremas or Plot extrema intervals. 

Factory Calibration Acquire Source 

This is used by k-Space to configure the BandiT calibration files. This is not generally used by a BandiT 
user. 

This is a plot property. It is used only to make calibration files, so most users will not use it. Instead, users 
may use a similar plot property called BandiT Spectra Acquire Source to configure the way data is viewed 
as if it is live. 

 

Check: 

Loop – for looping the *.kdt file for acquisition. This checkbox must be selected to loop the file. The 
Loop button on the *.kdt toolbar only loops playback. 

Animate during acquire – to view the *.kdt file play during acquisition, this is default selected and 
can no longer be changed. 

Specify Acquisition Limits: 

Data – choose Elapsed Time or Data Point and then use the arrows with Start and Stop to set the 
lower and upper bound from which data is acquired. This trims the data, allowing the user to begin 
and end acquisition at any point. 

Note that the Start and Stop values increment based on the values in the *.kdt, so data points are 
numbered sequentially and elapsed time is as recorded. For elapsed time, this means that the 
number of decimal places may mean that the beginning (or end) of the value is hidden while using 
the arrows buttons, so simply place the cursor in the box and use the arrow keys on the keyboard 
to view either end of the number. 
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The Elapsed time specifies whether the spectra will be time-compressed in the new acquisition. 

From document data – and the elapsed time will be generated from whatever data value is 
selected. Usually, users select Elapsed Time, which means that the new *.kdt acquisition elapsed 
time values will match those of the source *.kdt file. 

or 

Generate at – and the overall amount of data in the *.kdt file will be divided by this number, with 
the new acquisition will be as though it took place in the resultant number of seconds. The units 
are data points per second. 

For example, suppose a *.kdt file has 8000 data points that were generated over the course 
of 9999 seconds. Setting Generate at to 1000 means that the new *.kdt file will have all 
8000 data points in a file that has a total elapsed time of 8000/1000 = 8 seconds. 

The Acquisition speed specifies how fast the spectra is available for processing during a new 
acquisition. Choose: 

Match elapsed time – and the data will be available for processing at the same speed at which it 
was originally acquired 

or 

Acquire at – and the data (e.g. 200 spectra per second) will be available at a user-specified speed 

File 

This is a plot property that enables the user to comment on the plot/spreadsheet and store those 
comments with the file (so long as it is not exported, but saved in k-Space’s proprietary *.kdt format). 

 

Change the Compression to ZLib for loss-less compression, thereby reducing file size, but taking slightly 
longer to re-open. 

Fonts 
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This is a plot property that allows the user to change the font, font style, size, and script of the labels and 
titles on all charts. The functionality is similar to that of a word processor: the number of fonts available 
depend on the number installed on the system.  

 

To change the font characteristics of the axis numbers, click the Tick labels button.  

To change the font characteristics of anything else, click the Titles button.  

Fourier Transform 

This is a plot property for plots generated using FFT tools available under the Analysis menu. 

 

  

Select: 

FFT or DFT – While very fast, the Fast Fourier Transform (FFT) algorithm may introduce numerical 
error into the calculation. This is because FFT requires data sets that are a power of two in length. 
Zeros are added to data sets to get the proper length, and this can lead to small errors in 
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determining the frequency. The Discrete Fourier Transform (DFT) does not have this deficiency. 
Unless the data set is very large data set (or a very slow computer), it is best to use the Discrete 
Fourier Transform (DFT) for analysis. While slower, DFT provides more accurate analysis of the 
frequency. 

The Weighted average – takes the shape of the power spectrum peak frequency into account, 
calculating a weighted average frequency based on this shape. If the peak frequency profile is perfectly 
symmetric, then the weighted average frequency and the peak frequency are identical. 

Specify: 

Threshold – height of the peak profile below which a weighted average is not calculated. For 
example, a threshold of 0.5 means that the weighted average is calculated for the top 50% of the 
peak profile. The threshold value is useful for eliminating asymmetries in the peak profile. 

Steps to side – the number of data points to each side of the peak that are used in the weighted 
average calculation. For example, a value of 1 means that the weighted average algorithm will take 
1 data point to each side of the peak (as long as they are above the threshold value). 

Check: 

Mirror data set – to mirror the intensity data set about itself, thereby doubling the number of data 
points fed into the Fourier transform. In most cases this yields a cleaner Fourier transform. 
However, sometimes this yields additional harmonics that may result in an erroneous peak. The 
best way to check this is to first disable this checkbox, look at the peak frequency, and then turn on 
Mirror data set. The new peak should be within 5% of the old one. 

Set: 

DC Filter(Hz) - set the level of DC filter to use. 

Gauss Fit 

This is a plot property unique to plots analyzed with the Gauss Fit post-acquisition analysis tool. It gives 
the calculated fitting parameters of the non-linear least-squares fitting function:  

 

where  

.  
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Click the <<Copy button to copy the values from the shaded values (determined by the program) to the 
user-specified boxes. This will allow the same fitting parameters to be used on the next Gauss Fit.  

Growth Rate Damped Sine Fit 

This is a plot property unique to the Growth rate Damped Sine Fit analysis plot. 
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Specify the parameters for the plot in the left hand column. The parameters used in the last attempt are 
displayed in the right hand column and can be copied across using the <<Copy button. This is useful 
when using multiple iterations to obtain the best fit. 

Index of Refraction 

This is a plot property. It is used for Pyrometric Growth Rate analysis window, which is BandiT’s method 
for determining growth rate.  

 

Specify the Index Of Refraction given the temperature and material. See more on this topic in the How-
To Determine Growth Rate guide. There, it describes how to determine the Index of Refraction for a 
whole range of wavelengths given a temperature and material.  

For example, here is a graph of the Index of Refraction versus Wavelength for GaAs at 600°C.  

  

 

Labels 

This is a plot property that allows the user to change how the axes and title are labeled.  
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Using the Automatic setting selects the units chosen in the Data property. Deselect Automatic to rename 
the axis or title.  

The Top title default is blank for the 3-D plots (Surface Plot, Contour Plot, Triple Region Plot), changing 
when non-default values are chosen in other properties (such as Samples). It defaults to specific data in 
2-D plots (e.g., Histogram and Statistics, Line Profile).  

Line 

This is a plot property. But it also appears as a pop-up window when a line is double-clicked in an 
acquisition mode analysis tool (like Line Profile) for changing the line’s properties. 

 

Note in particular that changing the thickness averages (mean) the data beneath the line. So the thicker 
the line, the more data that is averaged. 

Lowpass Filter 

This is a plot property for the Lowpass Filter analysis plot. 
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Specify the Frequency to use for the filter. 

Multiple Markers LED Data 

This is a Plot Property which is used to determine which data is displayed in Multiple Marker LED Real-
Time Charts. 

 

Specify 

Marker - the number(s) of the markers that you want to display 

Select: 

Data - the data to be displayed for each marker. Check the All markers use the same column 
choice to use the same data for each marker. 

Decimal Places - choose the number of decimal places to display for each marker 

Orientation Column or Row - to display the multiple LED values in a column or a row, see the 
examples below. 
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Parameters 

This is a plot property that is used to separate the Contour part of the Triple Region Plot from the other 
regions.  
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Specify the Contour offset (%) to 100 to maximize or 0 to minimize the distance between the plots.  

Playback 

This is a plot property. It is used to change the playback speed of a *.kdt file. The *.kdt Toolbar is used to 
control all other aspects of playback.  

 

Specify either  

Play at recorded rate – to play the file at the rate at which it was recorded. Of course, this option 
includes delays between acquisition points.  

or  

Play at – to choose the rate in units of data points per second  

Plot Value 

This is a plot property that is used to specify what value appears in some Real-Time Charts, including 
Real-Time Stats (Time) and Real-Time Stats (LED). 

 

Specify the Plot to choose one of several possible values. A partial list follows: 

• Elapsed Time 
• Data Point 
• Acquire in Progress 
• Data Set 
• Samples per Data Point 
• Adjusted Elapsed Time 
• BandiT Temperature 
• TC Temperature 
• Confidence 
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• BandiT Spectra 
• Number of Wavelengths 
• BandiT Normalized Spectra 
• Bandit Spectra Wavelength 
• Band Gap Linear Fit X/Y Pos 
• Number of Linear Fits 
• Band Edge Wavelength 
• Peak Spectra Intensity 
• BandiT Fit Spectra 
• BandiT Fit Spectra Width 
• BandiT Background Width 
• Spectrometer Integration Time 
• Pyrometry Value 
• Percent of Full Light Intensity 
• Integrated Intensity – when implemented 
• Analog Input 
• Analog Input 0 – up to 8 total Analog Input Channels 
• Digital Input 1 – up to 15 total Digital Input Channels 

Poly Fit w/ extrapolation 

This is a plot property unique to plots analyzed with Poly Fit w/ extrapolation post-acquisition analysis 
tool. It performs a Polynomial Fit (up to 5th degree) and allows the user to increase the range over which 
the polynomial is plotted.  

 

Specify:  
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Polynomial Degree – for the highest degree term. For example, if Polynomial Degree is set to 4, 
then the software will fit the data to a fourth degree function, e.g.,  

 

Add Left – to increase the functions domain to the left of the data by this number of units  

Add Right – to increase the function’s domain to the right of the data by this number of units  

Coeff. – for the coefficients of the Polynomial Fit (which uses matrix inversion)  

Click the <<Copy button and the calculated values will be copied over to the user-specified values – 
which are the ones actually used to plot the fit.  

Polynomial Fit 

This is a plot property unique to plots analyzed with Polynomial Fit post-acquisition analysis tool.  

 

Specify the Polynomial Degree for the highest degree term. For example, if Polynomial Degree is set to 
4, then the software will fit the data to a fourth degree function, e.g.,  

 

Rectangle 

This is a plot property. The rectangle plot property is only available for 3-D plotting and specifies the exact 
location and size of the rectangle of data that is used for plotting.  

 

Columns (vertical) are numbered from left to right.  
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The Width is the number of columns wide the rectangle is.  

Rows (horizontal) are numbered from top to bottom.  

The Height is the number of rows high the rectangle is.  

Refresh Rate 

This is a plot property used to specify how fast the data is updated in some real-time charts.  

 

Choose either  

Real-Time – for updating the chart as fast as the computer is able  

or  

Refresh every – to update the chart in intervals starting as low as 0.25 seconds and going up to 
2.00 seconds (in intervals of 0.25 seconds)  

Samples 

This is a plot property used to specify how many data points are used to generate a 3-D plot (Surface 
Plot, Contour Plot, and Triple Region Plot.)  

 

Choose either  

Sample every – choose the number of samples based on the numbers of rows and columns (up to 
the size of the rectangle of data being plotted. For example, if a rectangle is 25 rows by 25 
columns, then Sample every 1 row and 1 column will give a total of 625 (= 25 * 25) data points.  

or  

Number of grid points – to choose the total number of data points sampled in the rectangle. For 
example, setting these values 25 by 25 will give 625 ( = 25 * 25) total data points, no matter how 
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big the rectangle is. However, if the rectangle is smaller than 25 by 25 (or if, say, there are fewer 
than 25 rows (or columns)), then the software is only able to gather a data point for each row (or 
column). Please see the technical note below.  

Technical Note:  

The software does not interpolate data between rows or columns. That is, grid size cannot be smaller 
than image resolution. Sample every gives the highest resolution plot at 1 column, 1 row. Even though 
Number of grid points can be set to as high as 1000 by 1000 – thereby dividing data of a small rectangle 
into decimal values of rows and columns – the resolution does not improve beyond 1 column, 1 row.  

Sampling 

This is a plot property for the Sampling analysis plot. 

 

Specify the number of samples to use. 

Savitzky-Golay 

This is a plot property used to specify the parameters of the Savitzky-Golay smoothing function which 
applies a Savitzky-Golay digital smoothing polynomial (DISPO) filter to the current plot.  

 

Specify: 
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Derivative number - A non-zero number results in calculation of the derivative of the specified 
order. The highest order allowed is equal to the order of the smoothing polynomial used. For 
example, use of a fourth order smoothing polynomial allows up to the fourth derivative to be 
calculated. Enter a value of zero for smoothing only. 

Boxcar Width -  Specifies the number of data points used in smoothing each data point (must be 
odd). For example, a setting of N results in smoothing each data point with the (N-1)/2 neighboring 
data points on either side. 

Smooth Order - Specifies the order of the smoothing polynomial (typically 4th order). A value of 
zero gives moving average, a.k.a. “boxcar” smoothing. 

Extend Data - A value of 1 allows the data range to be extended to accommodate the smoothing 
width. This is done by repeating the data points at the ends of the range as needed. A value of 0 
will disable this, preventing the data points near the ends of the range from being smoothed. 

Scale by Poly 

This is a plot property used to specify the coefficients for the Scale by Ploy analysis plot. 

 

Up to six coefficients can be entered which will be used by the generic scale by polynomial algorithm. 

Series 

This is a plot property available for 2-D line plots (e.g., Line Profile, FFT). If an image has more than one 
series (or set) of data, use this tab to distinguish the data plots from one another by using colors or 
markers.  
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Specify:  

Series – to choose different Lines and Marker options for up to 100 different series on the same 
plot.  

Choose:  

[All Series] – to select default Lines and Marker options.  

Series 1 (up to Series 100) – to select Lines and Marker options for a particular series.  

With Series 1 selected, click Same as [All Series] to choose the default Lines and Markers 
for that series.  

Then choose Line color and thickness, and the symbol, size, style, and colors of the Markers for 
each data point.  

Shape 

This is a plot property. But it also appears as a pop-up window when a rectangle or ellipse is double-
clicked in an analysis tool (like Histogram and Statistics) for changing the shape’s properties. 
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Columns (vertical) are numbered from left to right. 

The Width is the number of columns wide the rectangle or ellipse is. 

Rows (horizontal) are numbered from top to bottom. 

The Height is the number of rows high the rectangle or ellipse is. 

Source 

   This is a plot property that is used to specify what series is analyzed/plotted by the 2-D analysis tools.  

 

  

When the original data has multiple series, then specify:  

First – to gather data for analysis from the first series in the original data  

or  

Last – to gather data for analysis from the last series in the original data  
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or  

Specific – to gather data for analysis from a user-specified series in the original data. Use the 
drop-down box to specify which series.  

For Source range, specify:  

Use only visible data – for analyzing only the data visible in the original plot. This is useful when a 
user has set a domain/range to limit the original data (using, for example, Set X-Min by right 
clicking the original plot).  

or  

Use all available data – for analyzing all data from the original plot, even if some of it is no longer 
visible because the user has set a domain/range to limit the original data (using, for example, Set 
X-Min by right clicking the original plot).  

Spreadsheet Properties 

The Spreadsheet Properties dialog box is opened by right clicking the Spreadsheet and selecting 
Properties. 

 

Up to five Filters can be selected to be applied to the spreadsheet data, changing the data itself. 

Surface 

This is a plot property used to zoom in or colorize a 3-D plot (Surface Plot, Contour Plot, and Triple 
Region Plot). This is necessary because magnification is not available for 3-D plots. 
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Scale may be set to integer and non-integer values, for precise scaling of the data plot both up and down. 

Choose either: 

Palette – for the same palette options available in the Image Properties. 

Then check Smooth palette gradations and/or Show color legend. 

or 

Solid color – for a solid color value of the 3-D surface of the plot. 

Check Use lighting to vary intensities of the color in order to indicate ripples or patterns in 
the surface. 

Style - use the drop down arrow to select from a number of different display styles 

X/Y/Z Axis 

This is a plot property used for specifying plotting options for the axes.  
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Specify:  

Range – for the high and low 
values plotted and whether 
the user chooses it or it is 
done automatically.  

Choose: 

Automatic - then 
select Scale axis to 
fit data and the 
software will utilize all 
the available plot 
space for displaying 
the data.  

or 

Manual - and set 
Lock Maximum and 
Lock Minimum at the 
points required. 

Choose a Scale factor 
(integers 1 to 100) to zoom in 
by this multiplication factor. 
This will reduce the amount 
of data that is viewable.  

Grid lines - specifies the 
style (dashed, dotted, etc.) of 
grid lines that extend the 
length of the Major ticks. 
Note that 3-D plots do not 
have grid lines available.  

Ticks - specify the size and 
number of major and minor 
ticks, and then select what 
Direction (In for tick marks 
inside the plot – where they 
may intersect the data, Out 
for tick marks outside the plot 
– away from the data).  

General Note:  

The Range may also be set 
by right-clicking the desired boundary and selecting Set X-Min, Set X-Max, Set Y-Min, or Set Y-Max.  

Filters 
Data filters 

Data Filters 
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Data filters are for plots. Applying a data filter to a plot changes the plot itself. 

Find the Data Filters tab by right-clicking the plot and selecting Properties. 

 

For 2-D plots, choose: 

• Boxcar Smooth 
• Constant Scale 
• Derivative 
• Digital Filter Fit 
• Exponential Fit 
• Gauss Fit 
• Linear Scale 
• Normalizer 
• Polynomial Fit 
• Reverse 
• Savitzky-Golay 
• Scale by Poly 
• Spike Remover 

For 3-D plots, choose: 

• Scale 
• Smooth 

kSA systems also allow for user-created IDL filters. 

General Note: 

Some of the same tools are available under the Analysis menu option with a plot window selected. Using 
those tools creates a new plot. That makes it different from the Data Filters, which change the plot itself. 

Boxcar Smooth 

This is a 2-D data filter. It smoothes a 2D line plot with a boxcar average of the specified width. Use this 
filter to reduce the amount of noise in the plot. 
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Specify the Width of the side of the smoothing window using odd values between 3 and 101. For the filter 
to be meaningful, ensure that the specified width is smaller than either dimension of the plot. 

For example, width 3 specifies a 3 by 3 smoothing window with 9 total elements. The smoothed element 
will be in the middle of that box. 

Technical Note: 

Specifically, the function employed is this: 

 

where 

R = result 

A = array (of any dimension) 

w = width (user-specified) 

Constant Scale 

This is a 2-D data filter. It is similar to the Linear Scale and Scale by Poly filters. 

 

Specify Scale constant for the multiplier of all dependent values. For example, if peak intensity is 50%, 
average intensity is 35%, and scale constant is 2, then applying this filter means the peak intensity is 
100% and the average intensity is 70%. 

Note: negative and decimal values are allowed. 

Derivative 

This is a 2-D data filter that plots a derivative of a plot. Because the tool uses data points rather than a 
function, this tool actually calculates Δy/ Δx (Delta Y divided by Delta X) and connects resultant data 
points with a straight line – for the first derivative. It does likewise for other orders.  
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Specify:  

Derivative number – for which derivative to take, up to the fifth (5) derivative  

Peak at and Peak value are not alterable, and do not show any data for this data filter. To view 
these, apply the Derivative analysis tool and then look at the Derivative plot property.  

Digital Filter Fit 

This is a 2-D data filter used to construct highpass, lowpass, bandpass, and bandstop filters.  

 

Specify:  

Low freq. – the lower frequency of the filter as a fraction of the Nyquist frequency  

High freq. – the upper frequency of the filter as a fraction of the Nyquist frequency  

The following conditions are necessary for various types of filters:  

No Filtering: Low = 0 and High = 1  

Low Pass: Low = 0 and 0 < High < 1  

High Pass: 0 < Low < 1 and High = 1  

Band Pass: 0 < Low < High < 1  

Band Stop: 0 < High < Low < 1  

Exponential Fit 

This is a 2-D data filter that replaces the plotted data with a generic exponential fit using an algorithm that 
attempts to fit an exponential curve of the form: 

 

to a spectrum.  
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Specify initial guesses for the Fit Parameters A0, A1, A2 

  

  

Gauss Fit 

This is a 2-D data filter that computes a non-linear least-squares fit to a function f(x) with six parameters 
and replaces the original data with the fitted equation.  

 

f(x) is a linear combination of a Gaussian and a quadratic:  
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where  

.  

Note: to view the Gauss fit together with the original data, use the Gauss Fit analysis tool (under the 
Analysis menu).  

Linear Scale 

This is a 2-D data filter. It is similar to the Constant Scale filter, but with the additional function of being 
able to add a constant to every dependent value (see b below). To scale for higher powers of x, use the 
Scale by Poly.  

 

Specify:  

m – for the multiplier of all dependent values. For example, if peak intensity is 50%, average 
intensity is 35%, and m = 2, then applying this filter means the peak intensity is 100% and the 
average intensity is 70%.  

b – for adding a constant to all dependent values. For example, if peak intensity is 50%, minimum 
intensity is 2%, and b = 1, then applying is filter means the peak intensity is 51% and the minimum 
intensity is 3%.  

Note: negative and decimal values are allowed.  

Normalizer 

This is a 2-D data filter that takes the plot’s peak value and calculates the scale factor required to bring 
the peak to the maximum intensity value. It then multiplies that scale factor times every data point.  

Polynomial Fit 

This is a 2-D data filter that replaces the plotted data with a fitted polynomial.  

 

Specify the Polynomial Degree to choose the highest degree term. For example, if Polynomial Degree is 
set to 4, then the software will fit the data to a fourth degree function, e.g.,  
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The software provides the value of the Coefficients only when applying the Polynomial Fit analysis tool, 
which plots the polynomial fit on top of the original data.  

Reverse 

This is a 2-D data filter. It swaps the data from the beginning and the end, which in effect flips the plot 
over a vertical line. For example, if the first data point has a value of 3 and the last one has a value of 7, 
then applying this filter yields a plot with the first data point with a value of 7 and the last data point with a 
value of 3.  

Savitzky-Golay 

This is a 2-D data filter that removes high frequency noise from data, while preserving the original shape 
and features of the signal, and is well adapted for data smoothing. 

It performs a local polynomial regression of specified order on a specified number of adjacent points in 
order to determine the smoothed value at each point. An advantage of this technique is that derivatives 
may be trivially calculated from the smoothing polynomial. 

 

Specify: 

Derivative number - A non-zero number results in calculation of the derivative of the specified 
order. The highest order allowed is equal to the order of the smoothing polynomial used. For 
example, use of a fourth order smoothing polynomial allows up to the fourth derivative to be 
calculated. Enter a value of zero for smoothing only. 

Boxcar width - Specifies the number of data points used in smoothing each data point (must be 
odd). For example, a setting of N results in smoothing each data point with the (N-1)/2 neighboring 
data points on either side. 

Smooth Order - Specifies the order of the smoothing polynomial (typically 4th order). A value of 
zero gives moving average, a.k.a. “boxcar” smoothing. 
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Extend data - A value of 1 allows the data range to be extended to accommodate the smoothing 
width. This is done by repeating the data points at the ends of the range as needed. A value of 0 
will disable this, preventing the data points near the ends of the range from being smoothed. 

Scale 

This is a 3-D data filter. It is similar to the Linear Scale filter, but for 3-D plots. This is useful for zooming in 
on a 3-D plot, particularly because the Zoom buttons are not enabled for a 3-D plot.  

 

Specify:  

m – for the multiplier of all dependent values. For example, if peak intensity is 50%, average 
intensity is 35%, and m = 2, then applying this filter means the peak intensity is 100% and the 
average intensity is 70%.  

b – for adding a constant to all dependent values. For example, if peak intensity is 50%, minimum 
intensity is 2%, and b = 1, then applying is filter means the peak intensity is 51% and the minimum 
intensity is 3%.  

Scale by Poly 

This is a 2-D data filter. It is used to scale the data by a polynomial (up to fifth degree).  

 

 

Specify:  

Coeff. 0 – to set the constant coefficient: for example, inputting 10 will increase the intensity of all 
values by 10 counts.  

Coeff. 1 – to set the scaling coefficient: for example, if the value of the peak intensity is 50%, the 
minimum intensity is 2%, then setting Coeff. 0 to 2 means applying this filter will result in a peak 
intensity of 100% and a minimum intensity of 4%.  
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Coeff. 2 (and others) – to set the coefficient(s) of the power terms  

Smooth 

This is a 3-D data filter. It smoothes a 3-D surface plot with a boxcar average. Use this filter to reduce the 
amount of noise in the plot. 

 

Specify the Width of the side of the smoothing window using odd values between 3 and 101. For the filter 
to be meaningful, ensure that the specified width is smaller than either dimension of the plot. 

For example, width 3 specifies a 3 by 3 smoothing window with 9 total elements. The smoothed element 
will be in the middle of that box. 

Technical Note: 

Specifically, the function employed is this: 

 

where 

R = result 

A = array (of any dimension) 

w = width (user-specified) 

Spike Remover 

This is a 2-D data filter. It is used to flatten widely-varying dependent values (vertical axis, Y-values).  

 

Specify Max Deviation to the maximum difference between sequential Y-values. This filter is not 
recursive and proceeds from left to right. That means when the algorithm identifies a deviation between 
two points greater than the Max Deviation, it makes Y-values of both points equal to that of the point on 
the left. It then proceeds to the next Y-value to the right, comparing it to the point immediately to its left. If 
that Y-value difference is also larger than the Max Deviation, then it too will be set to the Y-value of the 
left point.  

Consequently, this filter often yields flattened portions of curved plots.  
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image filters 

Image Filters 

Applying an image filter creates a new image that has been filtered: the original remains unaltered. 

The only images available in BandiT are pyrometric scan mode images generated for computing growth 
rate (set in the Pyrometric Oscillations Advanced Acquisition Option). Thus, there is no reason to filter 
these images from a computation standpoint. For improving data visualization, the user may wish to use 
palettes, which provide different color options without changing the data. Such colorized Images can be 
exported for use in reports, but may need to be filtered for better printing, etc. So it is for reporting 
purposes that the image filtering capability is available in BandiT. 

With an image window selected, select the Filter menu. 

 

To create a filtered image or movie, select: 

•  

• 2D FFT 
• Bayer Grayscale to Color 
• Binning 
• Black Offset Correction 
• Brightness Adjust 
• Crop 
• Edge Detection 
• Edge Detection (Roberts) 
• Edge Detection (Sobel) 
• Field Doubling 
• Flip Horizontal / Vertical 
• Gamma 
• Histogram Equalization 
• Invert 
• Log Scaling 
• Maximize Contrast 
• Median Filter 
• Neutral Density 
• Reverse 2x1 Binning 
• Rotate 
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• Scale to New Size 
• Smooth 
• Spot Finder 
• Threshold 
• Unsharp Masking 

To create a new image by combining two sources in various ways, select: 

• Add 
• And 
• Average 
• Divide 
• Exclusive-Or 
• Or 
• Subtract 

kSA systems also allow for user-created IDL filters. 

Black Offset Correction 

This is an image filter that subtracts off an intensity value from the image and then re-scales the image 
intensity from 0 to 100%. It is useful for subtracting off noise from an phosphor screen image.  

 

Specify:  

Offset – type in a value from 0 to 4095 to subtract off that value from all pixel values. Resultant 
values below zero are zeroed.  

Binning 

This is an image filter used for reducing noise. It does not alter acquisition, only the image already taken. 
Binning combines the readings from a block of pixels to increase the signal to noise ratio. Of course, this 
reduces the size of the image, meaning lower resolution.  

As an example, suppose the binning size is set at 2 pixels. That means that a 2x2 block (containing 4 
pixels) will be reduced to a single pixel.  

The algorithm first "bins" starting in the upper left corner of the image. Then it selects the next block for 
binning to the immediate right of the first block (not overlapped). After coming to the end of a row, the 
algorithm starts with the next row that has not yet been part of a bin.  
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Specify:  

Binning size – the size of the bin that will be used. A binning size of 2 will reduce the size of the 

image by ; a binning size of 3 will reduce the size of the image by , and so on.  

Minimum pixel value – set the value below which pixel values are not added to the bin. = 
4096 values are available, with 0 excluding nothing and 4095 excluding all pixel values.  

Bayer Grayscale to Color 

This is an image filter that is useful for cameras that use the Bayer filter for capturing color information. 
These tend to be less expensive cameras because they need only one sensor to acquire data. Data for 
these cameras is acquired in a grayscale format and then can be converted to RGB color using this filter.  

 

Specify Red %, Green % , Blue % – to adjust the values of each color. This percentage is multiplied by 
255 and the result is then rounded to an integer. Color values are between 0 and 255, so any percentage 
yielding a value greater than 255 will be set at 255.  

Check:  

Auto white balance – to rescale based on summed values. Checking this option and clicking OK 
takes the total green value, divides it by the total red value, multiples the result by 2, and then 
normalizes the red value to the green value. Then it does the same thing for blue values with 
respect to the green value. Finally, the algorithm un-checks the Auto white balance checkbox and 
resets the preferences of red/green/blue scale to the calculated values.  
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The filtered image that appears upon clicking the OK button has not yet had the Auto white 
balance feature applied. Click the original image again and re-open the filter. The Auto 
white balance checkbox will be un-checked and the red/green/blue % fields will be 
updated. Simply click OK to see the changes take effect.  

Swap red and blue pixels – to swap all the red pixels values with the blue pixel values. 
Sometimes, the Bayer filter consistently creates colors that are different from what they should be. 
Swapping these two pixel values usually corrects this problem.  

And 

This is an image filter that uses two sources and the logical AND operator to create a new image. The 
filter works by applying the AND operator to the two sources bit-wise.  

For example, suppose two images were each composed of one pixel of 2 bit depth. Thus, the entire 

image is made up of an array  = 4 numbers in length. Further suppose that the first image (or pixel, in 
this example) is the array 1, 1, 0, 0 and that the second has the array 1, 0, 1, 0. Using the AND operator 
leads to the result 1, 0, 0, 0 because  

1 AND 1 = 1  

1 AND 0 = 0  

0 AND 1 = 0  

0 AND 0 = 0.  

Add 

This is an image filter that uses two sources and adds their pixel intensities together to create one new 
image.  

2-D FFT 

This is an image filter that performs two 1-dimensional FFT transforms, first replacing each row with its 
row transform and then replacing each column with its column transform.  

The algorithm first pads both the length and width of the image dimension with zeros until they are of a 
size that is a power of 2. Because the values in the rows and columns of the image are intensities, the 
imaginary component of the complex array (input into to the Fast Fourier Transform algorithm) is taken to 
be zero.  

2-D Fourier transforms simply involve a number of 1-D transforms, and as aforementioned, this one 
replaces first the rows with their transforms and then the columns with their transforms. But in order to 
place the origin of the frequency spectrum at the center of the image, the image is quartered and 
quadrants are swapped: 1 with 3, and 2 with 4, as shown in the diagram below.  

 

Technical Note:  

In the discussion above, it is assumed that the user is familiar with 1-D FFT. For more information on that 
topic, please see the 1-D FFT topic.  
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Average 

This is an image filter that uses two sources and averages (means) their pixel intensities to create one 
new image.  

Black Offset Correction - No Scale 

This is an image filter that subtracts off an intensity value from the image, but does not re-scale the image 
intensity. It is useful for subtracting off noise from an phosphor screen image. 

 

Specify: 

Offset – type in a value from 0 to 4095 to subtract off that value from all pixel values. Resultant 
values below zero are zeroed. 

Brightness Adjust 

This is an image filter that adjusts the brightness of both monochromatic and color images. Color images 
not already in HSB (Hue, Saturation, Brightness) format are first converted and then converted back after 
brightness is adjusted using the algorithm described below.  

 

Specify % Brightness Change between -100 and 1000. The number is then divided by 100 and the 
result added to 1. That number is then used to scale the brightness values.  

For example, suppose the % Brightness Change is -10. Then the scale factor will be 1-10/100 = 
0.9  

Crop 
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This is an image filter that allows the user to keep only a certain part of the image and throw the rest 
away. This is particularly useful when the image is much larger than what the user needs. It also reduces 
file size.  

 

Specify:  

Start column – for where cropping begins, along with Start row. The 0 column is the left of the 
image.  

Width – for how wide (horizontal) the smaller cropped image will be, starting from the Start column 
and moving left.  

Start row – for where cropping begins, along with Start column. The 0 row is the top of the image.  

Height – for how tall (vertical) the smaller cropped image will be, starting from the Start column 
and moving down.  

Divide 

This is an image filter that uses two sources that must be of the same size. 

Order is important: the first image is divided by the second, with each pixel intensity value in the first 
image divided by the corresponding pixel intensity value in the second image. 

After clicking the OK button in the two sources dialog, the following dialog appears: 

 

Select Auto-scale and the resultant image’s pixel values will be scaled by multiplication up to the 
maximum intensity value, which depends on the bit depth. 

For example, suppose the highest intensity value in an 8-bit resultant image is 25 and the lowest intensity 
value in the resultant image is 2. Then the Auto-scale function will multiply the highest intensity value, 25, 
by a factor of 10.2, making the new highest intensity value 255. All the other pixel intensity values will be 
multiplied by the same factor, making the lowest intensity value, for example, 20.4, which will be rounded 
down to 20 

Un-checking this option means setting the Scale factor, which is the multiplication value used for scaling 
the resultant pixel values. A value of 1 leaves the resultant image unchanged. Any value that results in a 
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pixel intensity value too high or too low (beyond the limits (0 to 255 for 8-bit images)) will be set to the 
highest- or lowest-possible scale factor. 

Edge Detection 

This is one of three edge detection image filters. This one uses the simple homogeneity function on a 3x3 
matrix of pixels in order to transform the image. The function subtracts each of the eight surrounding 
pixels from the middle pixel, notes the largest difference, and then uses the absolute value of that largest 
difference as the value of that middle pixel in the new image.  

For example, in the 3x3 matrix of pixel values below, 11 is center value and |11-16| = 5 is the maximum 
difference. So 5 will be the value of the center pixel in the filtered image.  

11 13 15  

16 11 11  

16 12 11  

There are an infinite number of edge orientations, widths, and shapes. Some edge detection algorithms 
work well for one image and poorly for others, so it may take experimentation to determine the best 
technique. See also Edge Detection (Roberts) and Edge Detection (Sobel).  

Edge Detection (Roberts) 

This is one of three edge detection image filters. This one uses the Roberts edge enhancement operator 
for images, as outlined below.  

If  

 

is the coordinate of each pixel  

 

in the original image, and  

 

is the Roberts-transformed pixel, then  

.  

There are an infinite number of edge orientations, widths, and shapes. Some edge detection algorithms 
work well for one image and poorly for others, so it may take experimentation to determine the best 
technique. See also Edge Detection and Edge Detection (Sobel).  

Edge Detection (Sobel) 

This is one of three edge detection image filters. This one uses the Sobel edge enhancement operator for 
images, as outlined below.  

If  



BandiT User Manual 

255 

 

is the coordinate of each pixel  

 

in the original image, and  

 

is the Sobel-transformed pixel, then  

 

where  

 

.  

There are an infinite number of edge orientations, widths, and shapes. Some edge detection algorithms 
work well for one image and poorly for others, so it may take experimentation to determine the best 
technique. See also Edge Detection and Edge Detection (Roberts).  

Exclusive-Or 

This is an image filter that uses two sources and logical XOR operator to create a new image. The filter 
works by applying the XOR operator to the two sources bit-wise. 

For example, suppose two images were each composed of one pixel of 2 bit depth. Thus, the entire 

image is made up of an array  = 4 numbers in length. Further suppose that the first image (or pixel, in 
this example) is the array 1, 1, 0, 0 and that the second has the array 1, 0, 1, 0. Using the XOR operator 
leads to the result 0, 1, 1, 0 because 

1 XOR 1 = 0 

1 XOR 0 = 1 

0 XOR 1 = 1 

0 XOR 0 = 0. 

Field Doubling 

This is an image filter that doubles either the odd or even field (rows) in an image. It is useful for images 
that have been captured with an interlacing camera. BandiT Scan Mode Images do not need this filter 
because of how they are created.  
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Specify  

Odd or Even – for which field gets row-by-row doubling and which field gets eliminated from the 
image  

or  

check Interpolate for software interpolation of the missing field.  

Flip Horizontal/Vertical 

These are two image filters that are used to flip images. 

Choose: 

Flip Horizontal – the resultant image has the same rows top-to-bottom (i.e., is flipped about a 
vertical axis) 

Flip Vertical – the resultant image has the opposite rows top-to-bottom (i.e., is flipped about a 
horizontal axis) 

Gamma 

This is an image filter that is used to control the overall brightness of an image. Images not properly 
gamma corrected can look either bleached out or too dark, often with an unnatural gradient between light 
and dark. For a color image, gamma correction also changes the ratios between red, green and blue. 

 

Brightness: 

For brightness, most computer monitors take pixel intensity and raise it to the power of 
approximately 2.5 (depends on system and monitor). That is, if x is the pixel intensity, then 
computer monitors display about 
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So, because the range of pixel intensity is between 0 and 1, raising it to the power of 2.5 
decreases the display intensity. Setting a gamma correction of 2.5 raises the display intensity to 
(1/2.5). That is, 

, 

so the image displayed looks like the image taken by the camera. 

Color: 

The same thing that happens in brightness happens in color intensity. That is, for each color, 
computer monitors display about 

 

of the original color. 

For example, assume a Red/Green/Blue (RGB) color space with values between 0 and 255 for each 
color. Suppose a color is 80 Red, 20 Green and 20 blue, or having a ratio of 4:1:1. The image will appear 
with a ratio of approximately 

 

so the color will appear much more red than it actually is. Set the gamma factor to about 2.5 to correct for 
the display, which will apply a power of (1/2.5) to the display image. 

Histogram Equalization 

This is an image filter that adjusts the color table. First, the software obtains a pixel-distribution histogram. 
Then, it takes the cumulative integral and scales it, applying it to the current color table. 

HSB Adjustment 

This is an image filter for images captured with a color camera that divides the image into Hue, 
Saturation, and Brightness.  

IDL Filters 

The kSA software supports Interactive Data Language™ (IDL) filters, enabling users to program their own 
IDL filters (*.pro files). These then become available in the View menu when saved in this folder:  

…\kSA\kSA BandiT\PROGRAM\idlprocs  

Learn more about IDL at the RSI’s Web site:  

www.rsinc.com/idl/  

Invert 

This is an image filter that inverts the palette of the image. 

For colored images, this results in an opposite color change—blue for orange, violet for yellow, etc. 

For monochromatic images, this filter inverts the grey scale—black for white, etc. 
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For falsely-colored images (created with the palette), this filter inverts the palette—for example, if 
choosing IDL-13 palette (black and rainbow) in the original image, the brightest portion of the image is 
red, meaning that the Invert filtered image displays red for the darkest part of the image. 

. 

Log Scaling 

This is an image filter that scales image intensity pixel-by-pixel using the following equation:  

 

where  

m = maximum intensity value in the whole image  

I = original pixel intensity  

N = new pixel intensity  

Maximize Contrast 

This is an image filter that applies the following equation pixel by pixel to maximize the difference 
between high and low intensity of the whole image:  

 

where  

min = minimum pixel intensity  

max = maximum pixel intensity  

I = original pixel intensity  

N = new pixel intensity  

Median Filter 

This is an image filter used for removing "salt and pepper noise," or isolated high or low values. The 
median filter replaces each point with the median of the values in the two-dimensional window of the 
specified width. It is similar to smoothing with a boxcar filter, but does not blur edges larger than the 
window.  
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Choose 3, 5, 7, or 9 for the window width and height from which the median value is taken. Even 
numbers are not available because the median of an even number of elements is the average of the two 
middle numbers.  

Neutral Density 

This is an image filter that divides the intensity by a scale factor.  

 

Specify Density, which is then input into the following formula:  

 

where  

I = original pixel intensity  

N = new pixel intensity  

Or 

This is an image filter that uses two sources and logical OR operator to create a new image. The filter 
works by applying the OR operator to the two sources bit-wise.  

For example, suppose two images were each composed of one pixel of 2 bit depth. Thus, the entire 

image is made up of an array  = 4 numbers in length. Further suppose that the first image (or pixel, in 
this example) is the array 1, 1, 0, 0 and that the second has the array 1, 0, 1, 0. Using the OR operator 
leads to the result 1, 1, 1, 0 because  

1 OR 1 = 1  

1 OR 0 = 1  

0 OR 1 = 1  

0 OR 0 = 0.  
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Reverse 2x1 Binning 

This is an image filter that reverses a common 2x1 binning option available on some cameras. That 
binning is done to speed up acquisition at the expense of resolution and image size.  

This filter takes two adjacent rows and averages them to make a third row in between them. The resulting 
image is twice as tall.  

Technical Note:  

The assumption that the filter gives an accurate reversal of the camera binning is based on a linear 
response of the detector between intensity signals.  

RSB Adjustment 

This is an image filter for adjusting images captured with a color camera that divides the image into Red, 
Green, and Blue. 

RGB to Grayscale 

This is an image filter for converting images captured with a color camera that divides the image into Red, 
Green, and Blue to a grayscale. 

Rotate 

This is an image filter that refers to four rotate options. Three of them: 

Rotate 180 Degrees 

Rotate 90 Degrees Left 

Rotate 90 Degrees Right 

are common choices that can all be done by the fourth: 

Rotate Any Angle 

 

Angles are in degrees, so choose a number (including decimal values) between -360 and 360. 

Choose positive values to rotate the image counterclockwise (left). 

Negative values rotate the image clockwise (right). 

Technical Note: 

There are two different functions called for rotate. Using Rotate Any Angle is less efficient when rotating 
in increments of 90 degrees than the other rotate functions, which rotate only in increments of 90 
degrees. 

Scale to New Size 
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This is an image filter that uses nearest-neighbor sampling to scale the image to a user-specified size. 
The filter will stretch or compress an image along both axes to match the new dimensions. It does not 
retain proportions. It is a very fast filter, but can result in jagged edges and loss of apparent resolution, 
even when scaling down. 

 

Specify New Width (pixels) and New Height (pixels) to set the size of the scaled image. 

Smooth 

This is an image filter that applies the Boxcar smooth algorithm to arrays of the pixel intensities. 

 

Specify the Width of the side of the smoothing window using odd values between 3 and 101. For the filter 
to be meaningful, ensure that the specified width is smaller than either dimension of the image. 

For example, width 3 specifies a 3 by 3 smoothing window with 9 total elements. The smoothed element 
will be in the middle of that box. 

Technical Note: 

Specifically, the function employed is this: 

 

where 

R = result 

A = array (of any dimension) 

w = width (user-specified) 

Spot Finder 

This is an image filter used to find spots on an image that meet or exceed a minimum intensity. 
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Specify Threshold min. % – for the intensity percentage needed for an area of the image to be 
considered a spot 

Choose Spot Size of: 

Single Pixel – for placing a single pixel at the centroid of the spot 

Original Spot Size – for placing a circle of the original spot size at the centroid of the spot 

Note that saturated images and/or images with a lot of pixel intensities at 100% may make this filter 
behave in unpredictable ways. 

Subtract 

This is an image filter that uses two sources and subtracts one’s intensity values from the other. Order is 
important: the second one is subtracted from the first, with any negative values zeroed out (black). 

Threshold 

This is an image filter that can bring up the low intensities and reduce maximum intensities.  

 

Specify:  

Threshold min. % – to set the value to which all pixel intensities lower than the threshold will be 
set.  

For example, with a setting of 50%, all pixel intensities below 50% will be brought up to 
50%. Setting this parameter to 0% means no pixel intensities are increased.  

Threshold max. % – to set the value to which all pixel intensities higher than the threshold will be 
set.  

For example, with a setting of 100%, no pixel intensity values are lowered. A setting of 90% 
will reduce only those pixel intensities above 90% to 90%.  

Two Sources 
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These filters use images, combining them in various ways to create a new image. Select any open image 
document for either source.  

 

Unsharp Masking 

This is an image filter that first subtracts a smoothed image from the original image and then scales the 
result.  

 

Specify the Width of the side of the smoothing window using odd values between 3 and 101. For the filter 
to be meaningful, ensure that the specified width is smaller than either dimension of the image.  

For example, width 3 specifies a 3 by 3 smoothing window with 9 total elements. The smoothed 
element will be in the middle of that box.  

Then the smoothed image will be subtracted from the original image.  

Finally, a scale is applied to the result:  

 

where  

min = minimum intensity  

max = maximum intensity  

I = original pixel value (of result of original image minus smoothed image)  

N = new pixel value  

Technical Note:  

For color images, the filter first converts any other color formats to Hue-Saturation-Brightness (HSB) first 
(more at HSB Adjustment). Then applies the filter to the brightness values, and converts the resultant 
image back to the original color table (e.g. RGB).  
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Save export 
File Formats 

k-Space has created the following proprietary formats: 

• img (kSA Images) 
• kdt (kSA Data Files) 
• bsrf (kSA BandiT Spectra Reference File) 
• mrk (kSA BandiT Multi-wafer Marker File) 
• rcp (kSA BandiT recipe files) 
• dls (kSA Platen Custom Scan) 

Except for reference files, kSA proprietary file types contain a variable-length header that contains all the 
pertinent information on how the data was acquired as well as any user-entered comments (use the 
Comments property for images and the File plot property otherwise). After that header, the data is stored 
in binary format. For this reason, direct reads of kSA proprietary files into external applications is difficult, 
which is why there are several exporting options. Reference files may be viewed using a text editor, but 
will only be useful within the kSA application. 

What follows below is a general description of each file type. If needing the exact file format for an 
external read into another application, please contact us. 

  

• img—Scan Mode Image 

Image files in BandiT are created using the Pyrometric Oscillations Advanced Acquisition Option and are 
a visual record of the Spectra versus Wavelength plot (seen in the Real-time BandiT Spectra chart during 
acquisition). Taking a horizontal Line Profile of the Scan Mode Image yields the same Spectra versus 
Wavelength plot, the data of which is also recorded in the *.kdt file. 

There are two exporting options. The first is simply to click the Copy button (Control+C) and paste the 
image into another program. The second—which ensures no loss of resolution—is to select the image 
and use File/Export from the menu, saving the exported file as a *.tiff. 

  

• kdt—Data Files 

Apply the Spreadsheet analysis tool to any *.kdt plot to see the two-column data from the plot itself, with 
the left column the dependent (horizontal axis) values and the right column the independent (vertical axis) 
values. Right-clicking the plot and selecting the data tab shows that there are many other values to plot, 
revealing that *.kdt files have an enormous amount of data in them. 

Depending on acquisition, that data can come in two types, each with its own plot property: BandiT 
Computed Data and BandiT Spectral Data. 

BandiT Computed Data—users choosing to use the option Minimal data output (default) in the BandiT 
I/O Settings Advanced Acquisition Option have acquired BandiT Computed Data. It is a "narrow-column" 
data, meaning that for each data point there are single values in each column (a time, a temperature, a 
wavelength, etc.). 
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BandiT Spectral Data—users choosing instead the option to Store raw and fully processed spectra 
have acquired both the BandiT Computed Data and the BandiT Spectral Data. BandiT Spectral Data is a 
"wide-column" data, meaning that for each data point there are multiple values that require multiple 
columns in order to contain all of it (a spectra). The program automatically uses this data to compute the 
BandiT Computed Data. 

If storing raw and fully processed spectra, then the user has the option of switching between the two 
types plotted by clicking the Data and Spectra tabs at the bottom of the plot. The kdt toolbar gives the 
user control over the replay of the acquisition. Of course, if no such toolbar is available, then only the 
BandiT Computed Data was acquired. 

Note that due to their size, exporting data (especially BandiT Spectral Data) may take several minutes. 
Modern computers can handle most (if not all) user needs, but because it is possible to Store 
incrementally (set in the BandiT I/O Settings Advanced Acquisition Option), files can be so large that 
they cannot be re-opened unless more RAM is available. 

  

• bsrf—Spectra Reference File 

These files are like BandiT Spectra Data *.kdt files, but contain only one spectra. The *.kdt toolbar 
capabilities are limited. There are two options for viewing the spectra data: 

Data tab – click the Data tab at the bottom of the plot to see a spreadsheet view of the data (number of 
wavelengths and intensity) in one row. 

Spreadsheet – apply the analysis tool (under the Analysis menu) to see a spreadsheet view of the data 
(wavelength and corresponding intensity) in two column format. 

  

• mrk—Multi-wafer BandiT Marker File 

These files contain all the marker positions specified in the Real-time Bandit Temperature (Full Rotation), 
including the marker position found when calibrating the homepulse. They are saved and loaded by right-
clicking that chart, and may be viewed outside the BandiT application by using a common text editor. 

  

• rcp—BandiT Recipe file 

These files contain information specified in the Spectra Processing Advanced Acquisition Option dialog. 
They are saved and loaded via that dialog, and may be viewed outside the BandiT application by using a 
common text editor. 

  

• dls—Platen Custom Scan file 

These files contain information specified in the Custom Platen Scan dialog. They are saved and loaded 
via that dialog, and may be viewed outside the BandiT application by using a common text editor. 
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Saving 

It is recommended that all data is Saved in the kSA file formats. In this form it can be reopened in the 
BandiT software and all analysis tools can be used. Data can be saved automatically by the BandiT 
software depending on the options chosen in the Document Generation tab of the Advanced Acquisition 
Options. 

If you want to use the data in some other application then you can additionally Export your data in a 
number of formats - see Exporting. 

kSA systems save generated data/image files in k-Space’s proprietary file formats: 

• img (kSA Images) 
• kdt (kSA Data Files) 
• bsrf (kSA BandiT Spectra Reference File) 
• mrk (kSA BandiT Multi-wafer Marker File) 
• rcp (kSA BandiT recipe files) 

Re-open any of these file types in kSA applications and employ all the analysis tools and any other 
functionality as if the data/image had just been acquired. Of course, this also means that these file types 
cannot be opened by off-the-shelf software applications. 

For this reason, kSA applications can export to a variety of file types. 

General Note: 

Log files are saved as Text Documents (*.txt) 

Exporting 

(See also Saving.) 

kSA systems can export files to a variety of file formats for use in other applications. The format available 
depends on the file: 

• bmp (Windows Bitmap) 
• txt (Text Documents) – plot data vs. all data for some plots 
• eps (Encapsulated Postscript File) # 
• png (PNG Image) # 
• tif (Tiff Image) # 
• wmf (Windows Metafile) # 
• xls (Excel File) – plot data vs. all data for some plots # 

Those marked with the # cannot be re-opened in kSA applications. However, even those that have been 
exported and can be re-opened in kSA applications will not have the same functionality as those saved in 
kSA’s proprietary formats. It is for that reason that, when possible, it is better to save files rather than 
export them. 

Glossary 
Average Intensity 
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Mean intensity of the area specified by the user  

Average (# of frames) 

Number of frames of input gathered and averaged together to make a single datum/image 

Bit depth 

Number of bits used to store information about each pixel in an image. The higher the depth, the better 
the resolution and the larger the file size.  

*kdt file 

A proprietary file type. They contain temperature and/or full optical spectra data. These files can only be 
read correctly by the kSA software. Data contained within and displayed from *.kdt files may be exported 
to various common file formats, including *.bmp, *.wmf, and ASCII *.txt files. Learn more in the help topic 
"File Formats" 

Bandpass 

Type of digital filter that transmits a particular band of frequencies, but lowers the transmission rate of that 
values above and below that band 

Bandstop 

Type of digital filter that suppresses a given range of frequencies, transmitting only those above and 
below that band 

Highpass 

Type of digital filter with one transmission band that extends from a lower-bound freqency (other than 0) 
to frequency approaching infinity 

Lowpass 

Also known as a spatial averager, this digital filter is a method of convolution that reduces random noise 
by replacing the value of each pixel with the average of that pixel and its neighbors (or of its neighbors 
alone) 

kSA BandiT Install Guide 

k-Space Associates, Inc., © 2004-2007. This document is provided in hard copy form with kSA BandiT 
systems. It is also available in *.pdf format at www.k-space.com. 

kSA Multi-Wafer BandiT 
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This new product from k-Space Associates gathers the kSA BandiT data from multiple wafers as they 
spin around on a platen, displaying and saving each wafer's data in a different file. Please contact us if 
you have a single-wafer system and would like to learn more about kSA's Multi-Wafer BandiT.  

Normalized Intensity 

Intensity values linearly scaled to be between 0 and 1. 

Nyquist Frequency 

1/(2T), where T is the time between data samples. This frequency comes from the Nyquist criterion, which 
postulates that the pickup sampling frequency must be at least twice the rate that brightness changes for 
any detail to be resolved.  

Acquire in Progress 

Is 1 (if in progress) or 0 (if not) 

Adjusted Elapsed Time 

Time spent in acquisition. This will only differ (be smaller) than Elapsed Time if pausing during acquisition. 

Band Edge Wavelength 

The wavelength calculated from the linear fit crossing the horizontal axis that, in turn, is used to calculate 
the BandiT temperature  

Band Gap Linear Fit X/Y Pos 

If X, then it is an array containing the two X-values (independent values, horizontal axis) of the linear fit. If 
Y, then it is an array containing the two Y-values (dependent values, vertical axis) of the linear fit. Plotting 
the Y versus X values gives a graph with the linear fit.  

BandiT Background Width 

Number of wavelengths per spectra in the BandiT Dark Background, which itself is a spectra that must be 
acquired before the software allows for temperature acquisition. See the BandiT Dark Background 
acquisition mode (Help topic) for more information.  

BandiT Fit Spectra 

A fitted spectra value used internally by the program for computing BandiT temperature 

BandiT Fit Spectra Width 

Number of data points in the BandiT Fit Spectra 

BandiT Normalized Spectra 
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A normalized (0 to 1) plot of BandiT Spectra, which is a plot of detected intensity versus wavelength 

BandiT Spectra 

A plot of detected intensity versus wavelength. From this data, the software calculates temperature. 

BandiT Spectra Wavelength 

The lowest wavelength detected 

BandiT Temperature 

Computed temperature using the proprietary algorithm developed by k-Space Associates 

Confidence 

A measure of how well the fitting equation matches the data. Usually, a confidence value greater than or 
equal to 85% is adequate for most users.  

Data Point 

The sequential number assigned to acquired data  

Data Set 

When BandiT supports multiple wafers, this will be the number of wafers. The spectrometer will separate 
data from each wafer into separate data sets. 

Elapsed Time 

How much time has passed since starting acquisition 

Number of Linear Fits 

The number of data points (x,y) used to plot the linear fit. Usually, this number is 2. 

Number of Wavelengths 

The number of wavelengths in the BandiT Spectra.  

Peak Spectra Intensity 

Maxiumum value of the Spectra source (specified in the BandiT Temperature Acquisition dialog) 

Pyrometry Value 
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The temperature calculated via pyrometry when using BandiT in transmission mode and measuring 
black-body radiation as the signal source 

Samples per Data Point 

Number of measurements taken for each data point 

Spectrometer Integration Time 

Amount of time that the spectrometer collects signal before digitizing and reading out the signal 

TC Temperature 

(T)hermo(C)ouple Temperature as measured by the thermocouple inside the chamber. Usually, 
thermocouples are not used unless making calibration files. 

Pop-Ups and Jumps 

When a word is green, clicking on it will provide either a pop-up window (such as this one) or a jump to 
another topic in the Help file. To undo a jump, simply use the "Back" command at the top of the Help file 
window. 

USB Security Key 

A (U)niversal (S)erial (B)us device that comes with the software and must be plugged in to a computer 
before it can run any kSA software. Because the key is programmable, some software capabilities may 
be hidden/disabled depending on the system purchased. 
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